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I.1 Introduction 
GEOPAK is a comprehensive software package that covers every project phase from 
conceptualization to final quantities.  The software works within the MicroStation graphic 
environment providing true interactive design.  For example, a horizontal alignment can be 
created graphically, it can be calculated with the coordinate geometry component of GEOPAK or 
some interactive combination of the two.  Dynamic on-screen design provides immediate 
interpretation of plan view geometrics for making design choices through visualization. 
 
Using GEOPAK will help ensure consistency and accuracy of design work and generate 
significant timesaving in the overall effort of producing construction plans. 
 
 
For GEOPAK support, please contact the CADD Support Center. 
 

I.2 File Names 
GEOPAK uses and/or creates files during the design process.  The files you need to be familiar 
with are listed below:  
 
job###.gpk This binary file is created when the user starts a coordinate geometry (COGO) 

session for the first time or through Project Manager and may be appended to 
during the design process. All coordinate geometry elements are stored in this 
file. Multiple users can access this file at the same time, and only one file 
should be created for each project.  The "###" is the only variable in this name.  
It represents a job number (up to 3 alphanumeric characters) unique to a 
project and is defined by the user upon creation.  MoDOT users should use the 
last 3 digits of the job number.  Example J1P0999 -> job999.gpk 

 
fname.inp  Any ASCII input file for running GEOPAK processes. Name is user defined 

with a .inp extension. Example: shape.inp 
 
fname.log ASCII file used to capture results from processing input files, proposed cross 

sections, and earthwork. 
 

fname###.ioc  ASCII input file for loading data during a COGO session. "###" represents the 
job number and "oc" is the operator code (users initials). Example: 
align999.iho 

 
fname###.ooc  ASCII output file created by GEOPAK during a COGO session. Variables are 

the same as defined above. Example: align999.oho 
 
fname.dat A binary file that contains string and point information to be used for digital 

terrain model construction. 
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fname.tin A binary file containing triangular surfaces also known as the digital terrain 

model (DTM) 
 
project.prj Binary file resulting from the creation of a new project. 
 

I.3 Accessing GEOPAK Road 
GEOPAK is 
started upon 
entering a 
MicroStation 
File with 
User: set to 
design, as 
shown in the 
dialog to the 
right.  To 
verify that 
GEOPAK is 
active, scan 
the 
MicroStation 
menu bar 
where the 
Applications 
menu appears.  
Simply pull 
down 
Applications 
> GEOPAK 
Road.  When 
each 
GEOPAK tool is selected, the corresponding dialog will appear.  To utilize the full potential of 
GEOPAK, usage of the GEOPAK dialogs may be interspersed with generic MicroStation 
commands.  In addition, several dialogs may be opened simultaneously. 
 
To close a dialog, simply click the X in the upper right corner of the dialog.  In addition, the 
Coordinate Geometry dialog and Design and Computation Manager may be closed by selecting 
the File > Exit option.  Other various dialogs will have a Cancel button, which will exit the 
dialog.  Exiting the MicroStation file automatically closes all GEOPAK dialogs. 

I-2 Missouri Department of Transportation 10/28/02 
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I.4 User Preferences 

 
 

The User Preferences dialog is used to set items that determine how distances, directions, and 
stationing is displayed and calculated, as well as the units that are used.  The User Preferences 
dialog can be accessed from Applications>>Geopak Road>>User Preferences.  The following 
dialog appears. 
 
Most of the settings in this dialog will be set when the project is setup.   
 
The Working Directory is used to tell Geopak where the data files for a particular project can 
be found.  If a user does not want to work within a specific project, they can delete the 
information out of this field, and Geopak will use the directory that the open MicroStation file is 
located in. 

I.4.1 Feature Preferences 
The Feature Preferences button will 
activate the following dialog. 
 
The SMD File is used to control the 
symbology of survey elements.  Users 
will not be able to edit the SMD File, 
however, the Edit SMD… button can be 
used to view the feature codes.  The 
Apply Best Match Feature toggle should be checked to allow for proper import of survey data.  
The scale of the features can be controlled using the Plot Scale.  This should be set to the scale 
of the plan sheets to be created. 
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I.4.2 COGO Preferences 
The COGO Preferences button will activate the following dialog. 

 
The Job Directory can be set to indicate the location of the coordinate geometry database (.gpk).  
If this field is not set, GEOPAK will look for the coordinate geometry database (.gpk) in the 
Working Directory.  The COGO Input File Dir. and COGO Output File Dir. can be set to 
indicate the location of the COGO input and output files respectively.  If these fields are not set, 
GEOPAK will look in the Job Directory.   
 
The Redefinition of Elements toggles on or off the COGO redefine option.  This option is 
discussed further in Chapter 5.  The Force redefinition off at Cogo Activation will turn the 
COGO redefine toggle off whenever GEOPAK’s coordinate geometry tools are activated. 

I.4.3 Superelevation Preferences 
There are two options for using GEOPAK Superelevation, GEOPAK 2000 and Classic.  
GEOPAK 2000 will use the tools made available in GEOPAK 2000 and later versions.  The 
Classic option will bring up the tools available prior to GEOPAK 2000.   
 
**Note: The Classic option will not be supported within MoDOT.  Only the GEOPAK 2000 
option will be supported. 
 
The Superelevation Preferences have been set by CADD Support and do not need to be 
modified by the user.   

I.4.4 Plan & Profile Sheets Compatibility 
Three options are available for creating Plan & Profile Sheets, Classic, GEOPAK 2001+, and 
GEOPAK 2001+ with Raster Manager.  At the present time only the Classic Plan & Profile 
Sheets tool is configured to MoDOT standards.  Consequently the user should choose Classic. 
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1.1 Objectives 

• Be able to start a new Geopak job with the Start Job dialog. 

1.2 Definition 

Start Job is a tool that will set up a Geopak job for a user, or add users to an existing job.  Start 
Job will create the job directories, copy default MicroStation files to the directories, and set the 
global origin in the MicroStation files.  Start Job will also append the job number to the end of 
the copied MicroStation files.  Once a job has been created, Start Job will add a user to the job.  
Start Job is only available in the design user interface in MicroStation. 

1.3 Accessing 

Start Job can be accessed from the MicroStation menu MoDOT>>Start Geopak Job/Add 
User. 

1.4 Start Job Dialog 

Once the user has accessed the Start Job 
dialog box, shown right, they will need to 
fill in or choose the Job Number and the 
Path in which to place the job directory.  
Once the job number and path have been 
chosen, the District and County can be 
chosen. 
 
If the user is creating a new job, do not 
check the Add Users to Existing Job 
toggle, just choose the userids of the people 
that will be working on the job.  If a job 
already exists, and the users are being 
added to the job, check the Add Users to 
Existing Job toggle. 
 
For a new job, select the Units and the 
Sheet types that will be used for the job.  
This will create a directory for each Sheet 
type selected to place the sheets into as 
they are created. 
 
If the job is not based on the modified state 
plane or the state plane coordinate systems, Custom Coordinates must be set to shift the global 
origin.  If the modified state plane or state plane coordinate systems were used for the project, 
the County selected will determine the global origin shift. 
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Once all fields have been filled in, select the OK button.  The job directories will be set up as 
shown below. 
 

T:\ 
 br-proj\ 
 A_Geopak\ 
 D# (last digit of district number) 
 job number 
     data 
               dtm.dgn 

          pattern_shape.dgn 
          plan.dgn 

               profile.dgn 
               topo.dgn 
               xs.dgn 
     plan_sheets 
               100 
               20 
     project 
               projdbs 
                userid1 
                userid2 
 
The data directory contains any project data.  This is the directory that contains the MicroStation 
drawings, the Geopak coordinate geometry database (.GPK), and any input or output files.  The 
plan_sheets directories contain the detail sheets drawn at specific scales for the project.  The 
project directory contains the Geopak project manager file (.PRJ), and the userid directories.  
The userid directories contain the user runs for the job. 

1.5 Set County Coordinates 

To change the coordinates of an existing MicroStation 
file, select MoDOT>>Tools>>Set County.  This will 
bring up the dialog shown to the right.  To use the tool, 

click on the pull-down box to the right of 
DISTRICT and select CUSTOM or the 
district number and click OK.  The pull-
down options are shown in the figure to 
the left.  Another dialog will appear that 
will let you enter the custom ordinates or 
select the county within the district 
chosen.  Click APPLY in this dialog to reset the coordinates or CANCEL to exit 
the tool without changing the coordinates.  Once the coordinates are changed, click 
OK in the County Coordinates dialog to unload the tool.  Consult your 
MicroStation manual for more information on the tool. 
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2.1 Objectives 

• Learn how to set up a project using Project Manager. 
• Learn how to utilize Project Manager as a workflow guide. 
• Learn how to access GEOPAK dialogs from the Project Manager. 

2.2 Definitions 
Project Manager is a GEOPAK tool that associates a project with its respective gpk job number, 
users, working directories and project files.  Project Manager provides the user with an easy 
workflow system that keeps records of processes run throughout the design of a project. 

2.3 Accessing 
To access Project Manager: 

•  Select Applications >> GEOPAK 
Road >> Project Manager (as shown 
in the figure to the right) or  
 

•  Select the Project Manager icon 
from the GEOPAK Road Tools 
(both are shown to the left), 
which are opened by selecting 
Applications >> GEOPAK 
Road >> GEOPAK Road 
Tools.   

 
The following dialog depicted to the right appears:  

2.4 Project Manager Dialog 

2.4.1 General Description 
The current directory is displayed at the top of the 
dialog box, which can be changed by navigating to 
a different directory in the Directories list box.  
This navigation is the first step in selecting an 
existing project or creating a new one.  Project 
files (.prj) are displayed in the Projects list box.  
The project files should be located in the  
t:\br-proj\A_Geopak\district\jobnumber\project 
directory. 
 
The remainder of the Project Manager dialog box 
displays information after a project has been 
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selected from the Projects list box.  At the bottom of the dialog are the OK and Cancel buttons.  
If the user wishes to exit Project Manager, the Cancel button should be selected.  To continue in 
the Project Manager process, the OK button should be selected. 

2.4.2 Project Manager Menu Bar 
There is three pull down choices on the Menu Bar: Projects, Directory, and Admin.  Each of 
these choices has options contained in the pull down. 

2.4.2.1 Project Tools 
There is four choices under the Projects pull 
down: New, Edit, Delete, and Exit as shown 
below. 
 
As can be seen from this dialog box, the Windows 
motif also keeps track of the last few processes that 
have been executed.  These may be recalled as 
needed by selecting the desired process.  

2.4.2.1.1 New… 
The New menu option is used to create a new 
project.  The .prj file will be stored in the directory 
shown in the Directory path at the top of the 
Project Manager dialog box.  When the New menu 
option is selected, the Create New Project dialog 
appears (shown at the bottom of the page). 
 
The Project Name can be any number of 
alphanumeric characters.  For MoDOT projects, 
the Project Name needs to be the same as the job 

number. (i.e. j1p0999.prj)  The Working Directory specifies the location of the project data 
files.  The Working Directory may be keyed in or the Select button may be chosen and the 
appropriate directory selected.  For MoDOT Bridge, the Working Directory should be set to 
t:\br-proj\A_Geopak\district\jobnumber\data. 
 
The next field is for typing in the 
COGO job number, or the Select 
button may be chosen and the 
appropriate COGO job number 
selected. 
 
Next the Preferences button 
should be chosen and the 
Project Preferences dialog 
appears, which is depicted on 
the following page. 
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The user may set the 
particular parameters for 
each project as well as the 
Working Directory.  
This keeps the user from 
re-setting them when 
changing projects since 
the project’s preferences 
are recalled when entering 
the project.  After all of 
the information is entered, 
select OK to accept the 
changes, or Cancel to 
reject them.  For more 
about User Preferences, 
see Section I.3 in the 
Introduction. 

 
Shown below is a sample project that includes a project description, which may be keyed in at 
the bottom of the Create New Project dialog box, with the Working Directory set to  
t:\br-proj\a_geopak\d5\j5p0100\data.  
 

 

2.4.2.1.2 Edit… 
The Edit menu option is used to change any settings associated with the currently selected 
project.  When chosen, the Project Info Edit dialog box appears. 

2.4.2.1.3 Delete… 
The Delete menu option is used to delete any project that has been stored.  The user highlights 
the project in the Projects and selects Delete. 
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2.4.2.1.4 Exit 
The Exit menu option closes the Project Manager and writes the settings to a resource file. 

2.4.2.2 Directory Tools 
There are two options under the Directory pull 
down, Create New Directory and Current 
Working Directory as shown.  
 
The Create New Directory option will create a 
new directory on the disk.   
 
If the Current Working Directory option is 
chosen, the directory path in Project Manager is 
changed to that directory. 
 
 
 
 
 
 
 
 
 
 
 

2.4.2.3 Administration Tools 
The Administration menu option is used to set a 
password on a project.  It is recommended that a 
password not be used since the project will need to 
be accessed by more than one user. 
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2.5 Project Users Dialog 
Once a project is highlighted and OK is selected, the Project Users dialog appears.  
 
This dialog has three sections: Project Users, 
User Info, and Description.  The Project 
Users list displays a list of users that have been 
created to work with any project that resides in 
the current projects home directory.  The names 
shown in Project Users will be the userid’s of 
the people working on that project as specified 
in the Start Job dialog.  Within the User Info 
group box, the Full Name field further 
identifies the user, and displays the full name of 
the user that is currently selected.  The OP 
Code field displays the GEOPAK Operator 
Code of the currently selected user.  The 
GEOPAK Operator Code is used for all 
coordinate geometry operations during this 
session.  The Operator Code, along with the Job 
Number, will be utilized whenever an input or 
output file is created by the software.  The 
Operator Code will be the user’s first and last 
initials.  The Description field displays the 
description of the currently selected user. 
 
Four tools are supported on the Project Users 
pull down as depicted in the exploded view to 
the right. 

2.5.1 New 
The New pull down menu option creates new users.  This option is not to be used in MoDOT.  
To create a new user for a project, use Start Job/Add User under the MoDOT menu with Add 
Userids to Existing Job activated, as show in the following figure.  Start Job/Add User must be 
used for the user to have the default MoDOT runs. 
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2.5.2 Edit 
The Edit pull down menu option allows the user to change any of the parameters of the currently 
selected user.  (Note: The User cannot be changed.  This will change the user information for the 
current project only.) 

2.5.3 Password 
The Password tool creates or modifies a password for the selected user.  If the selected user 
already has a password, the user will be prompted to enter the current password before 
continuing. 

2.5.4 Exit 
The Exit option closes the User dialog and returns back to the Project Manager dialog. 

2.6 Road Project Dialog 
After a minimum of one user has been defined, selecting the 
OK button on the lower left corner of the Project Users dialog 
or double clicking on a Project User will open the Applications 
dialog as depicted.   
 
When the Road option is selected, the following dialog appears.  
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2.6.1 General Description 
The top of the dialog displays the Working Directory, Working Alignment (if defined), User 
and GEOPAK Job Number.  In addition, a toggle for Working Alignment Influence Runs is 
also supported.  The bottom portion of the dialog box displays the various processes supported 
during the design process.  The small square in the upper right corner (to the right of the Job 
Number) will condense the dialog as depicted in the graphic below. 
 

 
 

2.6.2 Road Project Dialog Menu Bar 
There are three pull down menu bar options: 
File, Remember, and Options.  When the 
File option is selected, the choices are Close 
and Exit.  
 
If the Close option is selected, the user is 
returned to the Applications dialog.  If Exit is selected, the user is exited from Project Manager. 
 
When the Remember option is selected, the 
user can instruct the software to remember the 
Project, User, or Road in subsequent 
sessions.  For example, if all three toggles are 
activated, and the Project Manager is 
completely closed, the invocation of the 
Project Manager immediately invokes the Road Project dialog (flow chart) and utilizes the 
project name, username, etc., which were active when the Remember toggles were selected.  If 
only the Project and User toggles are activated, the user is returned to the Applications dialog in 
later sessions.   If only the Project toggle is activated, the user is returned to the Project Users 
dialog in subsequent sessions.  This option is particularly useful when numerous users are 
working on one project. 
 
The Options menu allows the user to toggle 
on the Autosink option.  When toggled on, 
this option will sink (move behind the open 
drawing views) the Road Project Manager 
dialog when a tool is chosen from the Project 
Manager.  When a tool is closed, the Road 
Project Manager dialog will become the active dialog.  

10/11/02 Missouri Department of Transportation 2-7 



Chapter 2 Project Manager  GEOPAK Road for Bridge 

2.6.3 Working Alignment 
The concept of a working alignment enables the designer to organize a project and to access 
project information without continually typing the required information.  On a simple project, 
only one working alignment may be needed.  However, on a more complicated project, an 
unlimited number of working alignments may be defined.  The designer can easily change from 
one working alignment to another by highlighting the desired alignment listed in the Select 
dialog.  Three tools relating to working alignments are located at the top of the Road Project 
dialog: 
 

• Select Button 
• Define Button 
• Working Alignment Influence Runs (toggle on left side of dialog) 

 

 
 

2.6.4 Select Option 
When the Select button is pressed, the Select Working Alignment dialog appears as depicted to 
the right.  If no working alignments have been defined, MoDOT appears in the Run List box.  If 
working alignments have been defined, they are listed with the last run time.  The description of 
the working alignment can be seen in the bottom of the dialog when each Name is highlighted.  
To select a previously defined working 
alignment, highlight the run from the list 
then press the OK button at the bottom of 
the dialog.  Double clicking on the Name 
also selects a previous working alignment 
for subsequent processing.  Pressing the 
Cancel button will close the Select 
Working Alignment dialog without any 
working alignment change.  Several file 
option are supported as depicted in the 
exploded view below.  These include New, 
Copy, Rename, and Delete.  
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• File>>New – allows the user to 

create a new working alignment.  
(Do not use this option as it will n
copy the default MoDOT setti
for the working alignment.  Instead, 
use Run>>Copy>>Run to copy the 
MoDOT run.) 

ot 
ngs 

hosen, 

on 

w 

 
• File>>Copy – allows the user to 

copy and existing Project, User or 
Run. 

 
• File>>Rename – allows the user to 

change the name of the existing 
working alignment.  

 
• File>>Delete – allows the user to 

delete an existing working 
alignment. 

 

2.6.5 Define Option 
Once a Working Alignment has been 
selected, pressing the Define button 
invokes the dialog depicted to the 
right.  The information that can be 
associated with a working alignment 
is listed in the left portion of the 
dialog box.  As each option is c
the right side of the dialog box will 
change to reflect the informati
needed as can be seen in the dialog 
box to the right after Profile Vie
was selected.  
 
All information entered in these fields 
can be used in subsequent processes 
run from Project Manager.  In the 
beginning of a project, much of this 
information will not be known but, as 
the user goes through the deign 
process, it can be added to the 
working alignment definitions.   
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For example, as soon as the chain 
has been stored in COGO, the user 
can enter that information in the P
View fields as depicted to the right.
For a more complete explana
each option shown, please see the 
GEOPAK Manual. 

lan 
  

tion of 

 
 
 
 

2.6.6 Port Viewer 
The Port Viewer is a tool that enables the user to view all three major aspects of a road design 
simultaneously even though they are located in different files.  The three views include: 

• Plan 
• Profile 
• Cross Section 

As a prerequisite to invoking the Port Viewer, a working alignment must be defined with the 
following information. 

• Alignment Specification 
• Plan View Design File and Chain 
• Profile Information 
• Cross Section File 
• Digital Terrain Models 

The Port Viewer will be covered in more detail in Chapter 16 in the GEOPAK Road 2 part of 
the manual. 
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2.7 Project Manager Process 
The primary Project Manager dialog is depicted below.  The advantage of utilizing the Project 
Manager rather than selecting functions directly from the Road menu is that pertinent 
information stored within the Project Manager is automatically displayed within the invoked 
dialog.  Therefore, job numbers, chain names, stationing, file names, and data associated with the 
project do not have to be typed in each time a dialog is utilized.  However, the user can change 
information in the fields. 
 

 
 
Many of the Project Manager processes function identically to their corresponding dialog’s 
invocation from the Road menu.  However, some of the procedures will invoke the Select Run 
dialog prior to invoking the actual dialog.  The Select Run dialog allows the user to set up 
different options to use in alternative design choices. 
 
Each of the Road Project dialog processes will be covered individually in the separate remaining 
chapters. 

2.7.1 Select Run Option 
When certain procedures are selected from the Project Manager dialog, the Select Run dialog 
will be invoked.  The Select Run dialog allows the user to save the settings for each procedure in 
a Run that can then be recalled whenever the user needs to execute that procedure.  With the 
individual runs, a user can keep a history of the project, and can access the various procedures 
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with the settings that were previously used.  
This way a user can repeat various 
procedures with the same settings 
previously used.  
 
When the Select Run dialog is invoked, 
MoDOT appears in the Run List box.  
(Some Select Run boxes will display 
default run names such as English, Metric, 
I_XS_10, etc.)  If Runs have been defined, 
they are listed with the last run time.  The 
description of the Runs can be seen in the 
bottom of the dialog when each Name is 
highlighted.  To select a previously d
Run, highlight the run from the list, and 
then press the OK button at the bottom o
the dialog.  Double clicking on the Name 
also selects a previous Run for subsequent processing.  Pressing the Cancel button will close t
Select Run dialog without any run settings change.  Several file option are supported as d
in the exploded view below.  These include New, Copy, Rename, and Delete.  
 

efined 

f 

he 
epicted 

• File>>New – allows the user to 
s 

e 

 
 File>>Copy – allows the user to 

 

 
 File>>Rename – allows the user to 

 
 File>>Delete – allows the user to 

create a new run.  (Do not use thi
option as it will not copy the 
default MoDOT settings for th
procedure selected.  Instead, use 
Run>>Copy>>Run to copy the 
MoDOT run.) 

•
copy and existing Project, User or
Run. 

•
change the name of the existing 
Run.  

•
delete an existing Run. 
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Exercise 2-1 

This is an individual exercise to practice setting up the directory structure and files for a new 
GEOPAK job. 
 

1. Open any MicroStation file. 

 

2. Create the following job with the Start Job dialog (MicroStation menu path: 
 
 MoDOT > Start GEOPAK Job/Add User).  
 
Use the settings shown in the following dialog. 

 

 
 

3. Review the directory structure and the files created in the directory.  
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4. Use the Project Manager dialog to create the following project:  
 

Go to the directory t:\br-proj\A_Geopak\D3\j3p0497\project\ 
 

 
 

Choose Projects>>New.   
 

 Enter the following information in the Create New Project dialog as shown below. 
 
Project name: j3p0497 
Working Directory: t:\br-proj\A_Geopak\D3\j3p0497\data 
Job Number: 497 

 

 
 Set up the Preferences as shown below: 
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5. Add User2 and User3 as users to the project.  
 

 

A) Start by 
toggling on 
Add 
Userids to 
Existing 
Job.

B) Continue 
by using 
this 
Browse 
button to 
choose 
the Job 
Number 
and Path.

C) Select the 
USERIDS 
to be added. 

D) Click OK 
to finish 
the 
process. 
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Exercise 2-2 This is an individual exercise to practice setting up a new working alignment. 

1. Open the Microstation file t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn. 
 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj. 
 

 
 

3. Select userc as the Project User. 
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4. Select the Road Project.  

 
 

5. Click on Select button at the top of the Road Project dialog as depicted below. 
 

 
 

In the Select Working Alignment dialog that appears, select the menu option:  
 Run > Copy… > Run. 
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 This will display the Select Run to  
Copy From dialog shown to the right.   
Select the default MoDOT run and  
click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
  
Enter J2P0300 in the new Run  
Name field as depicted in the figure  
to the right and click OK to create  
the new run. 
 
 
 
 
 
 

 
Select the J2P0300 working alignment  
as shown below and enter the alignment  
by clicking OK. 
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6. Enter the working alignment definition by clicking on the Define button to the right of the 
Select button in the Road Project dialog as shown below. 

 

 
 

7. Set up the default DGN files for the J2P0300 project as shown below: 
 
In the Plan View section, change the Design File to plan_j2p0300.dgn. 

 

 
 



GEOPAK Road for Bridge  Ex. 2-2 Working Alignment Setup 

4/14/03 Missouri Department of Transportation 2-2-5 

 In the Pattern section, change the Design File to pattern_shape_j2p0300.dgn. 
 

 
 

In the Shapes section, change the Design File to pattern_shape_j2p0300.dgn.  
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 In the Profile View section, change the Design File to profile_j2p0300.dgn.  
 

 
 

Save the changes to the working alignment definition by clicking OK.  This default 
alignment for the project will be modified and used as the basis for other parts of the project 
in later exercises. 
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3.1 Objectives 

• Learn how to import photogrammetric data and survey data into Geopak. 
• Learn how to map photogrammetric and survey data into a .dgn file. 
• Learn how to create a digital terrain model from photogrammetric and survey data. 

3.2 Definitions 

Geopak Survey is a tool for importing survey data into Geopak to be used in the design process.  
The information from either field surveys or aerial surveys is used to create a digital terrain 
model of the existing conditions as well as for showing the existing planimetric features. 

3.3 Accessing 

Geopak Survey can be accessed from the Project dialog as 
shown to the right.   
 
When Survey is chosen the following Run box is opened. 
 

There are three runs to choose from.  It is 
suggested to always copy a run so there 
will always be a default run available for 
future runs. 
 
Then three runs available to the user are 
PhotoCOR, PhotoLST, and Survey.  The 
PhotoCOR run is for importing Leica 
photogrammetric data files (.cor).  The 
PhotoLST run is for importing KORK 
photogrammetric data files (.lst).  The 
Survey run is set up to import ASCII XYZ 
files in the format of point number, X 
coordinate, Y coordinate, Z coordinate, 
and point code.  If the data file to be 
imported is in a different format, the 
Survey run will serve as a good starting 
point for the import process.  
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3.4 Importing Photogrammetric Data 

Once the one of the runs has been chosen, the following dialogs will open.  (When the PhotoLST 
run has been chosen, a columns dialog will also open.  DO NOT change this dialog.  It is set up 
for importing KORK photogrammetric data.)  

 
The user can either search for the file to be imported by pressing the File button or key-in the file 
name.  On the search box, be sure to change the filter to All Files [*.*]. 
 
After the file is selected, the data will appear in the Contents of File box.  If the file contains any 
header information, the user will need to remove this header information, then select the file 
again.  The user needs to select a line of data from the Contents of File box.   
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From the box on the left side of the dialog select the Mapping Option and the following dialog 
will appear.  

 
Enter the name of the DGN File to be created.  Be sure the SEED File is set to 
topo_jobnumber.dgn..  The topo_jobnumber.dgn file file is a 2D file that has the global origin 
shifted for the project.   
 
A user can turn on the information about the Points to be drawn with the map. 
 

Once the data file is selected, and the DGN File is specified, the user can 
choose the Process Survey button on the Survey Operations flow chart.  This 
will import the data to the Geopak database (.gpk) and map the data to the 
specified drawing. 
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3.5 Importing Survey Data 

The process for importing survey data is the same as it was for importing the photogrammetry 
data.  When the user chooses the Survey run, the Survey dialog appears as shown below. 

 
The user needs to select a line of data, specify the name of the DGN file to import to, and select 
the Process Survey button.  
 
If the file to be imported is not in the format of point number, X coordinate, Y coordinate, Z 
coordinate, point code, the user can assign the proper columns after selecting a line of data.  
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3.6 Creating the Digital Terrain Model 

Once the import of all the survey files is complete, the user is ready to build 
the digital terrain model (DTM).  To begin this process, the user should select 
the Create DTM button from the Survey Project Manager flow chart.   

 
The user can specify the file name of the .tin file to create, and then select the runs to include in 
the DTM by selecting the Set Search button and selecting from the list of available runs.   

 
Digital Terrain Models are discussed in further detail in Chapter 4. 
 

3.7 Mapping 

If the data was not mapped when survey file was processed, the user can map 
the data by using the Mapping button on the Survey Manager.  The user can 
then select the Set Search button to select the run(s) 
they would like to map.  Selecting the Process b
will map the data into the Microstation drawing
specified in the Mapping Option of the Survey 
Manager. 

utton 
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4.1 Objectives 

• Understand Digital Terrain Models (DTM’s) 
• Learn how to analyze a digital terrain model 

 

4.2 Definitions 

A Digital Terrain Model (DTM) represents the topography of a project in the form of a 
triangulation network.  The DTM can be drawn in a three-dimensional file, and rotated to see the 
existing surface of the project area. 
 
Digital Terrain Models can be generated from various sources including Microstation Elements, 
survey data, photogrammetry data, GEOPAK cross-sections, and geometry data. 
 
Triangulation is a mathematical process applied to stored elevation points and stored elevations 
along DTM break lines to create surfaces.  The result of triangulations is the creation of a .tin file 
from which original ground profiles and original ground cross sections can be generated. 

4.2.1 Digital Terrain Models 
Digital Terrain Models (DTM) are made up of a network of triangles.  A triangle is used 
because three points define a particular plane in space.  This triangle then represents a slope on 
the existing ground passing through these three points. 
 
The DTM is made up of several types of elements including points, breaklines, boundary, voids, 
and islands. 

POINTS 
Points represent a particular location with an X, Y, and Z coordinate.  Each of these points will 
represent a vertex on a triangle in the digital terrain model.  Below is an example of a digital 
terrain model made from a set of points.   
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If a section is cut through this digital terrain model at the location A-A, where the elevation of 
the triangle leg as linearly interpolated between the triangle vertices is plotted along the distance 
of the section, the section would look as shown in the picture below. 

BREAKLINES 
t a line along a change in slope.  Examples of breaklines may include the 

gle leg 

dding a breakline to the same set of points used above will produce the digital terrain model as 

 
utting a section at the same location will produce very different results as shown in the section 

Breaklines represen
edge of shoulder, the toe of a slope, or the flow line of a ditch.  A triangle cannot cross a 
breakline.  If a triangle crosses a breakline, it is split into multiple triangles so that no trian
will cross the breakline, and the triangles adjacent to the breakline will have a leg that lays on the 
breakline.   
 
A
shown below.   

C
below. 
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BOUNDARY 
A boundary is the maximum external limits a digital terrain model can extend.  No triangles will 
be created outside of this boundary.  

VOIDS 
A void is an area where no contours can pass through.  Examples of voids include ponds, lakes, 
buildings, concrete pads, etc. 

VOID AREAS

ISLANDS 
An island represents an area inside a void that contains contours.  

ISLAND 
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4.3 Accessing 

Selecting the Existing Ground push-button from Project Manger or the 
DTM Tools icon, and selecting a run will bring up the tool palette 
shown to the right.  All of the DTM tools can be accessed from the 
tool palette or from the DTM menu that can be accessed from the first 
icon in the tool palette.  

 

4.4 Settings 

Two user-defined stroking values need to be defined before graphics can be extracted to create a 
DTM.  Stroking is the process of automatically adding shots to the DTM Input file by 
interpolating new shots from the linear and curved sections of the data.  If the source topography 
data is mapped in a 3D-design file, stroking may be applied.  Stroking is not available if the 
topography data resides in a 2D-design file. 
 

Curve Stroke Tolerance  The maximum distance 
between the arc and the chord used to approximate the arc 
in the DTM. 

 
 

Minimum Linear Distance If a linear segment is greater than the Minimum Linear Distance, 
points are interpolated and added to the segment such that the distance between the points is not 
greater than the Minimum Linear Distance. 

4.5 Extract Graphics 

The Extract Parameters tool translates Microstation elements into DTM input 
data.  The dialog box shown below can be accessed from the GEOPAK DTM 
pull down by single clicking Extract >> Extract Graphics or from the 
Extract Graphics icon in the DTM toolbox.   
 
File Name specifies the name of the file to be created for storing the input data.  If file 

already exists, it may be found using the Files button.   
 
File Type specifies the format of the new file.  Either format will produce the same results.  

The difference between the two is ASCII files can be viewed and edited with a 
text editor while Binary files process faster.  For ASCII files, the number of 
decimal places can be chosen. 

 
File Open indicates if you are creating a new file or appending data to an existing file. 
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Feature Type determines the type of feature 

 
Spots – random survey points. Can 

 
Breaks – designate linear features 

 

 
oundary – the external boundary 

 
ontours – for use in extracting 

 
oid – closed shapes representing an area with no contours.  (i.e. ponds, 

 
lands – an area within a void that contains contours. 

raphic Triangles – for use in extracting triangles from a TIN model that has 

 
rape Void – same as void, except uses the elevation from the triangulated 

 
reak Void – same as void except edges are inserted as breaklines instead of 

 
Mode  e extraction mode calculates XYZ data directly from the coordinate values of 

his 

 
elect Criteria   provides ways to specify the features to be extracted.  When an “X” is placed in 

 
 

, 

 

to extract from a design file. 

be vertices of a line or line 
string. 

such as edges of pavements,
ditch bottoms, ridges, etc. 

B
of the digital terrain model. 

C
digitized or otherwise 
imported contours. 

V
headwalls, concrete pads, etc.) 

Is
 
G

been otherwise created or imported. 

D
model.   

B
drapelines. 

th
3D Microstation elements.  The interpolation mode produces XYZ data by 
interpolating between spot elevations along linear Microstation elements.  T
mode works in both 2D and 3D files. 

S
the box next to Levels, the Select box is activated.  You may then click the Select 
button to indicate only those levels you want GEOPAK to search for when 
extracting data.  If the Levels box is not turned on, GEOPAK will search all
levels.  The same procedure is true for the other criteria selections.  The three
buttons located at the bottom of the Select Criteria group box Match, Display
and Reset will assist you in interactively defining the search criteria. 
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Extract there are four options for data extraction.  Complex Chain reads those elements 

he 

 

4.6 Build 

Included under the Build pull down and icons are options for creating, 

 

4.6.1 Build Triangles 
 the information stored in a DTM input file (.dat) to create a 

ata File is the name of the DTM input file where 
 

e of the file in which the 
iangulated model will be stored in binary format. 

 to 
 file extension with the file name and you 

n always navigate to an existing file using the 

representative of the surface.  The 
ree options are: 

g, thin triangles are dissolved. 
 is longer than a user specified length are 

 
 

along adjoining Microstation elements.  Selection Set uses a Microstation 
Selection Set to define elements for extraction.  Fence will extract all elements 
within a fence boundary.  View 1 etc. will extract all the elements displayed in t
selected view. 

manipulating, and merging DTM models.  
 
 
 
 
 

 

Build>>Triangles processes
triangulated model (.tin).  The file extension represents a triangular irregular network. 

 
D
the extracted topological features are stored.  
 
TIN File is the nam
tr
 
In either of the above cases, you do not have
enter the
ca
Files button. 

The Dissolve Option eliminates external triangles that are not 
 

th
None – no external triangles are dissolved. 
Sliver – lon
Side – external triangles whose external side

dissolved.  (Recommended Option)
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4.6.2 Additional Build Options 
Build >> Lattice creates a grid (.lat) that can be draped over the triangulated data (.tin) to create 
a three dimensional visual display of the topography. 
 
Build >> Merge allows two triangulated models to be merged together as long as the boundary 
of one model overlaps the other.  This process will create a third model (.tin) from the 
combination of the two existing models. 
 
Build >> Clip creates a new model (.tin) from a clipped portion of an existing model. The area 
is defined as internal or external to a user defined clip polygon. 
 
Build>>Pad defines a pad (such as a building slab) and integrates the pad into the existing 
terrain with a variety of slope options. 
 
Build>>Delta Surface creates a new model based on the difference between two other models, 
or a model and elevation surface.  The Z value in the model that is created is equivalent to the 
difference between the two specified models, or model and surface. 
 

4.7 Reports

r 

 

The options under the Reports pull down and icons include a way to check for 
duplicate points or crossing breaklines, and the ability to generate statistics 
associated with a .tin file. 

 
Duplicate Points – reports points with the same x and 
y coordinates. 
 
Crossing Features – reports intersecting breaklines o
contours. 
 
Triangle Statistics and Lattice Statistics - displays a 
summary indicating the total count of each element 
type and minimum and maximum X, Y, Z ranges for 
the specified .tin or .lat file.  
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4.8 Utilities 

Options under the Utilities pull down and icons include a way to 
check the validity of a triangulated file, converting triangulated files 
from previous versions of Geopak, converting the DTM data file 
between ASCII and binary format, converting the DTM from E
to Metric, and exporting a DTM to Trimble DTX model. 

nglish 

 
Convert TIN – permits the conversion of a triangulated file from a previous version of Geopak 
to a Geopak 98 format. 
 
ASCII to Binary and Binary to ASCII - permits conversion of the DTM input file (.dat) 
 
Check Triangulation - starts an internal process that verifies the integrity of the triangulated 
file.  A message will appear indicating "Triangulation Valid". 
 
Metric <-> English – converts a file from English to Metric units, or from Metric to English or 
Imperial units.  A custom scale factor can also be used.  The DTM can also be translated or 
rotated.  If translation or rotation is desired without scaling, a Custom scale of 1.0 can be used.  
This process will create a new DTM file. 

4.9 Load 

 Load is the process by which we can visualize the DTM data, the TIN model, the 
lattice model, and the contours.  By clicking on Load >> DTM Feature, or by 
clicking on the icon, the following dialog will appear.   
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The user can choose to load the DTM data (.dat), the TIN file (.tin), or the lattice 
file (.lat).  Each of these files can be loaded for the model extents, within a fence, 
or within a window.  
 
 
 

 
Toggling on Display Only will allow the user to view the 
elements without writing them to the Microstation file.  

Conversely, toggling Display Only off will store the viewed elements as Microstation elements.  
If Display Only is on, updating the active screen will clear the display of these elements.  When 
Display Only is off, the elements can be placed as a graphic group using the Graphic Group 
toggle.   
 

The user can set what data to 
visualize, the symbology, and the 
contour interval (if Contours is 
turned on). 
 
 
 
 

 
 Will turn on all items. 

 
 Will turn off all items. 

 
 Will turn on only the selected item. 
  

 Will turn off only the selected item. 
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4.10 Other Pull Down Menus 

EDIT 
The Edit pull down provides the ability to edit the digital terrain model. 

 
Triangles - Allows the user to add, delete, or modify triangle vertices, triangle legs, and 
breaklines. 
 
Duplicate Points – Reports and allows interactive editing of points in a survey data file with the 
same X and Y coordinates. 
 
Crossing Features – Reports and allows the correction of crossing breaklines. 
 
Filter Vertices – Reduces the amount of vertices by deleting the vertices based on a user 
specified distance. 
 
Join Linear Features – Allows the user join two linear features into one feature. 
 
Z Range Clip – Deletes information from the survey data file (.dat) based on given elevation 
information. 

DRAPE 

GEOPAK provides two tools for draping Microstation elements onto a triangulated model, 
vertices and vectors. 
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ANALYSIS 

The Analysis tools allow the user to view the digital terrain model through 
many different methods such as a profile, themes, and drainage. 
 
 

Height – Show the user the x, y, and z coordinates and the slope of a given data point.  The 
contour at that elevation, the triangle the point lies within, and the direction of flow can be 
displayed. 
 
Profile – Will display the profile of the digital terrain model between two points. 
 
Volumes – Will calculate the volume between two TIN models, the volume between a TIN 
model and a plane, or the cut and fill totals between two TIN models. 
 
Elevation Differences – Will display the elevation difference, or the amount of cut and fill 
between two TIN models, or a TIN model and a plane. 
 
Slope Area – Displays the slope area of a TIN model, or a portion of a TIN model. 
 
Themes – Displays the digital terrain model based on different user definable themes such as, 
elevation ranges, slope percentage, slope degree, or aspect. 
 
Drainage – Allows a user to display and analyze drainage patterns with in a TIN model.  Tools 
include delineating watersheds, drawing flow arrows, determining upstream and downstream 
traces, and finding high and low points. 
 
Visibility – Displays lines of sight (which triangles can and cannot be seen), or what is visible 
between two specified points. 
 
For more information on these items, see the Geopak Manual or online help. 
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Exercise 4-1 
This is a group exercise to present several GEOPAK Digital Terrain Modeling (DTM) tools. 
 

1. Open the Microstation file t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn. 

 

2. Open the project j2p0300.prj.  Enter the project as user userc and select Road. 

 

3. Make sure that the Working Alignment is J2P0300.  

 

4. Select Existing Ground from the upper left corner of the Road Project dialog flow chart. 
 

 
 

Copy the MoDOT run to J2P0300, and open the J2P0300 run.  This is the same Run > 
Copy… > Run process used in creating a new working alignment.  GEOPAK uses runs to 
keep track of specific dialog and tool settings.  A run allows the user to repeat a task without 
having to reenter all of the needed information. 

 

 
 

The DTM tools for the following steps may be accessed from either the  
toolbox shown to the right or the DTM Menu bar depicted below. 

 

 
 

This icon 
opens the 
menu bar.
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5. Use the Build Merge TINs tool (DTM menu path Build > Merge TINs or the  
raised icon shown to the right) to merge the 20201dm.tin with the 20302dm.tin.  

 
To do this, set 20201dm.tin as the Old Tin and 20302dm.tin as the Mrg Tin.   
You can either type in the TIN names or use the Files button to select the TINs. 
 
Set the New Tin to J2P0300.TIN.  This needs to be typed since this file needs to  
be corrected.  This Files button is used only if the already exisits. 

 
Click on Process to initiate the merge tin process. 

 

 
 

6. Check the Triangle Statistics (DTM menu path Reports > Triangle Statistics  
TINs or the raised icon shown to the right) of the tin file j2p0300.tin.  Use the  
Files button shown below to select the TIN or type its name into the field.  Select  
the Process button to calculate and report the TIN statistics. 

 

 
 

It is a good idea to check the statistics for any new DTM to make sure that its information 
matches the known project data.  The minimum X and Y values can be used to set the custom 
coordinates for a MicroStation file created to display the DTM. 
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7. Open the Load DTM Features dialog (DTM menu path Load > DTM Feature or the raised 
icon shown to the following figure).   

 

 
 

Set the Load File to TIN and the file to J2P0300.TN.  Load the Tin Hull as a Graphic 
Group, by setting up the dialog as shown below.  (See the manual for instructions on how to 
use the “light bulb” icons to toggle an items Display on and off.) 

 

 
 

Fit the MicroStation view so you can see the boundary of the TIN model. 
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8. Turn off the Tin Hull and turn on the Contours, Major and Minor Lines, and Major 
Label items.   
 
With the Contours line highlighted, click on the Read button to set the elevation range of the 
TIN and set the following parameters: 

 Minor Interval: 2.000 
Major Interval: 10.000 

 

 
 

Switch to the Major Label line.  Set the text size to 12 and the Distance Between labels to 
1000.  Load the contours as a Graphic Group. 
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9. Close Load DTM Features and save changes to the MicroStation drawing. 

 

10. Turn on Level 22.  It contains a line indicating the location of an upstream valley section. 
 

Open the Site Profile tool.  It can be opened by going to DTM pull down menu item 
Analysis >> Profile or clicking on the second icon in the Analysis tool box, which is 
depicted below and is the tool box in the lower left hand corner of the DTM tools pallet. 

 

 
 

The Site Profile dialog is shown below. 
 

 
 

Under the Selection tab, add the J2P0300.TIN to the list by entering it in the Tin File field 
and clicking on the Add List Item icon: .  Once the TIN has been added to the list, the list 
area should look like the following: 
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11. Under the Profile tab, click on Select Element.  Data point on the line locating the valley 
section and accept.  This will place the valley section in the dialog, as shown below: 

 

 
 
12. Under the Preferences tab, set up the preferences to display a grid.  Use the settings shown 

below.  Go to Applications >> GEOPAK Road >> User Preferences to set the number of 
decimal places shown 2 for stations and distances. 
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13. Set the major horizontal and vertical grid symbology to that shown in the following figure.  
To display this dialog, double click on the line preview area to the right of Major Symb.  
Since the settings for each grid are set independently, you need to change the settings for 
both grids. 

 

 
 

 
14. Set the minor horizontal and vertical grid symbology to that shown in the following figure.  

To display this dialog, double click on the line preview area to the right of Minor Symb.  
Again, this needs to be set for each grid. 

 

 
 

 
15. Set the major horizontal and vertical text to the properties shown in the following figure.  To 

display this dialog, double click on the text preview area to the right of Major Text.  
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16. Return to the Profile tab.  The dialog should look similar to the one shown below. 
 

 
 

Navigate to a blank area of the MicroStation drawing.  Click on Place Profile in the Site 
Profile dialog and place the profile in the MicroStation file. 

 

17. Close all DTM dialogs and save changes to the MicroStation drawing. 
 

18. Return to the Road Project dialog by selecting the Project Manager Icon in the Road 
toolbox.  Click on the working alignment Define button.  Go to the DTM section and set 
both the Existing Ground Tin and Portview Tin to J2P0300.TIN as shown below. 

 

 
 

Click the OK button and Exit Project Manager. 
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1. Coordinate geometry elements are stored in 

a. .GPK files. 

b. .INP files. 

c. .IOC files. 

d. .OOC files. 

 

2. .TIN files store triangular surface information. 

a. True 

b. False 

 

3. ____ is a tool for setting up a new GEOPAK job, or adding users to an existing 
project. 

a. Project Manager 

b. Start Job 

c. GEOPAK Manager 

 

4. Job Number in Start Job and Project Name in Project Manager should be the same. 

a. True 

b. False 

 

5. The first step in creating a new Project Manager (.prj) file is to 

a. select Project>>New. 

b. navigate to the t:\br-proj\a_geopak\district\jobnumber\data directory. 

c. set the working directory. 

d. navigate to the t:\br-proj\a_geopak\district\jobnumber\project directory. 

 

6. Breaklines are used to define a change in slope. 

a. True 

b. False 
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5.1 Objectives 

• Learn to set up and access the coordinate geometry database. 
• Become proficient in using Geopak Coordinate Geometry. 

5.2 Definitions 

Coordinate Geometry (COGO) is a method of using XYZ coordinates to store geometric 
elements such as points, lines, curves, spirals, chains, parcels, and profiles.  The Coordinate 
Geometry dialog box is an interactive graphical user interface for storing coordinate geometry 
elements. 

5.2.1 Coordinate System 
The coordinate system is defined with XYZ coordinates.  The X and Y coordinates define a 
horizontal plane, while the Z coordinate defines the vertical dimension.  All points in a cogo 
element are defined by at least an X coordinate and a Y coordinate.  If an elevation is to be 
stored, the Z coordinate will also be defined.   
 

 
The XYZ coordinates can also be referred to in Northing (N), Easting (E), and Elevation (Z) 
coordinates.  The Northing coordinate refers to the Y value, the Easting coordinate refers to the 
X value, and the Elevation refers to the Z value.   
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The user must be aware of the coordinate system the data is in, and the coordinate system that 
GEOPAK is using.  When referring to the XYZ coordinate system, the coordinates are listed as 
(X, Y, Z).   When referring to the Northing, Easting, Elevation coordinate system, the 
coordinates are listed as (N, E, Elev.).  When translating this to the XYZ coordinate system, the 
coordinates would be (Y, X, Z). 

5.2.2 Points 
Points are defined by a single set of coordinates.  Each point will have an X and a Y coordinate.  
The point may also have a Z coordinate if an elevation is defined.   
 
Point names are alpha-numeric.  If alphabetic characters are used, they must come before any 
numeric characters.  The point name must contain at least 1 numeric character at the end of the 
name.  Names can be up to 9 characters in length, although limiting the name to 8 characters is 
recommended. 
 
Points can be stored from a set of coordinates, or located from other elements.  To define a point 
from another point, a distance and direction need to be defined.   

 
 
Modifiers can be added to the direction and distance.  An offset can be applied.  This will locate 
the point at the specified distance and direction from the starting point, then perpendicular to the 
specified direction for the specified offset distance.  A positive offset will go to the right of the 
specified direction, and a negative offset will go to the left of the specified direction 
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Distances and directions can also be found mathematically.  Values can be added, subtracted, 

 

multiplied, divided, or computed with a trigonometry function  

5.2.3 Lines and Line Segments 
d a direction, and are infinite in length.  Line Segments 

 

loc 115 trav 102 dis 107 to 108 m 20.50 n 40 18 33 w off 30 

Lines are defined by a location point an
are a portion of a line that is defined by a beginning and an ending point.  Line Segment names 
can be alpha-numeric up to nine characters, but cannot  be numeric-alpha. 

 

10/11/02 Missouri Department of Transportation 5-3 



Chapter 5 Coordinate Geometry GEOPAK Road for Bridge 

5.2.4 Curves 
Curves are a segment of a circular arc.  Curves can be defined by either the arc method (central 
angle that produces a 100’ arc) or chord definition (central angle that produces a 100’ chord).  
MoDOT uses the arc definition for all new alignments, however the chord definition has been 
used in the past, and may still be shown on old plans. 
 
A curve has several points associated with it.  These points help to define the curve, and are 
stored automatically when the curve is stored. 
 
PC – Point of Curvature; Beginning of the curve. 
PT – Point of Tangency; End of the curve. 
PI – Point of Intersection; Point where the two tangents meet. 
CC – Circle Center; Point at the center of the circle from which the curve is segmented. 

 
 
 
Curve names can be any alpha-numeric characters up to nine characters in length. 
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5.2.5 Spirals 
Spirals are a transitional curve.  Typically a spiral will transition from a tangent (infinite radius) 
to a specified radius defined by a curve.  Spirals can also transition between 2 specified radii as 
defined by 2 curves. 
 
Several points are also stored with a spiral.  They are as follows: 
 
TS – Tangent to Spiral Point 
SC – Spiral to Curve Point 
CS – Curve to Spiral Point 
ST – Spiral to Tangent Point 
PISCS – Overall Point of Intersection for the spiral-curve-spiral combination. 

 
 

5.2.6 Chains 
Chains are a combination of other elements.  They can consist of points, curves, spirals, or other 
chains.  Chains can represent horizontal alignments, or the horizontal location of some element.  
Chains have stationing associated with them.  Locations along the chain can be determined by 
the stationing.  If the stationing is adjusted along the chain a station equation is used.  The 
stations from the beginning of the chain to the first station equation are referred to as Region 1.  
The stations from the first station equation to the second station equation or the end of the 
chain are referred to as Region 2. 

 
 
Chain names can be any alpha-numeric characters up to a length of nine characters. 
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5.2.7 Profiles 
Profiles are vertical alignments defined by stations and elevations.  They are generally 
associated with some horizontal chain.  Profiles can be stored with or without vertical curves.  
Profiles without curves generally represent the existing ground profile, or a ditch profile.  
Profiles with vertical curves are generally used as proposed alignment profiles. 

5.3 Accessing 

From Project Manager choose Coordinate Geometry, or choose the Coordinate 
Geometry icon.  

 
When Coordinate Geometry is started, the Start-Up 
Dialog Box appears.  
 
Project Name – shows name displayed on reports 
(optional entry, 60 alphanumeric characters max).  If 
Project Manager is used, this field will be filled in 
automatically. 
 
Job Number  - identifies coordinate geometry database 

(3 alphanumeric characters, max) (required). If Project Manager is used, this field will be filled 
in automatically. 
 
Operator Code – identifies a unique 2-character operator code.  Allows multiple users access to 
database.  (Required, user’s initials suggested). If Project Manager is used, this field will be 
filled in automatically. 
 
Subject - description of work (48 alphanumeric characters, max) (optional) 
 
Once these parameters have been defined, the coordinate geometry dialog box will appear. 
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5.4 Coordinate Geometry Dialog Box 

The coordinate geometry dialog box is made up of three separate display areas: 

1) Tool Bar consisting of pull down menus and icons.  The icons displayed are 

tory of commands to be seen. 

 

3

2 

1

 

customizable. 
 

2) Command Key-in allows commands to be typed in.  The drop down button 
allows for a his

 
3) Output Window shows the results generated by the commands. 
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5.4.1 File Commands 

Append - this command is for input files only. A new input file is created by copying the 
 input file; you must use the Save 

.  
on is taken. 

the 
ect directory. 

 displayed in the output buffer and 

9.ooc) 

ands to a Geopak COGO input file. 

nd Geopak chains and points 

 file. 

ves the input buffer, No exits without saving, Cancel returns to the 
OGO session. Whether you pick Yes or No everything you did is still saved in the .gpk file. 

contents of an existing input file to the end of the current
command to store this new file. 
 
Catalog - when selected, a menu appears listing all saved input files in the project directory

his is for reference only no actiT
 
Delete - when selected, a menu appears listing all saved input files. Highlight a file then click 

K button to remove this file from your projO
 

Load - when selected, a menu appears listing all saved input files. Highlight a file then click the 
OK button. The input lines from the highlighted file are now
are ready for modify, delete, edit or read. 

 
Output - writes a Geopak output file from your current output buffer session to a newly created 
file for reviewing and printing. (Fname99

 
Print - sends your output/input file to the printer. 
 
Restore – converts an ASCII file of Geopak comm
  
Save - will save the current input buffer to a file. (Fname999.ioc) 
 
Export - will export Geopak chains and profiles into RDS format a
nto SDMS format. i

 
Import - will import horizontal and vertical alignments and points from RDS and SDMS format 
nto the Geopak .gpki

 
Exit - closes the COGO dialog box and ends the coordinate geometry session. A prompt to save 
the session appears. Yes sa
C
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5.4.2 Edit Commands 

 
Clear - empties the memory of the current input and output buffers without saving and initializes 
the line numbers to begin a new sequence of commands. 
 

ds in the input buffer by line number (or range of line numbers) 
nd re-sequences the line numbers for the remaining commands. 

 
ring will automatically be re-

er to change a word in a command line. The modified command line will 

 
g a ange of line numbers (Line Range). 

Delete - deletes input comman
a
 
Editor - opens the Geopak COGO Command Editor, which allows the user to edit an input 
ile before executing. f

 
Insert - allows the user to add a command line to the current input buffer before a specified line

umber; the other command lines will shift down and line numben
sequenced 

 
odify - allows the usM

not be computed until the operator uses the Read command. 
 
Read - the lines in the output buffer are processed. This may be done for the entire file (All) or
by specifyin  r
 
Type - displays the content of the current input file, (All) or a portion of the file by specifying a 
range of line numbers (Line Range). 
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5.4.3 Element Commands 

ELEMENT>>POINT 

 
Cell - assigns a cell name to a previously stored point 
 
Copy – copies points or a point range to a new point number or range within the same Geopak 
database 
 
Delete - allows you to input a point number (or range of numbers) to be deleted from the 
database. 
 
Elevation - assigns an elevation to a previously stored point 
 
Equate - stores a new point with the same values as a previously defined point 
 
List/Print - input a range of point numbers; List displays only the point numbers currently 
stored in the .gpk file.  Print displays point number, x, y, z coordinates, station value and other 
information in the output buffer for the requested points. If visualization is on, this will cause the 
points to be displayed. 

 
Station - allows you to specify a station for an 
existing point. 
 
Store - stores a point located by key-in or by 
digitizing a point on the screen. A station, 
elevation, point code, cell, feature, or description 
can be added to the point.  
 
Transformation - transform one set of points into 
a new coordinate system. 
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Compare Points to TIN – computes the elevations of a given set of points based on a given 
DTM, and outputs the elevations to a text file. 
 
Set Elevation From Tin – computes the elevations of a given set of points based on a given 
DTM, and stores the elevations to the points. 

ELEMENT>>CURVE 

Copy - copy a specified curve to another curve name 
 
Data - calculates the geometric parameters of a curve, displaying values for Delta, Degree, 
Tangent, Length and Radius 
 
Delete - will delete selected curve from the .gpk database 
 
List/Print - will display all curve data for the selected curve. List displays only the curve names 
currently stored in the .gpk file.  Print displays the curve data of the selected curve.  Also if 
visualization is on this will cause the curves to be displayed. 
 
Segment – defines new curves by dividing a stored curve into segments. 
 
Station - allows the user to identify a curve and the position on the curve (PC, PI, or PT) that a 
station value may be assigned. 
 
Store - provides 
various options for 
defining and s
lines and curves 
such as Store 
Curve from 
Tangents as shown 
to the right.  

toring 

 
Transpose – 
reverses the curve 
direction. 
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ELEMENT>>SPIRAL 

 
Copy - copy a specified spiral to another spiral name 
 
Delete - will delete selected spiral from the .gpk database 
 
List/Print - will display all spiral data for the selected curve. List displays only the spiral names 
currently stored in the .gpk file.  Print displays the spiral data of the selected spiral.  Also if 
visualization is on this will cause the spirals to be displayed. 
 
Store - provides various options for defining and storing spirals. 
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ELEMENT>>CHAIN 

 
Area – calculates the area of a closed chain 
 
Delete - deletes selected chains from .gpk database 
 
Layout Offset – computes the station and offset of a point or a chain based on a given chain. 
 
Describe/List/Print – displays chain information.  Print displays the name of each chain 
element.  Describe displays the alignment data of each element in the selected chain. 

 
Stationing - provides a method for stationing or re-stationing a chain. 
 
Station Equation - provides a method for applying a 
station equation to a chain 
 
Store - provides three options for storing a chain in 
the database, From Elements, From Offset Chain, 
and Transition Chain.  
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ELEMENT>>PARCEL 

Delete - deletes selected parcels from .gpk database 
 
Describe/List/Print - displays parcel information.  Describe displays the elements of 
composition, the area of tract stored, taken and remaining and a point, bearing, distance 
description of the specified tract.  Print displays the elements of composition, the area of tract 
stored, taken and remaining. 
 
Store - allows a user to store a parcel by adding points, curves and spirals. 
 
Subdivide – divides a parcel into individual lots. 
 
Editor – edits a parcel 

 
Manual Entry - Parcel Commands 
 
Store Taken - allows you to store the portion of a parcel taken by entering point and curve 
names in either a clockwise or counterclockwise direction. 

 
Store Easement - allows you to store an easement by entering point and curve names in either a 
clockwise or counterclockwise direction. 
 
Own Parcel - stores the name of the owner associated with a previously stored parcel.  

 
Make Legal - creates a legal description and writes it to a user named text file. 
 
For more detailed parcel information, the Geopak Manual or the online help. 
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ELEMENTS>>PROFILES 

Delete - deletes selected profiles from .gpk database 
 
Elevation - provides three options for reporting elevations along a selected profile, Station, 
Even Station, Incremental Stations 
 
List/Print – displays profile information. Print displays the data of the selected profile from the 
.gpk database 
 
Offset – stores a new profile at a given vertical offset. 

5.4.4 View Commands 

Icons – allows the user to customize which icons appear in the tool bar. 

Redefine – shows the Redefine box on the tool bar. 

isualization – shows the visualization items on the tool bar. 

ormat – shows the format items (i.e. number of decimals, station format, etc.) on the tool bar. 

OGO Key-in – shows the COGO Key-in box for entering commands in the dialog. 

ommand Output - show the Command Output Window in the dialog box, and controls 

 

 
V
 
F
 
C
 
C
options for the Command Output Window. 
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Error Alert – allows the user to turn on a beep and/or bring up the COGO dialog when an error 

5.4.5 Tools Commands 

ocate – locates a point from another point by several methods such as distance and direction, or 

Superelevation – calculates the superelevation f r a given chain.  (This will be covered in more 
detail in Chapter 11) 

occurs.   

Intersect – stores a point at the intersection of the defined elements 

 
L
station and offset.  (To locate by distance and bearing, use the Tools >> Locate >> Traverse) 

 
o
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Inverse – calculates the distance and direction between points.   

n more detail in Section 5.5) 

a set. 

ulates the data for the intersection of two roadways. 

inate geometry data with the data displayed 
 the Microstation file. 

nts (Temporary) – clears the temporary visualized elements from the 
iew. 

Visualized Elements (All) – clears the visualized elements from the Microstation file. 

n/off.  If Redefine is on, COGO data 
an be redefined/overwritten.  (It is recommended to work with Redefine off so the user does not 

ents to be displayed in the Microstation file permanently or 
mporarily. 

isplay – toggles between displaying NE or XY coordinates. 

 
Navigator – starts the COGO Navigator.  (This will be covered i
 
Best Fit – calculates a best-fit chain through a set of points. 
 
Translation and Rotation – moves, rotates, and scales a dat
 
Map Check – edits a parcel. 
 
Roadway Intersection – calc
 
Cul-de-sacs – calculates the data for a cul-de-sac. 
 
Redraw Visualized Elements – re-syncs the coord
in
 
Clear Visualized Eleme
v
 
Clear 

5.4.6 User Preferences 

Dialog - allows access to COGO Preferences dialog box. 
 
Redefinition of Elements – toggles the Redefine option o
c
overwrite another user’s data.) 
 
Visualization – allows the elem
te
 
Coordinate D
 
Angle Display – toggles between displaying Bearing or Azimuth. 
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5.5 COGO Navigator 

COGO Navigator is a tool to easily view and 
edit COGO data.  Navigator can be accessed by 
the pull down menu COGO >> Tools >> 
Navigator or by the Navigator icon.  The following 
dialog box will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
From the Navigator, points, curves, spirals, chains, survey 
chains, parcels, and profiles can be added, deleted, 
modified, identified, visualized, printed, or selected. 
 
 

NAVIGATOR>>SELECT 
Select All – selects a
points) 

ll data items of a certain type.  (I.e. all 

 
Invert Selection – selects all items not previously selected, 
and unselects all items previously selected. 
 
Clear Selection – unselects all items. 
 
Selection Set - allows the user to create a selection set that 
meets particular criteria.  This is the same as using 
the Selection Set icon.  

 
Fit View (Selection Set) – fits the items selected to the active Microstation window. 
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Show Selected Elements Only – only the items in the selection set will be displayed in the 
Microstation window. 
 
Show All Elements – all items in the database will be displayed in the Microstation window. 

NAVIGATOR>>TOOLS 

 Add Element – allows the selected type of 
element to be stored. 
 

 Delete Element – deletes the selected type of 
element.  
 

 Edit Element – allows the selected element 
to be edited. 
 

 Identify Element – allows the user to select 
an element by selecting it graphically. 
 

 Print/Describe Element – displays the 
selected element’s coordinate or alignment data. 
 

Edit Element Feature – Changes the feature code of the element. 
 

 Visualize Element – displays the selected elements according to their feature codes. 
 
Unvisualize Element – un-displays the selected elements. 
 
Visualize All – displays all of the elements of a certain 
type, or all elements. 
 
Redraw Visualized Elements - re-syncs the coordinate 
geometry data with the data displayed in the Microstation 
file. 
 
Clear Visualized Elements (Temporary) – clears the 
temporary visualized elements from the view. 
 
Clear Visualized Elements (All) – clears the visualized 
elements from the Microstation file. 
 
Settings – allows the user to define certain actions and 
behaviors of the Navigator.  
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5.6 Importing CEAL Data 

A CEAL interface file can be imported using the following command: 
 
 LOAD CEAL FILE filename 
 
where filename is the name of the CEAL interface file.  This command will create a Geopak 
input file that can be saved or read.  Points, curves, spirals, chains, and alignment profiles can be 
transferred to Geopak from CEAL.  Once the above command has been executed, to store the 
data into the .gpk file the input file must be read by going to Edit>>Read All. 

5.7 Bridge Deck Elevation Commands 

COGO solves the deck elevation requirements for the design of highway bridges.  The elevations 
computed by GEOPAK are top of slab elevations within the limits of the bridge.  The program 
computes deck elevations on a per span basis along the edge of the deck, gutterlines, centerline 
bearings, beams parallel to any line defined by two points, curves or lines concentric to the 
baseline, or non-parallel lines defined by unequal spacing along the piers.  The software is also 
capable of computing deck elevations between parallel or non-parallel piers.  Note these 
commands are not located on pull down menus and must be keyed in. 
 
Most of the commands in this chapter are provided with graphic illustrations and are indexed in 
the following order: 
 

BRIDGE name name of the bridge for output 
PROFILE name a profile already stored in GPK. 
TIE value defines the location of the profile grade line 
SE commands width and slopes across the bridge 
ALI name a chain already stored in GPK. 
PIER command defines the direction of the piers (optional) 
SPAN command defines the layout of the span 
CB command refers to Centerline Bearing Elevations (optional) 
FC command refers to the edge of the deck elevations (optional) 
GU command refers to the gutterline elevations (optional) 
BEAM commands set the framing plan for the current span 
End Span command initiates the calculation 
Edit Text command displays the results of the calculation 
 

The following convention will be used in presenting the bridge deck commands:  Words in all 
upper case letters indicate command names.  Lower case words indicate alphanumeric values 
provided by the user.  Since many keywords can be abbreviated, the minimum required is 
underlined.  As always, it is recommended that COGO element names be limited to nine 
characters.  For a full presentation of the COGO conventions go to Applications >> GEOPAK 
Road >> Help >> Coordinate Geometry and select the topic General Reference / General 
Conventions. 
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5.7.1 Bridge Name 

BRIDGE name 
 

The Bridge name command stores the name of the bridge.  The name of the bridge and the name 
of the span together form the name of the Deck Elevations Table for the current span. 

5.7.2 Profile Name 
PROFILE name 

 

The Profile name command refers to a previously defined profile utilized to define the deck 
elevations of the bridge.  If the profile name is not stored, a message will be printed.  Station 
equations along this profile, if any, must match the station equations along the chain (ALI name). 

5.7.3 Tie Value 
TIE value 

 

The Tie Value command defines the horizontal location of the Profile Grade Line (PGL) by a 
radial distance (or value) measured from the baseline or centerline of construction of the bridge.  
When the PGL is located to the left of the baseline the tie value is negative. 

 
When the profile grade line is coincident with the baseline, the Tie value is zero as depicted 
above. 

 
When the profile grade line is to the right of the baseline, the Tie value is positive as depicted 
above. 

 
When the profile grade line is to the left of the baseline, the Tie value is negative as depicted 
above. 
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5.7.4 SE Command 

SE station (R region) LT slope1 dist1 slope2 RT slope1 dist1 slope2 
 
The SE command set the slopes in percentage across the bridge from the PGL, left and right.  
The slope1 in percentage applies across the distance dist1, and slope2 applies to any point 
beyond the distance dist1 (left and right).  Slopes are negative when going down away from the 
PGL.  Three examples are given below. 
 

 
SE sta1 LT s1 dist1 s2 RT s1 dist1 s2  

 

 
SE sta2 LT s1 dist1 s2 RT s1 dist1 s2 

 

 
SE sta3 LT s1 dist1 s2 RT s1 dist1 s2 

5.7.5 ALI Name 
ALI name 

 
The ALI name command refers to a chain already stored in the GPK.  It defines the stationing of 
the bridge.  Station equations along this alignment or chain, if any, should match the station 
equations along the profile. 
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5.7.6 Pier Command 

PIER BK direction AH direction 
 
The Pier command sets the direction from right to left of the pier centerline.  When the Pier 
command is not used, the piers are assumed perpendicular or radial to the baseline. 

 
Pier BK N 40 12 34 E   AH  N 0 E 

 
Pier BK AZ 37 40   AH AZ 37 40 

5.7.7 Span Command 
The Span commands define the beginning station (bk_sta) and the end station (ah_sta) of the 
current span along with the location of the required elevations. 

 
Format A: 

 
SPAN (name) bk_sta ah_sta segments (+) 

 

Defines the current span defined from pier on bk_sta to pier on ah_sta, where: 
 name = the name of the span,  
 bk_sta = the station value for the centerline of the back pier, 
 ah_sta = the station value for the centerline of the ahead pier, and 
 segments = the number of equal length segments along the span. 

 

Elevations are calculated perpendicular or radial to the baseline at each segment.  The optional 
(+) calculates elevations on the pier ahead. 
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Format B: 

 
SPAN (name) bk_sta ah_sta segments (+) P 

 
Current span defined from pier on bk_sta to pier on ah_sta, with the terms used as defined above.  
Elevations are calculated at each segment and parallel (P) to the pier on bk_sta.  The optional (+) 
calculates elevations on pier ahead. 
 
Format C 

 
SPAN (name) bk_sta ah_sta IN v (+) 

 
Current span defined from pier on bk_sta to pier on ah_sta, where: 

 v = interval length and the rest of the terms are used as define above.  
 
Elevations are calculated at equal intervals (IN v) measured from the pier on bk_sta. The 
optional (+) calculates elevations on pier ahead. 

5.7.8 CB Command 
CB value 

 
The CB commands calculate deck elevations at the Centerline Bearing of the current span.  
When value is positive, the elevations are computed along a line parallel to and right of the pier 
on the back station; when value is negative the elevations are computed along a line parallel to 
and left of the pier on the ahead station.  Centerline bearing elevations are specified with 
asterisks (*) in the table of elevations for the current span. 
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5.7.9 FC Command 
The FC commands calculate deck elevations along the Face of Coping or edge of the deck.  
This edge is defined by a line concentric to the baseline at the offset distance offset_left or 
offset_right, or along a line designated by two points. 
 

Format A: 

 
FC offset_left offset_right 

Deck elevations along a line concentric to the baseline at offset distances, left and right. 
 
Format B: 

 
FC pa, pb offset_right 

Deck elevations along a line to the left of the baseline, from pa to pb, and along a line to the 
right and concentric to the baseline at offset distance. 
 

Format C: 

 
FC pa, pb pi, pj 

Deck elevations along a line to the left of the baseline, from pa to pb, and to the right of the 
baseline from pi to pj. 
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Format D: 

 
FC offset_left pi, pj 

Deck elevations along a line to the left and concentric to the baseline at offset distance 
offset_left, and along a line to the right of the baseline from point pi to point pj. 

5.7.10 GU Command 
The GU commands calculate deck elevations along the gutterline of the current span.  The 
gutter is defined by a line concentric to the baseline at the offset distance offset_left or 
offset_right, or along a line designated by two points pa, pb (to the left of the baseline) or pi, pj 
(to the right of the baseline).  It uses the same four formats as the FC Command 

5.7.11 Beam Command 
The Beam commands calculate deck elevations along beams defined by offset distances 
concentric to the baseline (Format A); parallel to a line pa, pb (Format B); by points (Format C) 
or along unparallel lines defined by unequal spacing along the piers (Format D). 
 
Format A: 

 
BEAM OFF offset1 offset2 offset3 . . . offsetn 

 
Negative offsets are to the left of the baseline and positive offsets are to the right. 
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Format B: 

 
BEAM PAR pa, pb beam_spacing number_of_beams 

 
The beams are laid out parallel to the line from pa to pb, which defines the location of the left 
most beam as shown above.  The value Beam_spacing designates the spacing between the 
beams with the value number_of_beams indicates the number of beams. 
 
Format C: 

 
BEAM BY POI pa, pb 

 
Locates a single beam running from pa to pb. 
 
Format D: 

 
BEAM pe, pf FROM n1 SPS v1 n2 SPS v2 . . . TO m1 SPS w1 m2 SPS w2 . . . 

 
The line from the previously defined point pe to the previously defined point pf locates the left 
most beam with the other beams located along the back (FROM) pier at n1 spaces of length v1, 
n2 spaces of length v2…and located along the ahead (TO) pier at m1 spaces of length w1, m2 
spaces of length w2…. 
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5.7.12 End Span Command 

END SPAN 
 
The End Span command initiates the calculation of elevations for the current span and stores, on 
disk, a table of elevations with a name composed of the name of the bridge, a hyphen, and the 
name of the span (bridge-span).  An ASCII file is also stored for digital terrain modeling 
purposes.  This ASCII file has a name composed of the name of the span, a dot, and the 
extension xyz.  If no name has been stored for the current span, COGO, assigns numbers to the 
span starting with number 1. 

5.7.13 Edit Text Command 
EDIT TEXT bridge-span.TXT 

 
The Edit Text command displays the table of deck elevations stored on disc as bridge-name, 
hyphen, span-name.  When the table exceeds 8 columns, COGO breaks the table into groups of 8 
columns.  The file can also be viewed with any text editing program. 

5.7.14 Point Elevation Command 
POI/EL list 

 
The Point elevation commands calculate deck elevations for any points on the deck, which has 
been stored in the coordinate geometry database file, where list is the list of points.  This 
command is active only when the Alignment, Profile, Tie, and Cross-slopes (SE commands) 
have been previously designated. 
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5.7.15 Example 

 
 
The input commands for the above figure are: 
 
*1     BRIDGE K1 
*2     PROFILE ABC 
*3     TIE 0 
*4     SE 60+00 LT -2 24 -3 RT -2 24 -3 
*5     SE 63+00 LT -2 36 -3 RT -2 36 -3 
*6     SE 65+00 LT 4 24 4 RT -4 24 -4 
*7     ALIG IN 
*8     GU -33 33 
*9     FC -34 34 
*10    PIER BK N 40 W AH N 40 W 
*11    SPAN A 61+00 62+00 8 P 
*12    BEAM OFF -32 -11.90 14.50 32 
*13    END SPAN 
*14    END 
 
The resulting output is: 
 
Bridge deck elevation 
Span K1-A  61+00.00 to 62+00.00 
LFC   11.4187  11.1029  11.3712  11.3712  11.3554  11.3396  11.3237  11.3079 
LGT   11.4490  11.4331  11.4015  11.4015  11.3856  11.3698  11.3540  11.3381 
BM 1  11.4792  11.4634  11.4475  11.4317  11.4159  11.4000  11.3842  11.3684 
BM 2  11.9250  11.9042  11.8834  11.8625  11.8417  11.8209  11.8000  11.7792 
BM 3  11.8811  11.8603  11.8394  11.8186  11.7978  11.7769  11.7561  11.7353 
BM 4  11.4941  11.4783  11.4625  11.4466  11.4308  11.4150  11.3991  11.3833 
RGT   11.4644  11.4485  11.4327  11.4169  11.4010  11.3852  11.3694  11.3535 
RFC   11.4346  11.4188  11.4029  11.3871  11.3713  11.3554  11.3396  11.3238 
PGL   12.1667  12.1458  12.1250  12.1042  12.0833  12.0625  12.0417  12.0208 

5.8 Additional Information 

Additional COGO commands and information can be found in the GEOPAK Manual. 

10/11/02 Missouri Department of Transportation 5-29 





GEOPAK Road for Bridge  Exercise 5-1 Route24 

11/20/02 Missouri Department of Transportation 5-1-1 

Exercise 5-1 

This is an individual exercise to practice using COGO.  All of the steps are given to you.  Make 
sure you understand each step, because later you will need to determine which tools are needed 
to store COGO elements 
 

1. Open the MicroStation file t:\br-proj\Exercise_Rte_24\Route_24.dgn. 
 

2. Go to Applications>>Geopak Road>>User Preferences and delete the working directory 
 

 
 

3. Open the Coordinate Geometry dialog.  
 
Create Job Number: 123 
 
Set the Operator Code to your initials. 
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Create the following alignment as shown on the following pages. 
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4. Store points 501 and 505 with the coordinates shown. 
 

  
 

5. Locate points 502 and 504. 
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6. Locate point 503 by using the Intersect tool. 
 

 
 

7.  Store CURVE1, CURVE2, and CURVE3. 
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7. (Continued) 

 
 

PT Curve1 to 503 m 100 
 

 
 

8. Store the alignment chain Route24. 
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9. Station the centerline at the beginning with station 10+12.6 
 

 
 

10. Describe the chain and save the output file.  Review the output file in UltraEdit. 

 

11. Use COGO Navigator to view the data. 

 

12. Exit Coordinate Geometry. 
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Exercise 5-2 This is an optional individual exercise. 

1. Open the Microstation file t:\br-proj\Exercise_B1\B1.dgn 
 

2. Open the Coordinate Geometry dialog.  
 

Create Job Number: 456 
 

Set the Operator Code to your initials. 
 

 
 

3. Use the Coordinate Geometry tools to create chain B1 as shown below.  Verify the area of 
the chain. 

 
Hints: 
 
Angles at 604 and 605 are not 90° 
 
Store point 604 and the curve before storing 

points 607 and 608 
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6.1 Objectives 

• Create and store coordinate geometry elements using the Graphical Coordinate Geometry 
tools. 

6.2 Definitions 

Graphical Coordinate Geometry is a set of tools that allows the user to store or modify 
coordinate geometry elements (points, lines, curves, spirals, chains, and parcels) by key-in or a 
mouse click.  The elements are stored directly into the coordinate geometry database (.gpk) while 
being created or modified graphically on the screen. 

6.3 Accessing 

The Graphical Coordinate Geometry tools can be accessed from the Horizontal and 
Vertical Geometry toolbox or by selecting Applications>>Geopak 

Road>>Geometry>>Graphical Coordinate Geometry.  If the user attempts to activate 
Graphical COGO without an active session of coordinate geometry, a warning dialog will appear 
advising the user that a coordinate geometry session must be started. 
 
When Graphical COGO is started, the following dialog appears.  
 
 
 
 

6.4 Dialog 

The Graphical COGO dialog contains four toolboxes.   
 
Store Elements 
 
 
 
Modify Elements 
 
 
 
Manipulate Elements 
 
 
 
Groups  
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When a tool in one of the toolboxes is selected, a dialog 
box will appear for the user to key-in any required 
information.  
 
 
 
 
 
 

6.5 Store Elements Tools 

The Store Elements toolbox is used to store points, lines, curves, and spirals.  The following 
tools are contained in the Store Elements toolbox. 
 

 Store Point – stores a point.  The user can store a point by either Cartesian coordinates 
(XYZ), or curvilinear coordinates (station and offset).  The XY and/or Z coordinates or the 
station, offset, and/or elevation can be locked or a data point can be used to place the point. 
 

 Store Equally Spaced Points – stores a given number of points spaced equally between 
two specified points. 
 

 Locate Point – stores a point by distance and direction.  The distance, direction, offset, 
and slope can be locked.  A line segment can also be stored. 
 

 Store Line – stores a line segment between two previously stored points. 
 

 Store Line by 2 Points – stores a line segment and its endpoints.  The distance and 
direction of the line segment can be specified. 
 

 Store Tangent Line – stores a line segment that is tangent to a curve.  The two endpoints 
of the line segment are also stored. 
 

 Store Curve by 3 Points – stores a circular curve by specifying the beginning and 
ending points, and a point on the curve. 
 

 Store Curve by Center – stores a curve by specifying the beginning point of the curve, 
the center of the curve, and the ending point of the curve. 
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 Store Tangent Curve Constrained – stores a curve tangent to the specified curve or 
line. 
 

 Store Tangent Curve Unconstrained – stores a curve through a specified point, and 
tangent to the specified line or curve. 
 

 Stores Tangent Spiral – stores a spiral tangent to specified line or curve. 

6.6 Modify Element Tools 

The Modify Elements toolbox is used to modify previously stored cogo elements.  The redefine 
toggle must be turned on to modify existing elements.  The following tools are contained in the 
Modify Elements toolbox. 
 

 Partial Delete – deletes part of an element creating two separate elements.  Additional 
points will be stored if needed. 
 

 Extend Plan View Element – extends or shortens any cogo element. 
 

 Trim Elements – trims or extends elements to intersect with another element. 
 

 Intersect Elements – stores a new point at the intersection of two elements.  The original 
elements are not modified. 
 

 Extend Element to Intersection – lengthen or shorten an element to another element.  
Works functionally the same as its Microstation counterpart. 
 

 Extend Elements to Intersection – lengthens or shortens two elements to intersect each 
other.  Works functionally the same as its Microstation counterpart. 
 

 Construct Circular Fillet – stores a circular curve between two elements.  Works 
functionally the same as its Microstation counterpart. 
 

 Construct Chamfer – stores a line and its endpoints between two elements.  Works 
functionally the same as its Microstation counterpart. 
 

 Cut Element – cuts an element into segments. 
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6.7 Manipulate Elements 

The Manipulate Elements tools allow the user to adjust previously created elements.  If an 
element is moved, the redefine toggle must be turned on.  The following tools are in the 
Manipulate Elements toolbox. 
 

 Move Plan View Element – moves or copies an element. 
 

 Rotate Plan View Element – rotates the element about a specified point. 
 

 Copy Parallel – moves or copies an element parallel to the original element. 
 

 Delete Element – deletes an element from a .gpk file.  Warning: There is no undo for 
this command. 

6.8 Groups 

The Groups tools allow the user to create a chain or parcel.  The following tools are contained in 
the Groups toolbox. 
 

 Store Chain – stores a chain from previously stored elements.  The user selects the first 
element, then data points to accept the each element.  When all elements are selected, the user is 
prompted to data point for the direction of the stationing. 
 

 Store Parcel – stores a parcel, takings, or easements from previously stored elements.  
The user can either automatically select the elements as with Store Chain, or manually select the 
elements.  When all of the elements are selected, the user is prompted for the direction of the 
parcel, and the point of beginning. 
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7.1 Objectives 

• Create and store horizontal chains using graphical tools. 

7.2 Definitions 

The Horizontal Alignment tools enable the user to create or modify horizontal geometry 
elements.  Spirals, curves, tapers, and ramps can all be placed according to user-defined 
parameters.   

7.3 Accessing 

The Horizontal Alignment tools can be accessed from the menu 
Applications>>Geopak Road>>Geometry>>Layout Alignments 
Horizontal, from the Horizontal Alignment icon, or from the Horizontal 
Alignment button on Project Manager.  
 
When the Horizontal Alignment tools are 
started for the first time, the dialog shown to the 
right will appear.  The user has the option to 
select the COGO Element Based (New), or the 
Graphic Element Based Horizontal Alignment 
tools.   
 
The COGO Element Based tools write the created elements directly into the coordinate 
geometry database (.gpk) as cogo elements.  For this option, a Geopak COGO session must be 
active. 
 
The Graphical Element Based option first creates Microstation graphical elements in the .dgn 
file.  The user then has to store these elements as a COGO element in the coordinate geometry 
database (.gpk).   
 
If the Don’t ask me anymore toggle is set, the user will not see this dialog when going into the 
Horizontal Alignment tools. 
 
** Note:  It is recommended to use the COGO Element Based Horizontal Alignment tools.  
The COGO Element Based Horizontal Alignment tools will allow the user to better achieve an 
efficient, accurate design.  Only the COGO Element Based Horizontal Alignment tools will be 
discussed in this class. 
 
When the COGO Element Based Horizontal Alignment tools are chosen, the following dialog 
will open.  
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7.4 Dialog 

The Horizontal Alignment Generator dialog has three menus, File, Design Tables, and Tools.   
 
The File menu opens the following dialog which allows the user to change various preferences 
such as element symbology, beginning element names, curve vehicle tables, curve definition and 
dynamic increments. 

 
Design Tables allows the user to set up Design Tables for Symmetrical 3 Centered Curves, 
Asymmetrical 3 Centered Curves, Taper Curves, and Spiral Curves.  Entry, middle, and exit 
radiuses can be set up for various vehicle types and deflection angles. 

 
The Tools menu allows access to the Main tool dialog, or to any of the tool boxes to store a 
Horizontal Alignment. 
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7.5 Lines/Curves Tools 

The Line/Curves tools allow the user to place line and curve elements by various methods.  The 
Line/Curves toolbox contains the following tools. 
 

 Store Line By 2 Points – stores a line and its endpoints. 
 

 Store Tangent Line – stores a line tangent to a curve and the endpoints of a line. 
 

 Store Curve By 3 Points – stores a circular curve by selecting the beginning and ending 
points of the curve, and a point on the curve. 
 

 Store Curve By Center – stores a circular curve by defining the center point, radius, and 
sweep angle. 
 

 Store Tangent Curve Unconstrained – places a curve tangent to a line or curve, and 
through a specified point. 
 

  Place Curve Between Two Elements – places a circular curve between two elements. 
 

 Place Simple Transition – draws a tangent, curve, or spiral between two arcs. 
 

7.6 Curve Combination Tools 

The Curve Combination Tools allows the user to place compound curves, three centered 
curves, reverse curves, and tapered curves. 
 

 Place Compound Curves – places a compound curve between two elements. 
 

 Place Three Centered Curves – stores a three-centered curve between two elements.  
Design vehicle parameters from File>>Preferences can be utilized. 
 

2/11/02 Missouri Department of Transportation 7-3 



Chapter 7 Horizontal Alignments 

 Place Reverse Curves – stores reverse curves between two elements.  A short tangent 
sect nio  between the curves can also be specified. 
 

 Place Taper Curves – places a curve and tapers between two elements.  The design 
veh le

7.7 Spiral Combinations 

The Spiral Combinations tools allo irals with curves, tangents, and other 
spirals. 

ic  parameters from File>>Preferences can be utilized. 

w the user to place sp

 

 Place ST Tangent To Curve - stores a spiral tangent combination tangent to a curve. 
 

 Place SC Tangent To Line – stores a spiral curve combination tangent to a specified 
line. 
 

e The spiral will be placed between the curves. 
 

 Place SCS (Intersecting Elements) – stores a spiral curve combination tangent to a line. 
 

Place SC Tangent To Curve – stores a compound spiral curve combination tangent to a 
curv .  
 

 

 Place SCS (Disjoint Curves) – stores a spiral curve spiral combination between two 
curves. 

Place STS (Disjoint Curves) – stores a spiral tangent spiral combination between two 
curves. 
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7.8 Complex Transitions 

The Complex Transitions tools allow the user to place complex ramp designs. 
 

 Place Complex Ramp – places simple to complex ramp geometry. 
 

 Place Ramp Connector – places simple to complex ramp connector. 
 

7.9 Alignment Tools 

The Alignment Tools allows the user to either store an alignment from existing COGO elements 
or to dynamically place an alignment. 
 

g he alignment. 
 

 Store Chain – stores an alignment by selecting graphical elements.  This tool works 
imilar to the Microsta

 Place Dynamic Element – places an alignment dynamically.  The user needs to select a 
tarting element and then specify the les

a
ngth of curves and length of tangents to create the 

lignment.  The degree of curvature can be changed, and spirals can be added as the user moves 
alon  t

s tion Automatic Create Complex Chain tool. 
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7.10 Manipulate Tools 

The Manipulate tools allow the user to move/copy, rotate, extend, and delete elements. 
 

 Move Plan View Element - moves or copies an element. 
 

 Rotate Plan View Element - rotates the element about a specified point. 
 

 Extend Plan View Element – extends or shortens any cogo element. 
 

 Delete Element – deletes an element from the coordinate geometry database (.gpk). 
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Exercise 7-1 

This is an individual exercise to practice storing a horizontal alignment.  It is to be done outside 
of a GEOPAK project. 
 

1. Open the MicroStation file t:\br-proj\Exercise_7-1\Route_50.dgn. 

 

2. Use Coordinate Geometry, Graphical COGO, or Horizontal Alignment Generator to 
create the alignments as shown on the following pages. 

 
  Do not worry about the graphics (stationing, curve data, etc.) being plotted.  These items will 

be discussed in later chapters. 

 
3. Upon completion of storing the alignments in coordinate geometry, close coordinate 

geometry, graphical cogo, and Horizontal Alignment Generator.  
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Route50 
 
Beginning Point: X = 1698102.3440 Y = 999551.4260 

 
Ending Point:  X = 1702419.9216 Y = 1000116.5660 

 
 Intersect the PI point using the direction back and direction ahead of curve. 
 
 Direction Back of Curve = S 82° 41’ 55” E 
 
 Degree of Curve = 2° 00’ 00” 
 
 Direction Ahead of Curve = N 49° 10’ 00” E 
 
 Station the chain beginning at 445+30.94 
 
 Name the alignment Route50. 
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Route 50 
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Big Horn 
 
 Beginning Point: X = 1700104.5480 
    Y = 1000188.1340 

 
Ending Point:  X = 1700092.3040 
   Y = 998143.9168 

 
PI of the first curve is exactly 248.8954’ from the beginning point on a bearing of  

S 1° 04’ 27.8” W 
 
 Direction Back of first curve = S 1° 04’ 27.8” W  
 
 Degree of Curve for first curve = 5° 00’ 00” 
 
 Direction Ahead of first curve = S 6° 32’ 27.3” E 
 

The direction back of second curve matches the direction ahead of the first curve, 
which is S 6° 32’ 27.3” E  

 
Degree of Curve for second curve = 5° 00’ 00” 
 
Direction Ahead of second curve = S 6° 42’ 48.6” W 
 
Intersect the alignment chain Route50 with a line segment between the PT of the first 

curve, and the PC of the second curve.  Note: The Route 50 station value shown is 
approximate. 

 
Store the alignment as BigHorn (be sure to include the Route50 intersection point) 
 
Station the alignment with station 10+00 at the intersection point with the Route50 chain. 
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Big Horn 
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Ramp 1 
 
 Beginning Point is at station 452+56.52; offset 66’ LT of Route 50 
 
 The PC of the curve is the Beginning Point 
 
 Direction Back of the curve is S 82° 41’ 55” E 
 
 Degree of Curvature = 4° 00’ 00” 
 
 Direction Ahead of the curve is N 83° 27’ 28.56” E 
 
 Alignment ends at Big Horn, at about Station 6+55.32 
 
 Station the alignment beginning at 0+00 
 
 Name the alignment Ramp1 
 
Ramp 3 
 
 Beginning Point is at station 479+48.31; offset 66’ LT of Route 50 
 

Ending Point is at end of Ramp1; however, use different point numbers for the ending 
point of each ramp.  Hint: Element > Point> Equate. 

 
 PC of the first curve is the alignment beginning point. 
 
 Direction Back for the first curve is S 67° 41’ 47.7” W 
 
 Degree of Curvature for first curve = 6° 00’ 00” 
 
 Direction Ahead for the first curve is N 69° 50’ 21.3” W 
 

Point Back of the second curve is the PI of the first curve 
 

PI of second curve is at the intersection of a line through the PI of the first curve 
with a bearing of N 69° 50’ 21.3” W and a line through ending point of Ramp1 
with a bearing of N 83° 27’ 28.56” E.  Hint: Do not use the same point number as 
the ending point for both ramps. 

 
 Degree of Curvature for the second curve = 8° 45’ 00” 
 
 Point Ahead of the second curve is the alignment end point 
 
 Station the alignment beginning at station 0+00 
 
 Name the alignment Ramp3 
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 Ramp 1 & 3 
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Exercise 7-2 

This is an individual exercise to practice storing a horizontal alignment outside of a GEOPAK 
project. 
 

1. Open the MicroStation file t:\br-proj\Exercise_7-2\Route_6.dgn. 

 

2. Use Coordinate Geometry, Graphical COGO, or Horizontal Alignment Generator to 
create the alignment on the following page. 
 
Do not worry about the graphics (stationing, curve data, etc.) being plotted.  These items will 
be discussed in later chapters. 

 
3. Upon completion of storing the alignments in coordinate geometry, close coordinate 

geometry, graphical cogo, and Horizontal Alignment Generator. 
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Rte 6 
 
Hints: 

 
Beginning Point is at 
station 1268+90.8814 
with coordinates of 
X=45,417.1720 & 
Y=90,893.1483. 
 
The PI of the curve is 
located 984.25’ from 
the beginning point 
along a bearing of  
N 80° 36’ 26” E. 
 
Curve RTE6-1 has a 
decree of curvature of 
1° 30’ 00.0” and a 
deflection to the right 
of 25° 27’ 00.0”. 
 
The end point is 
located 3290.7634’ 
from the PT of the 
curve along a bearing 
of S 73° 56’ 34” E, 
which is the ahead 
bearing for the curve. 
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1. In the following alignment description, find 3 reasons why this is a poor alignment. 

 
Beginning chain CLASS description        
==============================================================================                                 
Point 1006     N        999,316.7962  E      1,698,550.3961  Sta      10+00.00                     
                                                               
Course from 1006 to PC CLASS-1  N 70^ 06' 55.04" E        Dist 380.0001          
                                                                          
                                   Curve Data                                    
                                  *----------*                                   
Curve CLASS-1                                                                    
P.I.  Station            22+36.99  N        999,729.7630  E      1,699,716.4028  
Delta       =      48^ 20' 00.00" (RT)                                           
Degree      =       3^ 00' 00.00"                                                
Tangent     =            856.9896                                                
Length      =          1,611.1111                                                
Radius      =          1,909.8593                                                
External    =            183.4619                                                
Long Chord  =          1,563.7635                                                
Mid. Ord.   =            167.3830                                                
P.C.  Station            13+80.00  N        999,446.0451  E      1,698,907.7401  
P.T.  Station            29+91.11  N        999,314.2862  E      1,700,465.9429  
C.C.                               N        997,643.8856  E      1,699,540.0247  
Back        = N  70^ 40' 00.00" E                                                
Ahead       = S  61^ 00' 00.00" E                                                
Chord Bear  = S  85^ 10' 00.00" E                                                
                                                                                 
Course from PT CLASS-1 to PC CLASS-2  N 61^ 00' 00.00" W        Dist 27.8502     
                                                                                 
                                   Curve Data                                    
                                  *----------*                                   
Curve CLASS-2                                                                    
P.I.  Station            36+19.82  N        999,036.4852  E      1,700,967.1091  
Delta       =      66^ 10' 00.00" (LT)                                           
Degree      =       6^ 12' 44.06"                                                
Tangent     =            600.8607                                                
Length      =          1,065.1017                                                
Radius      =            922.3047                                                
External    =            178.4584                                                
Long Chord  =          1,006.8953                                                
Mid. Ord.   =            149.5263                                                
P.C.  Station            30+18.96  N        999,327.7882  E      1,700,441.5845  
P.T.  Station            40+84.06  N        999,399.4866  E      1,701,445.9238  
C.C.                               N      1,000,134.4541  E      1,700,888.7267  
Back        = S  61^ 00' 00.00" E                                                
Ahead       = N  52^ 50' 00.00" E                                                
Chord Bear  = N  85^ 55' 00.00" E                                                
                                                                                 
Course from PT CLASS-2 to 1007  N 52^ 50' 00.00" E        Dist 629.1392          
                                                                                 
Point 1007     N        999,779.5720  E      1,701,947.2733  Sta      47+13.20   
                                                                                 
==============================================================================   
Ending chain CLASS description 
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2. Coordinate Elements can have up to ____ characters in the name. 

a. 6 

b. 7 

c. 9 

d. 10 

 

3. DB stands for Distance Back 

a. True 

b. False 
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8.1 Objectives 

• Understand the use of the D&C Manager in creating construction plans 
• Understand the format of the hierarchical database and how to use it 
• Be able to use the D&C Manager in conjunction with Microstation to store roadway 

features and calculate their quantities 

8.2 Definitions 

The Design and Computation Manager (D&C Manager) is a tool that allows MoDOT to 
standardize graphics elements for drafting and pay item quantities. 

8.3 Database 

A hierarchical database is used with the Design and Computation Manager.  For MoDOT the 
default database is either MoDOT_English.ddb or MoDOT_Metric.ddb.  The database stores 
information concerning functional classification and display preferences for each feature and 
item used in a Microstation file. 
 
Categories are used to group and classify the features and items used in creating construction 
drawings.  The content the MoDOT databases are divided into three overall categories – Pay 
Items/, Drafting Standards/, and Design Standards/.  These three categories each contain sub-
categories.  The sub-categories break down each classification into more specific sections.  (See 
dialog box next page). 
 
For example, Pay Items/ is broken into several additional categories like Pipes/ and Lighting 
and Signals/.  Pipes/ is broken into many different categories representing various types of pipes 
and pipe features that may be used in the design of your project like Flared End Sections/.  
Within the category Flared End Sections/ the different pay items for flared end sections are 
listed. 
 
CADD Support personnel maintain this database.  You will find commands within the D&C 
menu that require a password before execution.  This is a security measure to protect the 
integrity of the database file and ensure its consistent application on a statewide basis. 
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8.4 Accessing 

Design and Computation Manager can be accessed from Project Manager >> Plan View 
Quantities or from the Design and Computation Manager icon. 
 
The following dialogs will appear. 

The D&C Manager dialog box is composed of three distinct areas: 
 
1) The D&C Manager may be configured to operate in seven different modes. A single click 

on an icon will change operational modes.  They are: Display Design Set Compute 
Shape Pavement Preferences 

 
 
 
 

Display  Design  Set  Compute  Shape  Pavement  Preferences 

1

2

3
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2) The Content box lists the sub-categories or items available at your current position 

within the database structure. 
 

3) The Operations box will appear differently depending on the set mode of operation. 
 
The D&C Manager dialog box can be used in two different modes.  The dialog mode as shown 
on the previous page, allows the user to access items in from a “directory tree” structure.  The 
icons at the top of the dialog allow the user to access the different operational modes of D&C 
Manager. 
 
The toolbox mode as shown below, allows the D&C Manager dialog to be docked on the 
Microstation toolbars.  With this format, the user accesses items from the pull-down menus, and 
can toggle the various tools from the tool bar.  

 
 Categories Items  Up Level      Find      Dislpay Options  Set    Key-in’s 
Place Influence    Down Level    Identify             Dialog Toggle 
 
The dialog box can be toggled using the appropriate icons.   
 
 
 
  Switch to toolbox mode    Switch to dialog mode 
 

8.4.1 File Commands 
For a MoDOT Geopak user, the only file command options needed are Open 
and Exit. 
 
MoDOT_English.ddb or MoDOT_Metric.ddb will be used for all MoDOT 
projects.  This file is password protected, so the users will not be able to make 
changes to it. 
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8.4.2 Edit Commands 
Find - will search the database (from your current location) for an item 

or category.  The display in the D&C Manager dialog box will 
change to each item/category as it is found. 

 
Identify – will show the item name and description attached to an 

element in the design file. 
 

 
 
 
 
 
 

8.4.3 User Commands 
Display Settings - temporarily changes the display of elements on the 
screen to one common color, then the user may specify additional 
elements to be viewed in their original colors.  This tool enhances 
visualization when working on a complex project. 

 
Design Settings - sets the maximum gap tolerance and 
deduction tolerance used in computations and the drawing 
scale for placing cells.  Do not use the Custom Line Style 
Creation option.  The Project in the Microstation Manager 
handles the line style scaling in the MoDOT Microstation 
configuration.  This dialog also sets the cell scale to adjust 
the cell size appropriate to the drawing scale. 

8.4.4 Recall Commands 
 
Add to Favorites - saves current D&C Manager 
path for easy recall in the future. 
 
Organize Favorites – allows the user to edit and 
save the Favorites list. 

8-4 Missouri Department of Transportation 9/16/02 



GEOPAK Road Chapter 8 Design and Computation Manager 
8.5 Operational Modes 

8.5.1 Design 
The Design mode allows the user to tag 
each roadway element as it is placed in 
the design file based on item parameters 
and/or write COGO elements to the file.  
 
 Place Influence will set the level, symbology and attribute tags of elements drawn or copied 
using Microstation commands.  When Place Influence is On, elements are drawn using the 
level, symbology and attributes as defined in the Geopak database file.  When Place Influence is 
Off, elements are drawn using the active level, symbology and attributes of Microstation. 
 
The Draw Cogo Element button is for drawing Cogo elements to a design file.  A single click to 
this button prompts the user for a job number then opens a dialog box that allows the user to 
choose a COGO item to draw. 
 

If a drafting item is 
chosen, the Draw Cogo 

Element button changes to Draw Plan and 
Profile.  A single click to this button prompts 
the user for a job number, and then opens the 
Geopak Plan and Profile Draw box shown 
to the right. 
 
There are nine possible COGO elements that 
may be recalled from the .gpk file: points, 
lines, curves, spirals, chains, stationing, 
parcels, profiles, and parallel chain.  Each of 
these options changes the dialog box to offer 
relevant draw and label features used when 
placing an element in a graphics file.  When 
using Plan and Profile Draw, be sure to turn 
off Place Influence. 
 
The points and lines dialog boxes have a key-
in field that allows the user to specify the 
names of the COGO elements to be drawn.  
To use the line operation, the user must use 
point numbers to specify the ends of the line.  
The points/lines are drawn immediately after 
you enter their respective names and press the 
enter key.  To draw more than one point or line, place a dash in-between the point numbers.  To 
draw a line without using consecutive point numbers, use a forward slash.   
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The dialog boxes for curves, spirals, chains, stationing, parcels, and profiles have a list box that 
display the names of all stored curves and chains.  Highlighting one of the available elements 
causes it to be drawn into the file.  Each type of item has a list of options that can be plotted. 
 
**Note that Geopak can draw elements to levels not turned on.  After elements are drawn, it may 
be necessary to turn on appropriate levels and fit screen. 
 
**Remember that Place Influence is for drawing Microstation elements.  Draw Plan & Profile 
is for drawing Cogo elements.  Do Not have Place Influence on when using Draw Plan & 
Profile. 

8.5.2 Display  
Display mode is 
used to enhance on screen 
visualization.  
 
The pay item to be visualized 
is added to the Collection 
box.  Three display options 
are available for the display 
of the items in the Collection 
box.  
 
Highlight - will change those 
items stored in the collection 
area to the Microstation 
highlight color. 
 
Not - simply turns off the display of the collection 
items leaving everything else on. 
 
Only - will turn off everything but the collection 
items. 

Normal  Highlight  Not  Only 

Collection Box 

8.5.3 Set  
The Set mode allows you to assign attributes 
from the D&C Manager database to existing 
graphical elements in the file.  The Complex 
Chain option automatically creates a chain from 
graphic elements and applies the attributes of the highlighted item in the content box. 
With the Complex Chain option is off, the Set mode is the same as Microstation Element Select.  
The user may tag several elements by depressing the Ctrl key while data pointing each element.  
This allows you to affect multiple elements with one Set command.  ID Element is used to 
specify the complex chain to be changed.  Set activates the command and changes the element 
attribute. 
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8.5.4 Compute  
The Compute m
provides quantity 
calculations from graphic 
elements placed using the 
D&C Manager.  Desired 
items for inclusion in the 
computation are added to 
the collection box at the 
bottom of the main D&C 
dialog as shown to the 
right. 

ode 

 
Chosen items within 
either the View or a 
Fence are calculated, 
which is set in the 
upper right hand corner 
of the dialog.  The 
other fields in the top 
row are discussed later. 
 
There are six Output options: 
 
Comp Book - calculates station/offset and coordinates for items defined in the Collection box 
within a Range left and right of a selected Chain in the specified Job as set by the first three 
fields in the top row of the dialog.  The  icon can be used to select the job.  The output file is 
ASCII format. 
 
Item Report – a total quantity for each item is calculated.  For this option, the job, chain, and 
range fields are inactive.  The output file is ASCII format. 
 
Item Tables – contains the same information as an Item Report.  It produces an ASCII formatted 
quantity table to be included in a drawing file or imported into the estimate program. 
 
SDF Item Report – is similar to Item Report, except that the output file is in SDF (standard 
database format) or CSV (comma separated value) format. 
 
SDF Comp Book – produces a more detailed report that lists not only quantity summaries, but 
also geometric properties such as plan view coordinates and station/offsets for located elements.  
Format is in SDF or CSV format. 
 
DBMS – provides very detailed information including calculated and rounded quantities, 
geometric properties, pay item numbers, descriptions, station / offset values, etc. The format is 
the selected database (i.e., Microsoft Access, Oracle, SQL Server, and dbase. 
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To the right of the Output field is the Preview/File option.  If preview is chosen, a file is not 
created and the output is displayed in a GEOPAK window.  If set to File, GEOPAK creates the 
file whose file format is based on the Output type and whose name is defined in the key-in field 
to the right of the File option.  The name can be manually entered or selected via the Files 
(folder) icon.  The user can either Create a new file or Append the output to an existing file by 
using the option button at the end of the second row.  If desired, a full path may be specified, 
otherwise, the report will be found in the current directory.  The  icon can be used to select an 
existing file. 
 
Any information keyed into the Description: field will be printed at the top of the report.  There 
is a maximum of 48 characters supported for this field. 
 
The four display options described in section 8.5.2 can be utilized using the 
buttons shown to the right. 
 
The Highlight in Computation toggle will highlight all MicroStation elements utilized in the 
computations if activated. 
 
Compute commences the computation process. 

8.5.5 Shape 
Shape mode provides tools for creating 
shapes to be used for area calculations such 
as pavement. 
 
Three options are available for choosing the 
elements to create the shape. 
 
Semi-auto – allows the user to trace around the elements to create the shape.  The user picks an 
element, and then GEOPAK finds an intersection on that element.  The user clicks the data point 
button to accept the intersection, or reset to choose another intersection.  GEOPAK will then find 
the next intersection, which the user can accept or choose another.  This is repeated until the 
beginning of the shape is reached. 
 
Automatic – creates the smallest shape possible.  The user selects a data point inside the shape 
they are trying to create.  GEOPAK then moves up until it intersects an element, then traces 
around intersecting elements to create the shape. 
 
Exclusive – works the same as the Automatic mode, but allows the user to select elements that 
will create a whole in the shape. 
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8.5.6 Pavement 
The Pavement mode allows the user to place pavement m
including striping, and symbols.  

arking 

 

 Striping – allows the user to place single or double, solid or skip pavement stripes. 
 

 Separation – allows the user to place traffic separation pavement marking. 
 

 Chevron Diverge – allows the user to place pavement chevrons in areas of diverging 
traffic. 

 

 Chevron Merge – allows the user to place pavement chevrons in areas of merging 
traffic. 

 

 Symbols – allows the user to place pavement marking symbols with a specified pattern. 
 
These are discussed further in the following pages. 
 

SINGLE STRIPING 
This box offers predefined configurations for single stripe 
and double stripe options so the user can easily control the 
type of striping being placed. 
 
The pay item box will reflect the currently selected pay 
item in the D&C Manager dialog box; the user may 
change this at any time during the process. 
 
Next, define the start option by selecting Solid or Skip (or 
a combination thereof).  If Skip is active, the user must 
define the stripe and skip lengths.  If an ending stripe is 
shorter than the Tolerance value, it will not be drawn.  
 
A beginning and ending point for the limits of striping are 
entered from digitized points on the screen. 
 
The lower portion of the dialog box provides tools for 
identifying the reference element on which the striping 
will be based. 
 
After clicking Apply, the user must enter a data point on 
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either side of the reference element to begin striping.  
Striping is placed at the indicated offset value; the data 
point controls whether striping is offset left or right.  
Striping is placed as a graphic group. 

DOUBLE STRIPING 
 
The process for Double Striping is the same as Single, 
except for having two pay item placement options, Inside 
and Outside.  The user must select either the Inside or 
Outside button for the highlighted (D&C Manager) pay 
item to be displayed in the dialog box.  Separate quantities 
are calculated for each stripe.  
 
The remaining process is the same as described above. 

SEPARATION 
This option draws 
pavement markings 
between two sets of 
selected elements.  
Elements may be either GEOPAK or Microstation 
generated.  
 
Once a pay item has been selected, the user may set the 
Distance Between Stripes and the Slash Stripe Angle.  
Tolerance functions the same as for striping. 
 
A Begin DP and End DP should be issued before the 
Reference DP is identified.  The Reference DP must fall 
between the Begin DP and End DP.  It marks the location 
of the first pavement marking and determines the direction 
of the slashed stripe.  All other markings will be based on 
the first stripe. 
 
Tools for defining the limits of the pavement markings are 
located at the bottom of the Separation dialog box.  ID 
Intersection identifies the elements where the striping 

will terminate.  ID Location is the set of elements from which the striping begins. 
 
After the Apply button is selected, the user must issue a data point in the graphics file for the 
pavement markings to be displayed.  
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CHEVRON DIVERGE  
Once the pay item and its relative parameters have been 
defined, there are three points needed to define the 
chevron: Gore, Breaking Line and Point. 
 
The Gore point defines the wide end of the gore. 
 
The Breaking Line point must fall between the two sides 
of the gore and sets the location of the point at which the 
chevron diverts in a different direction. 
 
The Point represents the narrow end of the gore where 
chevrons are to stop. 
 
Use the two ID buttons to identify the sides of the gore. 
 
Once the Apply button is selected, the chevrons are 
displayed. 

CHEVRONS MERGE 
This process works similar to Chevron Diverge except the 
two points, Gore and Breaking Line, have been combined 
into one point that serves both functions.  
 
The Gore and Break DP should be located near the wide 
end of the chevron.  It simultaneously sets the beginning 
of the pavement markings and the point at which the 
chevron will break. 
 
The remainder of the process is as described above. 
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SYMBOLS 
Cell Group Info defines the cells to be 
placed. 
 
Layout allows the user to repeat the 
cells, and to set the locations of where 
the cells are placed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.6 DP Station/Offset 

The DP Station/Offset command works in conjunction 
with Microstation commands and the D&C Manager.  

It can be used as the data point for any Microstation 
command.  DP Station/Offset provides precision placement 
of elements based on a station and offset of a stored chain.  
Uses for this command include precision placement of 
elements and window functions. 

8.7 Draw Transition 

Draw Transition will draw a line/curve 
based on a beginning station/offset and an 

ending station/offset relative to a selected chain.  
Use of this command includes turn lanes, mail box 
widening and lane transitions.  
Note: Elements placed with Draw Transition will 
have Microstation element type curve when the 
beginning and ending offsets are different and will 
have Microstation element type line and/or arc 
when the beginning and ending offsets are the same. 
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Exercise 8-1 
This is a combination group / individual exercise to introduce and practice using three GEOPAK 
plan view design tools: Design and Computation (D&C) Manager, DP Station/Offset, and Draw 
Transition.  The first part of the exercise will be done together to introduce the tools.  The last 
part is to be done individually to practice using the tools. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\plan_j5p0100.dgn. 

 

2. In order to show all of the ways to access the plan view design tools, the instructor will open 
a GEOPAK project.  It is recommended that the students do not open the project. 

 

3. Open the Design and Computation Manager dialog.  To access the tool, go to  
the MicroStation menu path:  
 

 Application > GEOPAK Road Design & Computation Manager  
 

or click on the raised icon shown in the figure to the right. 
 

Select the item:  
 

 Drafting Standards/Plan/Alignments/MoDOT Proposed Baseline 
 

 
 

Select the Draw Plan & Profile button. 
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4. If you open D&C Manager outside of a project, you will get  
the first dialog shown to the right to indicate which GPK  
file is to be used.  (If you are inside of a project, GEOPAK  
already knows which GPK file to use.)  Click on Select to  
bring up the next dialog shown on the right side of the page.   
Pick job100.gpk in this dialog and click OK.  (If you do  
not see job100.gpk listed, ask an instructor for help.)  Click OK in the  
first dialog to continue to the third dialog depicted in the bottom figure  
on the right side of the page. 

 
Select the Chain Operation in the Plan & Profile Draw dialog. 
 
Set the Labeling Scale to 50 
 
Have the following options turned on:  
 

 Line Direction 
 Curve Label 
 Curve Data 
 Spiral Label 
 Spiral Data 
 
After all of the settings are checked, an  
item can be plotted by clicking once on its  
name. 
 
Select the Chain Route50 
 
Do a MicroStation fit view to 
see the plotted chain. 
 
Select the Chain Ramp1 
 
Select the Chain Ramp3 
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5. Select the Stationing Operation. 
 

Be sure the Labeling Scale is set to 50. 
 
Have the following options turned on: 
 

 Tick Marks 
 Tick Mark Stations 
 PC & PT & CS … Labels 
 PI Labels 

 
Set the following options: 
 
 Small Ticks:  
  Ticks LT, Labels LT 
 Large Ticks: 
  Ticks Both, Labels LT 
 Control Point Labels: 
  As Per Preferences 
 
Select the chain Route50. 
 
Select the chain Ramp1. 
 
Select the chain Ramp3. 

 
Close the Plan & Profile Draw dialog. 

 

6. Open the Draw Transition tool by selecting the raised icon shown to the right;  
it is the third tool in the tool palette.  This tool, shown below, can be used to  
draw linear elements relative to a chain by specifying the job number, chain, a  
beginning station & offset, and an ending station & offset. 
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7. Use Draw Transition to create the edges of pavement by switching to D & C Manager  
category: Design Standards/Roadway/ and item: EOP New – Edge of Pavement (New). 

 

 
 

Be sure that Place Influence is  
checked to have the MicroStation  
symbology match the pay item.   

   
Using the following information to draw the edges of pavement: 
 
  Beginning Ending 

  Chain   Station Offset Station Offset 
  Route50 Start of chain -56 446+06.52 -56 

446+06.52 -56 449+06.52 -66 
449+06.52 -66 452+56.52 -66 
454+26.54 -56 474+48.41 -56 
474+48.41 -58 476+88.41 -66 
479+48.31 -66 482+98.31 -66 
482+98.31 -66 485+98.31 -56 
485+98.31 -56 End of chain -56 
 

  Route50 Start of chain -28 End of chain -28 
 

  Route50 Start of chain 28 End of chain 28 
 

  Route50 Start of chain 56 End of chain 56 
 

  Ramp1 1+68.30 18 12+10.00 18 
 

 Ramp3 2+51.07 -20 3+11.07 -18 
3+11.07 -18 12+58.00 -18 
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8. On your own, use Draw Transition to create the edges of shoulder for the alignment with 
the following parameters. 

   
Use D & C Manager category: Design Standards/Roadway/ and item EOS New Conc. 
Edge of Shoulder - Concrete (New). 

 

 
 

Be sure that Place Influence is checked. 
   

 Beginning Ending 
  Chain   Station Offset Station Offset 
  Route50 Start of chain -64 446+06.52 -64 

446+06.52 -64 449+06.52 -74 
449+06.52 -74 453+32.03 -74 
455+08.53 -64 474+48.41 -64 
474+48.41 -64 476+47.92 -70.62 
478+70.54 -74 482+98.31 -74 
482+98.31 -74 485+98.31 -64 
485+98.31 -64 End of chain -64 
 

  Route50 Start of chain -24 End of chain -24 
 

  Route50 Start of chain 24 End of chain 24 
 

  Route50 Start of chain 64 End of chain 64 
 

 Ramp1 0+75.86 -6 12+10.00 -6 
 

 Ramp1 2+49.46 22 12+10.00 22 
 

 Ramp3 2+89.88 -22.71 3+11.07 -22 
3+11.07 -22 12+58.00 -22 
 

 Ramp3 0+76.31 6 12+58.00 6 
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Exercise 8-2 

This is a group exercise to introduce additional aspects of thee GEOPAK plan view design tools. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\plan_bh_j5p0100.dgn.  
Window in on the area where the ramps intersect Big Horn Drive. 

 

2. DP Station/Offset and Design and Computation Manager will be used to plot  
some drop inlets and a culvert to demonstrate the use of this tool combination.   
Open DP Station/Offset by selecting the raised icon shown to the right.  It is the  
second icon in that tool palette. 

 
To place the correct item, open D&C Manager category:  
 Payitems/Drainage/Drop Inlets And Manholes. 
 
Double click on the item:  731-10.32 Precast Concrete Drop Inlet 3 ft x 2ft.  This will 
activate the MicroStation Place Active Cell tool. 

 

 
 

Be sure that Place Influence is checked or else the correct cell will not be placed. 
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3. Place the cell using DP Station/Offset at the following locations: 
   
  Chain   Station Offset Orientation Auto Angle 
  BIGHORN 7+00 -20.5 Radial Checked 

7+12 20.5 Radial Checked 
   

The dialogs for placing the cells are shown below.  After entering the correct information 
into the dialog, click on DP to place the cell.  (Note: Before pressing DP, make sure that 
Place Cell is still the active MicroStation tool since DP Station/Offset will work with and 
MicroStation or GEOPAK tool that requires as data point.) 

 

   
 

The instructor will demonstrate the other orientation options. 

 

4. Use DP Station/Offset or Draw Transition to draw the culvert between the two drop using 
the following beginning and ending stations and offsets. 

   
 Beginning Ending 

  Chain   Station Offset Station Offset 
BIGHORN 7+00 -19 7+12 19 

   
Use D & C Manager category: Pay Items/Pipes/RCP/  
and item 726-13.24 24 in. Class III Reinforced Concrete Pipe Culvert. 

 
Be sure that Place Influence is checked to have the MicroStation symbology match the pay 
item.  (Note: If you use DP Station/Offset, make sure that Place Line is still the active 
MicroStation tool.) 
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5. After placing the culvert, switch the D & C Manager Mode to Compute by clicking on the 
shaded icon shown below.  A new section, called the Collection Box, is added to the main 
D&C Manager dialog.  This mode can be used to compute quantities for items placed using 
D&C Manager. 

 

  
 

Add the items shown above to the collection box by navigating to the pay item and either 
double clicking on the item or clicking on the Add to Collection icon shown below.   
 
The id icon in D&C can be used to aid in navigating to the items in the Payitems list.  This is 
done by clicking on the icon and then data pointing on the plotted item in the MicroStation 
file.  The instructor will demonstrate the use of this option. 

 

 
 

After adding the items to the collection box, zoom out in the MicroStation window until all 
of BIGHORN chain is visible.  This needs to be done in order to compute all of the curb and 
gutter. 
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6. When D&C Manager is in Compute Mode, the Operations Box switches to the form shown 
below. 

 

 
 

Set up the dialog as shown above and click compute.  The results of the computation will be 
displayed in an output window.  If you want a want a permanent record of the output, switch 
the Preview option shown above to File as shown below and type in the name of the output 
file you wish to use. 

 

 
 

To see the other types of computation reports that D&C can generate, switch the Output to 
Item Report and Item Table and generate a report using these options. 
 
The icons in the lower left hand corner of the above dialog can be used to control the display 
options for the items in the Collection Box.  They are the same icons used in D&C’s Display 
Mode.  See the manual for an explanation of these options. 
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9.1 Objectives 

• Learn how to label information with Plan View, Profile View, and Cross-Section 
Labeler 

9.2 Definitions 

The GEOPAK Labeler is a tool that allows the user to construct labels using text inserts, 
computed inserts, and key-in text.  The Labeler is available for plan view, profile view, cross-
section view, and drainage elements. 

9.3 Accessing 

Plan View Labeler can be accessed from the Plan View Labeling icon.  
 

Profile View Labeler can be accessed from the Profile View Labeling icon.  
 

Cross Section Labeler can be accessed from the Cross Section Labeling icon.  

9.4 Dialog 

GEOPAK’s labeling tools allow a user to place “smart” labels in a Microstation drawing.  These 
labels have the ability to calculate XYZ coordinates, station, offset, direction, length, radius, 
degree of curvature, etc. of the element the label is attached to. 

 
When the Plan View Labeling icon is selected, the above dialog appears.  The label to be placed 
will be displayed in the box on the right side of the dialog.  The Space button will put a space in 
the label at the cursor position.  The Return button will start a new line of text.  The Clear 
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button will start a new label.  The Delimit button will place a line above or below a line of text.  
The Place Label button will place the label on the cursor to be placed in the drawing.   
 
The user can select the various tabs to modify the label appearance. 

9.4.1 Text 

The Text screen allows the user to add computed text inserts, or user text inserts.  For data to be 
computed, the job number and the chain need to be selected.  If elevations are to be calculated, a 
.tin file needs to be chosen.   
 
The Computed Inserts are items that Geopak has the ability to calculate for the chosen item.  
The list of Computed Inserts changes with the type of element that is chosen.  If a line is 
chosen, the list of Computed Inserts will show inserts of bearing, and length.  If a curve is 
chosen the list of Computed Inserts will change to show inserts of radius, curvature, chord 
length, etc. 
 
The user can select different elements by using the icons in the Label Feature section. 

 Allows the user to select a graphical element such as a point, line, or curve. 
 

 Allows the user to data point a location on the screen. 
 

 Allows the user to choose two visualized COGO points to represent a line. 
 

 Allows the user to select the PC, PT, and either the center of curve or a point on curve 
using visualized COGO points. 
 
The User Inserts are inserts that a user may use on a regular basis.  This list can be customized 
for a specific user’s needs. 
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9.4.2 Parameters 

The Parameters tab allows the user set up the text size and symbology for the label. 
 

 Will set the symbology to the current Microstation settings. 
 

 Allows the user to set the symbology by choosing a Microstation element. 
 

 Will set the symbology using D&C Manager symbology 
 

 Will set the symbology for all elements in the label (text, delimiters, leader lines, etc.). 
 

9.4.3 Shape 

The Shape tab allows the user to place a shape around the label and set the symbology for the 
shape.  The user can select the shape to be placed around the text.  The Shape Offset is used to 
determine the distance between the shape and the text.  The symbology icons are the same as 
those described under the Parameters tab. 
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9.4.4 Leader 

The Leader tab allows the user to attach a leader from the label to the point.  Different leader 
types and terminators can be chosen.  The active terminator can also be used.  The symbology 
icons are the same as those described under the Parameters tab. 

9.4.5 Rotate 

The Rotate tab allows the label to be rotated.   The rotation can be determined from the current 
angle, the angle of the element, or the alignment angle.  Two data points or the active angle can 
also set the rotation. 
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9.4.6 Styles 

The Styles tab allows a user to choose label symbology from a library of pre-defined styles.  
When the user chooses the style, all of the symbologies, leaders, shapes, etc. is set up for the 
user. 

9.5 Menus 

The Style Files menu allows the user to open a new style 
library.  
 
 
 
 
 
 
 
In the Options menu, Minimize Dialog will minimize the dialog 
box when Place Label is chosen.  
 
The Use Reference File Coordinates option will use the 
coordinates from the attached reference file when placing a label 
in a plan sheet. 
 
The Use DP Element Association option will allow the user to associate the label with an 
element in the active drawing.  When the element changes, the label can be updated with the 
Label Updater. 
 
Label Tools will bring up the toolbox shown below that will allow the user to modify GEOPAK 
labels.  
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Label Viewer brings up a dialog that allows a user to view and place a
label. Automatic Label will update the computed inserts in a label as 
a new data point or element is chosen. 

 

 
he Label Scale menu allows the user to choose a plan scale.  All 

 scale 

The Tools menu allows the user to use a 

o 
a

The Label Updater w

 
 
 
 
 
 
 

 
 

T
labels will be adjusted according to the plan scale.  The user 
simply keys in a scale, and chooses a Labeling Style.  The 
corresponding label will be placed at the correct size for the
that was chosen.  
 

selection set, or update existing labels.  
Selection Set Labeling allows the user t
bels using a Microstation selection set.  
ill allow the user to update a label’s 

computed inserts, symbology, etc. 

work with multiple l
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9.6 Profile Labeling 

The Profile Labeling dialog differs from the Plan View Labeling dialog only on the text tab.  
s the user to select a chain and profile, and to set the profile 

settings.  The Computed and User Inserts contain values and phrases related to profiles. 

The  dialog only on the text 
tab.  t Cross 
Section Navigator  contain 

The Profile Labeling dialog allow

9.7 Cross-Section Labeling 

Cross Section Labeling dialog differs from the Plan View Labeling
Cross Section Labeling works with the Cross Section Navigator.  The curren

station is shown on the Text tab.  The Computed and User Inserts
values and phrases related to cross-sections. 
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10.1 Objectives 

• Learn to calculate original ground profiles based on a DTM. 

10.2 Definitions 

GEOPAK will generate an existing ground profile based on a stored chain from either a 3D 
graphic file or from a triangulation file (TIN). The profile information is stored in the .gpk file 
with the option to create an input (.inp) file. 

10.3 Accessing 

Existing ground profiles may be generated in either a 2D or 3D graphics file, 
both methods are similar except that an additional option is available with a 
3D file.  To access the Existing Ground Profile utility, click on Project Manager >> 
Existing Ground Profile, or choose the Existing Ground Profile icon.  Once the run 
is chosen, the following dialog box will open.  
 

 

10.4 Dialog 

Profile Name - Name of the profile to be stored. 
 
Job Number and Operator - .gpk job number and user’s initials. 
 
Chain - Name of stored chain used for profile stationing. 
 
Offset - Produces a profile at a user specified offset to the selected chain. 
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Beg Station and End Station - By clearing each field and hitting the Enter key the stationing 
will default to the beginning and ending station limits of the selected chain.  The user may also 
key-in a station range within the limits of the chain. 
 
There are four options that control the frequency of elevation calculations along the base chain. 
 
Increment - based on the beginning station of the alignment, incremented by a user specified 
value. 
 
Intersect - an elevation is calculated at every intersection of the alignment with a triangle side. 
 
Even - will compute elevations at even stations rather than an incremented distance along the 
alignment.  This is best used for alignments with station equations. 
 
POT - calculates an elevation at each POT along the alignment 
 
When in the Increment, EVEN or POT mode, an additional option box will provide two modes 
of operation for extracting data; graphic or TIN.  (Only available in 3D file) 
 
When using the Intersect or POT option with the graphic option, you will have an additional 
option for a circle to be drawn into the 3D file at the location of the intersection. 
 
**Note: It is recommended to use the Intersect option, as this will provide the most accurate 
existing ground profile. 

10.5 Reviewing Profiles 

Once a profile has been created, it may be reviewed in two ways: 
 
1) Output viewed from the COGO dialog box: Element >> Profile >> Print/List 
 
2) Profile drawn from the D&C Manager: By selecting the appropriate categories, for example: 
 

Drafting Standards >> Profile >> Existing Ground Profile >> Profile Scale 
 
Note: Always set an origin point for the profile display by drawing the Profile Cell. 
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10.5.1 Plotting Profiles 
1) Draw a diagonal line to serve as a reference point. 
 
2) Start D&C Manager. 

 
 
3) From D&C Manager, choose the appropriate scale from the category Drafting 

Standards>>Profile>>Existing Ground Profiles or Drafting 
Standards>>Profiles>>Proposed Ground Profiles. 

4) Choose the Draw Plan & Profile button. 
 
5) Set the options to be shown on the plotted profile.  
 

 
 

6) Choose the profile from the list. 
 
7) Set the horizontal and vertical scales and the station range to be plotted. 

 
 

2/11/02 Missouri Department of Transportation 10-3 



Chapter 10 Existing Ground Profiles 

 
 
8) Determine the station and elevation of the origin point.  (Usually the station will be the 

beginning of the chain, and the elevation will be a rounded value below the minimum 
elevation of the profile. 

 
9) Select the By DP button and snap to the end of the diagonal line plotted in step 1 and 

accept the location.  The coordinates for that location will be filled out. 
 

 
10)  If a profile cell has not been previously plotted, and is desired, set the PGL Chain and 

choose Draw Cell at XY.  If a cell has been previously drawn, selecting the Identify 
Cell button and choosing the appropriate cell will fill in the scale, station and DP 
information. 

 
11) Select the OK button. 
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Exercise 10-1 This is a group exercise 

1. Open MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\topo_j2p0300.dgn.   
 
If the line indicating the location of the valley section is not visible, use Level Manager to 
turn on Level 22. 

 

2. Open the project j2p0300.prj and enter Road as user userc. 
 

Copy the J2P0300 working alignment to Valley and enter that working alignment. 
 

 
 

Go to the Plan View screen in the working alignment definition and select VALLEY as the 
default chain.  
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3. Choose Existing Ground Profile from the Project Manager dialog. 
 
Copy the MoDOT run, name the new run Valley and enter the new run. 

 
4. Create an original ground profile for the valley section. 
 

Profile Name: Valley. 
Job Number: 300. 
Operator: cu. 
Chain: VALLEY. 
Offset: 0. 
Beg. Station: Will be filled in when the chain is chosen. 
End Station: Will be filled in when the chain is chosen. 
Mode: Intersect TIN. 
TIN File: j2p0300.tin. 

 

        
 

Click OK to create the ground profile input file, Yes to store the profile, and Yes to delete 
the 3D profile string. 

 

        
 

Close the Ground Profile dialog, saving the settings. 
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5. Open MicroStation file t:\br-proj\a_geopak_\d2\j2p0300\data\profile_j2p0300.dgn and 
attach t:\br-proj\a_geopak_\d2\j2p0300\data\plan_j2p0300.dgn as reference files 

 

6. Plot the existing ground profile above the plan view geometry using D&C Manager item 
Drafting Standards \ Profile \ Existing Ground Profiles \ 1”=100’ Existing Ground 
Profile and clicking on Draw Plan & Profile in the operations box. 

 

Set the Labeling Scale to 100 and turn on the following options as depicted below in the 
figure on the left: 
 Horizontal Axis Labels 
 Vertical Axis Labels 

 

Choose the profile Valley, to bring up the dialog shown below in the figure on the right. 
 

Set the following parameters: 
 Horizontal Scale: 100 
 Vertical Scale: 10 
 DP Station: 0+00.00 
 DP Elevation: 700 
 DP X and Y: Press DP and data point on the screen in an open area  
  above the plan view data or enter the values shown. 
 PGL Chain: VALLEY 

 

        
 

Press Draw Cell At XY and OK buttons to draw the profile cell and existing ground. 
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7. Complete the Profile View and Location sections of the Valley Working Alignment. 
 

Existing Profile: VALLEY 
Proposed Profile: VALLEY 

 

 
 

For the Location section, use the Identify Cell button to choose the profile cell. 
 

 
 

Accept the changes by clicking on the OK button. 
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11.1 Objectives 

• Create and store vertical alignments using the Vertical Alignment Generator. 

11.2 Definitions 

The Vertical Alignment Generator is a GEOPAK tool that can graphically create and modify 
proposed design profiles or modify an existing ground profile.  These operations may be 
accomplished through a dialog box and/or by dynamic manipulation of graphic elements. 
 
A profile may also be created with Coordinate Geometry (COGO) input. 

11.3 Accessing 

Vertical Alignment Generator may be invoked by Project Manager >> Vertical 
Alignment or by the Vertical Alignment Generator icon.  
 

he first dialog box that appears is labeled Settings.  

hoosing the Identify Cell button and selecting a 

 
n 

T
The entries in this box set the parameters and define 
the location within the design file where the profile 
is to be displayed.  All fields must be completed 
before the design process can begin.  As the OK 
button is clicked, the Vertical Profile Generator 
dialog box will appear.   
 
C
profile cell can also fill in the information.  If a 
profile cell does not exist, the Draw Cell at X, Y
can be used to place a profile cell using the locatio
and scale information provided in the dialog. 
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11.4 Dialog 

This tool allows a user to load a previously stored profile or create a new profile.  You will 
notice changes in the configuration of this dialog box as you design a vertical alignment. 

 
Various design parameters must be defined prior to designing a new profile; we will discuss 
those as we look at the options provided under the three headers, File, Tools, and User. 

11.4.1  File 
Clear - clears the profile display from Microstation graphics and removes all 
VPI’s from the dialog box. 
 
Draw - write the graphic elements of the profile to the Microstation file. 
 
Load - retrieves a previously stored profile from the coordinate geometry database 
(.gpk) 
 
 

Save - stores a new profile or updates (redefines) a previously stored profile under the same 
name. 
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Save As - is used to store the profile or to save a modified profile under a different name. 
 
Exit - ends the process. 

11.4.2 Tools 

Critical Points - Vertical curves may also be defined by one or two 
critical points.  If mathematically solvable, the vertical curve will be 
drawn and the design speed display adjusted to fit the current 
parameters. 
 

Issue Data Point - Permits the user to type in stations and elevations, issue a data point that can 
be part of a Microstation place line, place a cell or perform another generic operations.  This is 
useful in displaying visual references within the profile that need to be considered in design of 
the vertical profile. 

11.4.3 User 
Preferences - sets the rounding parameters for each of the items 
listed in the dialog box. 

 
K Values - is a table of stopping sight distance K-values for crest and 
sag conditions for various design speeds.  These values are based on 
the AASHTO Green Book. 

 
Settings - recalls the Settings dialog box that first appeared upon initializing Vertical Layout. 

11.5 Creating A New Profile 

Step 1  Place the first VPI (Note: The enter key must be used to ensure values are accepted.) 
Four options:  

i. Type station and elevation of the VPI into dialog box 
ii. Enter station of VPI as precision input (type in value) Elevation is defined 

through dynamic cursor placement on screen 
iii. Elevation is defined via precision input Station is defined through dynamic 

cursor placement on screen 
iv. Both values for the VPI can be established dynamically on screen 

Step 2  Define ahead (or back tangent) 
Station, elevation, grade and length parameters may be defined via precision 
input, dynamic manipulation or a combination of both. 

Step 3 Define remaining VPI’s and Grades 
A repetition of the process from Step 2 with an option to insert VPI’s between 
two existing VPI’ s 

Step 4 Define Vertical Curves 
Simply define the design speed from the Speed option button and GEOPAK will 
reference the K-value table and draw the vertical curve.  If a curve overlap occurs, 

2/11/02 Missouri Department of Transportation 11-3 



Chapter 11 Vertical Alignment Generator 

an overlap message will be displayed in the dialog box along with the overlap 
length. 

Step 5 Adjusting Curve Lengths 
The vertical curve can be modified by directly keying in either the K-value, curve 
length or design speed in the dialog box.  You will see the displays in the dialog 
box automatically adjust to reflect the results of any modifications. 

Step 6 Save the Profile 

11.6 Precision Placement Options 

Options available for creating or modifying vertical curves, VPI’s and grade lines:  
 
OFF - Values change. 
 
INC (Increment) - Ensures that the designated profile parameter will be adjusted as defined in 
the Preferences dialog box. 
 
LCK (Locked) - Forces all operations to maintain the designated profile parameters. 
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Exercise 11-1 This is a group exercise 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\plan_j2p0300.dgn. 

 

2. Open the project j2p0300.prj and enter Road as user userc. 
 

Copy the J2P0300 working alignment to Rte6 and enter the Rte6 working alignment. 
 

  
 

3. Enter the Rte6 Working Alignment Definition by clicking on Define in the Road Project 
dialog. 

 
Set the chain to Rte6 in the Plan View section of the dialog as shown below. 
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4. Choose Existing Ground Profile from the Road Project flow chart. 
 
Copy the MoDOT run, name the new run Rte6 and enter the new run. 

 

5. Create an original ground profile for the project. 
 

Profile Name: Rte6EX. 
Job Number: 300. 
Operator: cu. 
Chain: Rte6. 
Offset: 0. 
Beg. Station: Will be filled in when chain is chosen. 
End Station: Will be filled in when chain is chosen. 
Mode: Intersect TIN. 
TIN File: j2p0300.tin. 

 

 
 

6. Open the MicroStation file  
 t:\br-proj\a_geopak_\d2\j2p0300\data\profile_j2p0300.dgn. 

 
Attach the file t:\br-proj\a_geopak_\d2\j2p0300\data\plan_j2p0300.dgn as a reference 
file, if it is not already attached, and fit the screen. 
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7. Plot the existing ground profile below the plan view geometry using Design and 
Computation Manager item Drafting Standards \ Profile \ Existing Ground Profiles \ 
1”=100’ Existing Ground Profile. 

 
Be sure all options are turned off, and the Labeling Scale is set to 100 as shown below in the 
figure on the left. 

 
Choose the profile Rte6EX, which will bring up the dialog shown below in the figure on the 
right. 

 
Set the following parameters 

 
Horizontal Scale: 100 
Vertical Scale: 10 
DP Station: 1281+77.12 
DP Elevation: 700 
DP X and Y: Press DP and data point on the screen in an open area  
 or enter values shown. 
PGL Chain: Rte6 

 

        
 

Press Draw Cell At XY and OK buttons to draw the profile cell and existing ground. 
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8. Use the Vertical Alignment Generator to create the following proposed profile with the 
given settings. 

 
With the Identify Cell button, choose the profile cell plotted previously.  The dialog should 
fill in as follows. 

 

 
 

VPI 1 Sta.: 1281+77.20 Fd Grade: –6.40 
VPI 2 Sta.: 1285+35.00 Elevation: 799.50 Vertical Curve L: 600 
VPI 3 Sta.: 1298+40.00 Elevation: 799.50 Vertical Curve L: 300 
VPI 4 Sta.: 1306+80.00 Bk Grade: –0.01 Vertical Curve L: 660 
VPI 5 Sta.: 1311+70.00 Bk Grade: 6.80 

 
Save the profile as Rte6PR. 

 

 
 

Exist the Profile Generator.  Do not save the profile since it was just stored, but save the 
vertical alignment settings. 
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9. Plot the existing ground profile using Design and Computation Manager item Drafting 
Standards \ Profile \ Proposed Ground Profiles \ 100 Scale Proposed Ground Profile 
1”=100’ H & 1”=10’ V. 

 
Turn on the following options as depicted below in the figure on the left. 
 
 VPI Labels 
 Horizontal Axis Labels 
 Vertical Axis Labels 
 V.C. Parameters 
 Grade Labels 
 K Value 
 VPC/VPT Label 
 Stopping Sight Distance. 
 
Choose the profile Rte6PR, which bring up the dialog shown below in the figure on the 
right. 

 

     
 

Use the Identify Cell button in the dialog to select the profile cell placed earlier. 
 
Plot the profile Rte6PR by selecting the OK button.  Close D&C Manager. 
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10. Complete the Profile View and Location sections of the Rte6 Working Alignment. 
 

Existing Profile: Rte6EX 
Proposed Profile: Rte6PR 

 

 
 

For the Location section, use the Identify Cell button to choose the profile cell. 
 

 
 

Accept the changes by clicking on the OK button. 
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Exercise 11-2 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\plan_j2p0300.dgn. 
 

2. Open the project j2p0300.prj and enter Road as user userc.  Select the Rte6 working 
alignment. 

 

3. Choose Coordinate Geometry from the Road Project  
flow chart. 
 
Enter Coordinate Geometry with the settings shown 
to the right: 

 
 
 

 

4. Use Bridge deck commands to find the quarter point elevations for the first span for Bridge 
A6059. 

 Bridge Name: A6059. 
Profile: RTE6PR. 
Tie: 0. 
Cross Slope -2% (Normal Crown) 
Alignment: RTE6. 
Pier Direction Rt. to Lt.: N 13 56 34 W. 
Back Sta. CL Bearing: 1288+26.4434. 
Ahead Sta. CL Bearing: 1288+70.9850. 
Roadway Width: 36’. 
Beam Spacing: 8’-2”. 

 
The needed COGO commands are given below: 
 

BRIDGE A6059 
PROFILE RTE6PR 
TIE 0 
SE 1288+00 LT -2 12 -2 RT -2 12 -2 
ALI RTE6 
PIER BK N 13 56 34 W AH N 13 56 34 W 
SPAN 1 128826.4434 128870.9850 4 + P 
FC -19.333333 19.333333 
GU -18 18 
BEAM OFF -16.333333 -8.166667 0 8.166667 16.333333 
END SPAN 

 
Save the COGO commands (File >> Same) as an input file.  Name it 59-1 and give it the 
description: A6059-1 Deck. 
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5. Use Ultra-Edit to view the file: 
 
 t:\br-proj\a_geopak\d2\j2p0300\data\a6059-1.txt. 

 
Your results should be identical to those shown below.  If not, use the COGO Editor (Edit 
>> Editor) to correct your input file.  Once it is corrected, do a Restore/Read.  Save the 
corrected input file. 
 

Bridge Deck Elevation. 
---------------------- 
Bridge A6059 
Span A6059-1  1288+26.44 R 1 to 1288+70.99 R 1 
  
           000      001      002      003      004 
---------------------------------------------------- 
LFC    799.1341 799.1173 799.1133 799.1133 799.1133  
LGT    799.1591 799.1433 799.1400 799.1400 799.1400  
BM   1 799.1906 799.1758 799.1733 799.1733 799.1733  
BM   2 799.3461 799.3369 799.3367 799.3367 799.3367  
BM   3 799.5039 799.5000 799.5000 799.5000 799.5000  
BM   4 799.3375 799.3367 799.3367 799.3367 799.3367  
BM   5 799.1733 799.1733 799.1733 799.1733 799.1733  
RGT    799.1400 799.1400 799.1400 799.1400 799.1400  
RFC    799.1133 799.1133 799.1133 799.1133 799.1133  
PGL    799.5039 799.5000 799.5000 799.5000 799.5000 
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12.1 Objectives 

• Understand and be able to use the Plan & Profile Sheet Generator 

12.2 Definitions 

Based on user-defined parameters and sheet size, sheet borders will be placed into a blank design 
file relative to a specific alignment.  Modifications may be made to sheet size and location.  
Once the sheet boundaries are in the proper location, the designer may then place the sheet(s) 
into a design file(s) with the appropriate reference files and sheet cell. 
 
The CADD Support Center has set up data files as a basis for generating typical plan and profile 
sheets.  These sample data files include all of the settings that are “User Definable” via the Plan 
and Profile Sheet Preferences dialog box.  These settings include the General Settings, Plan 
Drawing Area, Profile Drawing Area, Grid Settings, Tabular Data, etc. 

12.3 Accessing 

The Plan and Profile Sheets Generator may be invoked via Project Manager >> Plan and 
Profile Sheets.  The Plan & Profile Sheets dialog appears.  
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12.4 Plan & Profile Sheet Layout 

The user first needs to select the job number, chain name, and profile name to layout the sheets 
along. 

 
Once the profile is selected, the user needs to reference or plot the profile into the plan sheet.  
The profile origin needs to be defined by selecting the Define Profile Origin button and filling 
out the dialog box with the proper information. 
 

DP Station – station value of the data point used to 
define the location of the profile. 
 
DP Elevation – elevation value of the data point used to 
define the location of the profile. 
 
Horizontal Scale – horizontal scale the profile was 
plotted at. 
 
Vertical Scale – vertical scale the profile was plotted at. 
 
DP X – the X coordinate of the profile location. 
 
DP Y – the Y coordinate of the profile location. 

 
The X and Y coordinates can be selected by choosing the By DP button, then selecting the origin 
point in the drawing file.  If the profile has a station equation, the profile can be plotted with gaps 
or with no gaps. 
 
Choosing the Identify Cell button and selecting a profile cell can also fill in the information.  If 
a profile cell does not exist, the Draw Cell at X, Y can be used to place a profile cell using the 
location and scale information provided in the dialog. 

 
The Beginning Station and Ending Station fields are automatically filled in with the station 
limits of the chain identified in the upper portion of this dialog box.  Should the user want to 
begin or end at a different location the user has the option to type in the station limits for sheet 
processing or click the DP button and data point a location on the screen along the center line. 
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12.4.1 Sheet Info 
After the chain and profile information has been setup, the user needs to choose the scale and 
type of sheet to create, and enter the scale value.  

 
From the list, the user needs to select the scale and type of sheets they want to create. 
 
 Type   Purpose 
 I100PL   Creates English Full Plan Sheets 1”=100’ 
 I100P2   Creates English Plan and Plan Sheets 1”=100’ 
 I100PP   Creates English Plan and Profile Sheets 1”=100’ 
 I100PR  Creates English Full Profile Sheets 1”=100’ 
 I200PL   Creates English Full Plan Sheets 1”=200’ 
 I200PR  Creates English Full Profile Sheets 1”=200’ 
 I20PL   Creates English Full Plan Sheets 1”=20’ 
 I20PR   Creates English Full Profile Sheets 1”=20’ 
 I50PL   Creates English Full Plan Sheets 1”=50’ 
 I50P2   Creates English Plan and Plan Sheets 1”=50’ 
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 I50PP   Creates English Plan and Profile Sheets 1”=50’ 
 I50PR   Creates English Full Profile Sheets 1”=50’ 
 M1000PL  Creates Metric Full Plan Sheets 1:1000 
 M1000P2  Creates Metric Plan and Plan Sheets 1:1000 
 M1000PP  Creates Metric Plan and Profile Sheets 1:000 
 M1000PR  Creates Metric Full Profile Sheets 1:1000 
 M2000PL  Creates Metric Full Plan Sheets 1:2000 
 M2000PR  Creates Metric Full Profile Sheets 1:2000 
 M200PL  Creates Metric Full Plan Sheets 1:200 
 M200PR  Creates Metric Full Profile Sheets 1:200 
 M500PL  Creates Metric Full Plan Sheets 1:500 
 M500P2  Creates Metric Plan and Plan Sheets 1:500 
 M500PP  Creates Metric Plan and Profile Sheets 1:500 
 M500PR  Creates Metric Full Profile Sheets 1:500 
 
The scale that corresponds to the type of sheet the user chose, needs to be entered into the Scale 
key-in field.  The plan number and profile number can be entered into the Plan # and Profile # 
fields. 

12.4.2  Sheet 
 Layout - In this mode, sheet borders (not the actual cells) are placed in the 
master design file based on the Sheet Type selection and the specified a
and/or profile.  The toggle below provides three options for the Layout 
command.  

lignment 

 
• Plan - Draws the plan clipping area(s) onto a plan sheet 
• Profile - Draws the profile(s) clipping area(s) onto a plan & profile sheet 
• Plan & Profile - Draws the Plan & Profile clipping area(s) onto a plan & profile 

sheet 
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12.4.3 Modify 
Once the above process is complete, the user should review the 
location of all the sheets.  Should any of the sheets need adjusting, the 
Modify mode provides four options for changes in sheet location. 
 
Place Single Sheet - allows the user to manually place one sheet 
issuing a data point on the screen 
 
Slide Single Sheet - slides a previously placed sheet along the 
alignment; adjacent sheets remain in their original location. 
 

Adjust Profile Sheet - allows the user to adjust the location of the profile border(s). 
 
Modify Drawing Area - modifies the Clip borders. 
 
Edit Sheet Number - allows the user to change a previously placed sheet number 

12.5 Clip Sheets 

he 

Output File - name of design file the 
sheet(s) will be drawn in.  GEOPAK 
will add a 1, 2, etc. to the end of each 
file name. 
 
Reference File - name of reference 
file to be attached to the output design 
file.  After selecting the reference file, 
the Add button must be clicked in 
order to add the reference file to the 
reference list.  (Note: the active 
design file and any files attached to it 
will automatically be referenced to t
output file) 
 
Attach Sheet Cell Reference – 
attaches the border reference file.  
(Note: Do not use Place Sheet Cell.) 
 

Sheets/File - Indicates how many sheets are drawn per design file.  (Note: for Rotate Reference 
only) 
 
Attach Image – attaches a DeCartes image to the plan sheet.  (Note: Image Manager must be 
running at the same time.) 
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12.5.1  Label 
Sheet - places the sheet number, chain name, and angle of rotation next to each sheet. 
 
Match Lines - When selected the Compose button becomes un-ghosted. 
 
Compose - will display a dialog box that allows the designer to place text before and after the 
station label of the match line.  
 
Define Annotation - Allows the user to define a sheet title, sheet number and a project number 
to be placed on each sheet. 

12.5.2  Rotate 
View - will attach all reference files and rotate the view to conform to the orientation of the 
sheet. 
This option allows true coordinates for the file.  (Note: If Rotate View is used, tools such as Plan 
View Labeler, and DP Station and Offset can still be used.) 
 
Reference - Will rotate each reference file to orient itself with the sheet.  (Note: It is suggested 
to use the Rotate View mode.) 

12.5.3  Sheet Range 
Allows the designer to specify the number of sheets to execute. 

12.5.4  Process 
When all the information is entered, selecting the Process initiates the sheet(s) creation. 

12-6 Missouri Department of Transportation 2/11/02 



GEOPAK Road for Bridge Exercise 12-1 Plan & Profile Sheets 

4/14/03 Missouri Department of Transportation 12-1-1 

Exercise 12-1 
This is a group exercise to show how to use the GEOPAK Plan and Profile Sheets tool to create a 
single plan sheet rotated to the alignment in the area of a stream crossing. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\plan_j2p0300.dgn.  
Attach t:\br-proj\a_geopak_\d2\j2p0300\data\topo_j2p0300.dgn as a reference file. 

 

2. Open the project j2p0300.prj and enter Road as user userc.  Use the Rte6 working 
alignment. 

 

3. Choose Plan & Profile Sheets from the Road Project flow chart.  
 
Copy the English run, name the new run Rte6 and enter the new run. 

 

4. In the Sheet Info area of the Plan/Profile change the sheet type to I20PL, which is an 
Imperial 20 scale full plan sheet, and the Scale to 20, as depicted in the following figurre. 

 

 
 



Exercise 12-1 Plan & Profile Sheets GEOPAK Road for Bridge 

12-1-2 Missouri Department of Transportation 4/14/03 

5. If a series of full plan sheets were being created, the Sheet group would need to be set to 
Plan, as shown in the following dialog. 

 

 
 

Since a single sheet will be placed, this setting is not important.  
Instead, click on the Modify… button under the Sheet group 
selection.  This will display the Modify dialog shown to the left. 

 
Click on Place Single Plan Sheet in the dialog box and move the 
mouse cursor into the MicroStation window in the area where 
Route 6 crosses the stream near the middle of the topographical 
information.  Move the mouse until the white box that appears is 
centered on the stream crossing and data point to accept the sheet’s 
location. 

 
If you need to reposition the sheet, once it is placed, click on Slide Single Plan Sheet, which 
will allow you to reposition the sheet. 
 
Zoom into the area where the sheet was placed.  Inside of the white rectangle is a gray 
dashed line that represents the area that will be clipped and viewed in the sheet file once it is 
created.  This clip boundary can be modified by clicking on Modify Drawing Area button 
and data pointing on one of the corners of the clip boundary.  The next data point will locate 
that corner in a new location.  Close the Modify dialog box. 
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6. Save the changes to the MicroStation file.  Return to the Plan/Profile Sheets dialog and click 
on Clip Sheets, which is right above the Modify… button. 

 

 
 

This will bring up the following Clip Sheets dialog, which is okay as it appears.  Click on 
Process to generate the sheets. 
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 The screen will flash and a File is Read Only alert may appear.  Accept the alert and a new 
file will appear called plan_prof1.dgn.  It is created in the Working Directory.  If you had 
wanted a different name for the file, the other name could have been typed into the Output 
File: field in the Clip Sheets dialog. 

 

7. Close the Plan/Profile Sheets dialog tool and say Yes to Save Plan/Profile Sheet Settings.  
Save the changes to the MicroStation file. 
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Exercise 12-2 
This is a group exercise to show how to create and use a MicroStation drawing with the Bridge 
working units that will be able to display GEOPAK based on Modified State Plane Coordinates. 
 

1. Open any MicroStation file the t:\br-proj\a_geopak\d2\j2p0300\data\ directory. 

 

2. From the MicroStation Menu, select File >New…  This will open the following dialog. 
 

 
 

Click on the Select button in the lower right hand corner of the dialog to chose a different 
seed file.  In the dialog that appears, navigate to t:\standard\wsmod\bridge\seed_i\ and 
select seed_i2d.dgn as the seed file, a shown below.  Click OK in that dialog. 
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3. Name the new file bridge_sheet in the Create Design File dialog shown below. 
 

 
 

Click OK to create the new DGN. 

 

4. Go to Applications > GEOPAK Road > User Preferences and clear out the Working 
Directory. 
 
The global origin for the file needs to be set to match the coordinates of the project.  The best 
way to do this is to find the southwest most point for the project.  This point can be 
determined from either the alignment or the TIN information.  Both methods are shown here 
since on method may work better than the other for a specific project. 
 
To find the point from the alignment information, do into COGO and describe the alignment 
chain.  For this example, enter COGO with the following information: 
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5. In COGO, go to Element > Chain > Describe/List/Print.   
The dialog pictured to the right will appear. Highlight the  
RTE6 chain in the dialog and click on Describe, as shown to  
the right. 

 
The chain description as output to COGO and saved in a text  
file is reproduced below: 

 
Chain RTE6 contains:  
 
 601 CUR RTE6-1 604 
 
Beginning chain RTE6 description 
============================================================= 
 
Point 601     X 45,417.17  Y 90,893.15  Sta 1268+90.88 
 
Course from 601 to PC RTE6-1  N 80^ 36' 26.00" E  Dist 121.69 
 
  Curve Data 
 *----------* 
Curve RTE6-1 
P.I.   Station 1278+75.13  X 46,388.23  Y 91,053.78 
Delta     = 25^ 27' 00.00" (RT) 
Degree    =  1^ 30' 00.00" 
Tangent   =        862.56 
Length    =      1,696.67 
Radius    =      3,819.72 
External  =         96.18 
Long Chord=      1,682.75 
Mid. Ord. =         93.82 
P.C.   Station 1270+12.57  X 45,537.23  Y 90,913.01 
P.T.   Station 1287+09.24  X 47,217.14  Y 90,815.20 
C.C.                       X 46,160.61  Y 87,144.50 
Back        = N  80^ 36' 26.00" E   
Ahead       = S  73^ 56' 34.00" E   
Chord Bear  = S  86^ 40' 04.00" E   
 
Course from PT RTE6-1 to 604  S 73^ 56' 34.00" E Dist 3,290.76 
 
Point 604     X 50,379.51  Y 89,904.98  Sta 1320+00.00 

 
Point 601 has the minimum X = 45,417.1720. 
CC RTE6-1 has the minimum Y = 87,144.50. 
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6. To find the minimum X and Y from the TIN, go into the DTM Tools by clicking  
on the raised icon depicted to the right. 

 
Go into the J2P0300 run, if you are in Project Manager; otherwise, the DTM tools  
will be displayed outside of a run. 
 
From the DTM menu, shown below, select Reports > Triangle Statistics. 

 

 
 

Process the TIN Statistics for the J2P0300.TIN, as shown below. 
 

 
 

For the TIN, the minimum X = 46,576 and the minimum Y = 89,389.  Since these values 
are greater than the ones for the alignment, the values for the alignment control.  The global 
origin for the file will be set at the rounded down vales of: 

 
X = 45,000 
Y = 87,000 
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7. Set the origin for the drawing by going to MicroStation menu MoDOT > Tools > Set 
County Coordinates.  In the Set County Coordinates, leave the DISTRICT set to 
CUSTOM, Imperial Units and click OK, as shown below in the figure on the left. 

 

    
 

This will display the next dialog, which is shown above in the figure on the right.  Set the X 
COORDINATE to 45000 and the Y to 87000 as shown and click APPLY.   
 
When the new origin is set, the follow dialog appears.  Click OK. 

 

 
 

The drawing is ready for plotting information for the project.  To demonstrate this, the 
alignment and the stationing will be plotted.  Since the process for placing a border is unique 
because of using a drawing with Bridge working units in the Design workspace, this will be 
demonstrated as well. 
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8. Open D&C Manager and select the item: 
 

Drafting Standards \ Plan \ Alignments \ MoDOT Proposed Baseline.  
 

Make sure that Place Influence is unchecked, as shown below, and click on Draw Plan & 
Profile. 

 

 
 

If asked, select Job 300. 
 
Set the Operation to Chains and the Label Scale to 20, as shown below in the figure on the 
left and click ONCE on RTE6.  Do a MicroStation Fit View.  Change the operation to 
Stationing and make sure that Large Ticks is set to Ticks Both; Labels LT and click ONCE 
on RTE6. 

 

  
 

Close D&C Manager and window in on Station 1295+00, which is the second major label 
after the curve.  Save changes to the MicroStation file. 

 

9. Choose Plan & Profile Sheets from the Road Project flow chart.  
 
Reenter the Rte6 run since the same size will be cut as before. 
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10. Check if the settings match those shown in the following figure.  Make any need corrections. 
 

 
 

When the settings are verified, click on Modify…, which is the 
active button in the above figure.  This will display the Modify 
dialog shown to the left. 

 
Click on Place Single Plan Sheet in the dialog box and move the 
mouse cursor into the MicroStation window.  Slide the white box 
that appears along the alignment until it is center on Sta. 1295+00 
and data point to accept the sheet’s location.  (Note: Only the digits 
to the left of the “+” are plotted in the drawing.) 

 
If you need to reposition the sheet, once it is placed, click on Slide Single Plan Sheet, which 
will allow you to reposition the sheet. 
 
Once the sheet is positioned where you want it, close the Modify dialog box. 

 

11. Save the changes to the MicroStation file.   
 
Return to the Plan/Profile Sheets dialog and click on Clip Sheets, which is right above the 
Modify… button. 
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12. This will bring up the following Clip Sheets dialog 
 
Change the Output File: to plan.dgn, as shown below. 

 

 
 

Click on Process to generate the sheets. 
 
Once the new file is opened, close the Clip Sheets and Plan/Profile Sheets dialogs. 

 

13. Because working units for an English Bridge seed file are 8 times smaller than a English 
Design file (the ratio is 12:1 for a metric file), the border is only 1/8 of the needed size. 
 
Adjust the border size by scaling the border file.  To do this, open the MicroStation 
References Files dialog box (Files > Reference). 
 
Highlight the border file as show in the following figure. 
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13 (continued) 
 
In the Reference File dialog go to Tools > Scale… to display the Scale Reference File tool 
depicted below. 

 

 
 

Currently, the Scale (Master:Ref) is 5:2.  Increase the Master scale by a factor of 8 to 40 as 
shown below 

 

 
 

In the lower left hand corner of the screen, the MicroStation prompt is:  
  “Scale Reference File > Enter point to scale ref file about.” 
 
If your border is centered on station 1295+00, snap to the tick mark at that location and 
accept the snap; otherwise, data point near the center of the border.  (Note: prior to scaling 
the border, a temporary MicroStation element could be place to provide a snap point at the 
center of the boarder.) 
 
Other Reference File Tools could be used to move reposition the border or to adjust the view 
are for the bridge_sheet.dgn referenced file.  
 
Since the coordinates of the bridge_sheet.dgn match those of the current file (plan1.dgn), DO 
NOT move, scale, or rotate the bridge_sheet.dgn or else the items plotted will not have real 
world coordinates.  In order that the alignment run from left to right, the view of the file has 
been rotated.  Consequently, east is not necessarily to the right. 

 
If the view becomes unrotated, attaching the 
saved view created by GEOPAK will restore the 
rotated view.  To do this, go to MicroStation 
pull down menu Utilities > Saved Views.   
 
When the Saved Views dialog appears, which is 
shown to the left, select the PLPRCL saved 
view and click on Attach.   
 
Do a MicroStation Fit View to complete the 
view restoration.   
 
The saved view was generated as part of the 
plan and profile clip sheet process. 
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14. Open the MicroStation Level Manager (Settings > Level > Manager).  Select the border file 
in the left part of the dialog as shown below.  Levels 1-2 and 10-13 are displayed by default, 
as noted in the figure. 

 

 
 

The title block in the upper corner of the border file is on level 2.  Turn off level 2.  Since 
the bridge id block is on level 7, turn on level 7.   
 
Close Level Manager and save the changes to the MicroStation file. 
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Chapter 13 Original Ground Cross Sections 

13.1 Objectives 

To generate original ground cross-sections based on a DTM, and to use the Cross-section 
Navigator tools. 

13.2 Definitions 

Geopak uses topographic elements to generate original cross sections.  These include breaklines 
and spot elevations. GEOPAK can access and read this data from several basic data formats: 

• Field Notes 
• RDS cross sections 
• DTMs based on Photogrammetric Mapping 
• DTMs based on survey information 

 
Of these basic formats, MoDOT primarily uses data from DTM's for generating existing ground 
cross sections. 

13.3 Accessing 

To access the Draw Pattern Lines dialog box, go to Project Manager >> Draw Pattern or 
choose the Draw Pattern icon.  
 
To access the Existing Ground Cross Sections dialog box, go to Project Manager >> Existing 
Ground Cross Sections, or choose the Existing Ground Cross Sections icon. 

13.4 Pattern Lines 

Pattern Lines identify the location of the cross sections.  Pattern lines are either a line or a line 
string drawn into a Microstation drawing.  The lines are most commonly drawn using the 
Microstation Place Line or Place Smartline tools, or by the Geopak Draw Pattern Line dialog.  
The Draw Pattern Line dialog allows the user to easily place pattern lines at even intervals, and 
key alignment locations.  The Microstation tools are generally used for specialty sections, such 
as an existing culvert location, or kinked sections. 
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From the Project Manager select Draw Pattern, and choose the run.  The following dialog box 
will appear.  
 

 
 
The user selects the Job Number and the Chain along which to draw the pattern lines.  The 
Offset LT and Offset RT determine how far from the chain the pattern line is to be drawn, and 
the Beginning and Ending Stations determine the station range for which to plot the pattern 
lines. 
 
Six methods are allowed for drawing the pattern lines. 
 
Increment – starts at the beginning station, and draws a pattern line at the given increment (i.e. 
for a 100 foot increment on a chain starting at 10+17, pattern lines will be drawn at 10+17, 
11+17, 12+17, …) 
 
Even – draws pattern lines at stations divisible by the given value (i.e. for a 100 foot even 
interval on a chain starting at 10+17, pattern lines will be drawn at 11+00, 12+00, 13+00, …) 
 
Once – draws a pattern line at a given station. (Only the beginning station is active.) 
 
Critical Points - Horizontal – draws a pattern line at each of the critical points (i.e. POT, PC, 
PT, etc.) within a chain. 
 
Critical Points - Vertical – draws a pattern line at each of the critical points (i.e. VPC, VPT, and 
high or low point) within a profile. 
 
Superelevation Transitions – draws pattern lines at the beginning and ending of each 
superelevation shape drawn in the current Microstation file, and any attached reference files.  
(Locations that are coincident with the horizontal control points are not drawn.) 
 
The cross section skew can be set using the skew toggle.  The pattern line is skewed by the 
specified angle from the standard pattern line (perpendicular to the baseline).  A positive skew 
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angle will rotate the pattern line clockwise, and a negative skew angle will rotate the pattern line 
counter-clockwise. 
 
Once all the key-in fields have been completed and the Apply button is selected the pattern lines 
are drawn along the chain into the open Microstation design file (on the specified level, color and 
style).  This is a visual representation of the location of the cross sections to be generated. 
 
The user can use the Microstation Place Smartline, or Place Line command to draw additional 
pattern lines as needed. 

13.5 Processing the Existing Ground Sections 

Once the pattern lines have been drawn the cross-sections can be processed.  To process the 
cross-sections, go to Project Manager >> Existing Ground Cross Sections, or choose the 
Existing Ground Cross Sections icon.  After the run is chosen, the dialog box below will 
appear. 

 

13.5.1  File Menu 
The File menu allows the user to save the dialog settings for each chain.  The user sets 
the parameters for each chain, and then selects File>>Save.  The next time the user 
accesses this dialog, the current information is completed from the resource files.  The 
user can select File>>Load to access the previously saved settings.  As the user 
switches between chains, the dialog settings will change according to how the user 
saved them.  The Project Manager run also performs the same functionality. 
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13.5.2  Edit Menu 
The Edit menu allows the user to Cut, Copy, and Paste rows from the 
Surfaces tab.  Save Dialog Settings will save the information in the 
dialog box to the resource file.  Restore Saved Settings will restore the 
dialog settings from the resource file.  (If the resource file is deleted, these 
settings will be lost and cannot be restored.)  The Clear Surface List 
option will clear all surface options from the current list. 
 
 

13.5.3  Update Options Menu 
The Update Options dialog determines how previously 
cut original ground section elements will be handled 
when drawing new original ground section elements on 
the same cross section cells. 
 
 

Delete Existing Elements and Redraw – any existing ground lines previously drawn with this 
tool are deleted and new ground lines are drawn. 
 
Delete Non-Modified Elements and Redraw – only the existing ground lines previously drawn 
with this tool that have not been modified are deleted and new ground lines are redrawn.  Lines 
that have been modified are left intact. 
 
Draw on Top of Existing – the previously drawn existing ground lines are ignored, and new 
lines are drawn.  This will result in two sets of lines. 
 
Query – brings up the following dialog when the Draw button is pressed.  The user can choose 
which option to use. 

 

13.5.4  Job Number 

 The user must specify the job number that contains the chain on which to 
base the cross sections.  The drop-down arrow will display the .gpk files available in the working 
directory. 
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13.5.5  Chain 

 The user must specify the baseline to be used for the cross sections.  The 
drop-down chain will display the chains available in the specified job number. 

13.5.6  XS Cells 
The XS Cells tab allows the user to determine where each cross section is to be drawn.   
 

 
 
Three options are available in the Pattern section to determine the l
of the cross sections. 

ocation 

 
By Station – allows the user to specify the Beginning and Ending Stations, the Left and Right 

Offsets and whether the stations should be cut at specified Even stations or at a specified 
Increment along the baseline. 

 
By DGN File – uses the pattern lines drawn as discussed in section 13.4.  The user needs to 

specify the Microstation design file in which the pattern lines are drawn, and the 
symbology of the pattern lines.  The Match button can be used to select a pattern line 
with the desired symbology.  When accepted, the symbology of the selected element will 
populate the fields that are turned on.  The Display button will display all of the elements 
that match the specified symbology.  The Reset button will clear all of the symbology 
fields. 
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In Existing Only – this option uses the only the cross section cells drawn in the current 
Microstation Design File. 

 
The Scale section can be used to adjust the scale of the cross sections.  For MoDOT, the 
Horizontal and Vertical scale should always be set to 1.0.  MoDOT controls the scaling of the 
cross sections when the cross section sheets are plotted. 
 
The distance between the cross sections and the maximum number of cross sections in each 
column can be set using the Horizontal, Vertical, and Number of XS by Column option in the 
Spacing section.  It is suggested to leave the Vertical and Number of XS by Column settings at 
the default values.  The Horizontal setting may need to be changed depending on the width of 
the cross sections.  The Horizontal setting should be set to a value greater than the total width of 
the cross section.  This will prevent the cross sections from overlapping each other. 
 

13.5.7  Surfaces 
The Surfaces tab allows the user to specify the surfaces from which to cut the original ground 
cross sections. 
 

 
 
The top portion of the dialog lists the surfaces to be cut, and the symbology to be used when 
drawing the cross sections for the given surface.  The icons on the right allow surfaces to be 
added , modified , or deleted . 
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The Details portion of the dialog allows the user to specify the TIN file to be used as the cutting 
surface, select the Method of interpolation, and select the Type of element to be drawn.  When 
Breaklines is selected as the Method, the cross section is interpolated between the breaklines, 
and the triangles are ignored.  This is mainly used in a site design application.  The method 
should always be set to Triangles, which will include the triangles in the interpolation of the 
cross section surface.  The Type allows the cross section to be drawn a Line, or a Line String. 
 

sing 

logy 

The Display Settings section allows the user to determine 
how the cross section surface will be drawn.  The user can 
choose By Level Symbology or By Feature.  When u
By Level Symbology, the user can choose the level, 

weight, color, and line style for the cross section elements by double clicking on the symbo
box next to the By Level Symbology / By Feature toggle.  By Feature allows the user to 
choose an item from the current D&C Manager database.  Selecting the paintbrush  icon il
open the current D&C Manager.  The user can select the item to use, which will then be 
displayed in the Feature field.  Previously selected items can be viewed by using the pull down 
in the Feature field.  Currently, MoDOT does not have any D&C Manager items set up for the 
cross section view.  Therefore, it is suggested to us the By Level Symbology option.  The Void 
symbology can be set using the Void toggle.  This will draw any areas that 
cross a void, or the tin hull using the specified symbology.  The following 
table shows the level symbology currently used in MoDOT. 

w l 

 
Surface Name Level Color Weight Line Style 
Existing Ground 57 90 3 2 
Void Areas 57 40 3 2 
Top of Rock 58 8 3 2 
Bottom of Rock 
(for rock seam) 

58 9 3 2 

 
The Filter Tolerances section allows for the elimination of short 
segments that may be created but are less than the tolerance distance in 
length.  The default values are good values to be used for these options. 
 
The existing ground elevation at the baseline can be 
plotted using the Text Settings portion of the dialog.  To 
use the text settings option, turn on the Elevation toggle.  
Choosing the symbology box located next to the elevation toggle can set the text symbology. 
 

13.5.8  Draw 
Once the cross section location is set up, and the surface and surface symbology is 
determined, the Draw button can be used to draw the cross sections into the active 

Microstation design file.   
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13.6 Cross Section 

The cross sections consist of mostly Microstation elements.  These elements can be modified 
using Microstation tools.  New elements can also be added using Microstation or Geopak 
drawing tools.   
 

 
 
The intelligence of the cross section is built into the cross section cell.  This cell is located on 
level 63.  The cell consists of the baseline name, the station and region, the end coordinates for 
the cross section location, and the coordinates for the location at which the cross section 
intersects the baseline. 
 
Warning:  Do not delete or modify the cross section cells.  If the cell is deleted or modified, the 
intelligence for this cross section will be lost. 

13.7 Cross Section Navigator 

The Cross Section Navigator is a tool used to view and move between cross-sections.  It can 
also be used to draw cross-section information. 
 
The user can access Cross Section Navigator by the Cross Section Navigator icon.  
When the icon is chosen, the following dialog appears.  

 

 

Station 
List 

Reset 
Navigator

Station 
Key-in 

Previous 
Section

First 
Section 

Next 
Section

Last 
Section

DP Delta 
Distance Slope

XS Active 
Angle 

Open View 
Control Dialog

Profile 
Elevation

Draw 
XS Line 

DP Offset 
Elevation

 

The user can move through the cross-sections by either choosing the station from the pull-down 
list, by typing the station value into the Station Key-in dialog, or by using the First Section, 
Previous Section, Next Section, or Last Section icons.  The Reset Navigator icon will center 
the first station to the view, and reset the navigator to the first 
station value.  Cross-section elements can be added or modified 
using Microstation tools, and/or the cross-section drawing tools. 
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DP Offset Elevation – data points 
at a given offset/elevation, or find 
the offset/elevation of the cursor 
location.  
 
 
DP Delta Distance Slope – draws a line at a 
given horizontal distance and slope.  
 
 
XS Active Angle Tool – sets the active 
angle to the given value.  If a 
Microstation tool is used with the active 
angle option, this value will be used.  
 
 
Draw XS Line – draws a cross-section line.  An 
offset or a slope can be specified.  
 
 
Profile Elevation – issues a data point at the 
elevation of a specified profile.  An alternate 
chain location can also be specified.  
 
 
 
 
 
Open View Control Dialog – allows the user to open and navigate through 
several windows to view different portions of the cross-section at the same 
time.  (I.e. The user can view the whole cross-section in view 1, the left side 
in view 2, and the right side in view 3.)  
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13.8 Summary 

Basic Steps to Creating Original Ground Cross Sections from a DTM 
 

1. Have an existing triangle file (.tin). 
2. Open a 2D Microstation design file for the pattern lines. 
3. Draw the pattern lines. 
4. Open a 2D Microstation design file for the cross sections. 
5. Draw cross sections through GEOPAK. 
6. Review and modify (if necessary). 
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Exercise 13-1 

This is a group exercise to demonstrate the process for specifying the location of cross sections 
using pattern lines and creating existing ground at those locations. 
 

1. Open the MicroStation file  
t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 
Attach the following files as references: 
t:\br-proj\a_geopak\d5\j5p0100\data\plan_50_j5p0100.dgn and 
t:\br-proj\a_geopak\d5\j5p0100\data\plan_bh_j5p0100.dgn. 
 
Save changes to the MicroStation file pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj.  Select user userc. 
 

    
 

Enter Road. 
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3. Select the Route50 working alignment. 
 

 
 

4. Choose Draw Pattern from the Road Project dialog. 
 

  
 

Copy the MoDOT run and name the new run Route50. 
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5. Create the pattern lines for the Route50 alignment in the vicinity of Big Horn Dr. but away 
from the proposed bridge ends by using the following settings. 

 
Job:  100 
Chain:  Route50 
Beginning    Ending 
 Offset Lt: 200   Offset Rt: 200 
 Station: 465+00  Station: 465+40 
 Offset Lt: 200   Offset Rt: 200 
Even:  10 

 

 
 

After enter this information in the Draw Pattern Lines dialog, plot the pattern lines by 
clicking on Apply. 

 
Repeat the process with a beginning station of 465+90 and ending station of 466+50. 

 

6. Add pattern lines at 1’ increments in the vicinity of the proposed bridge ends.  To do this, 
change the Even value to 1 and add the following two ranges of pattern lines as follows.  
Make sure you do not add pattern lines on top of any already plotted lines. 

 
Beginning Station  465+50 Ending Station:  465+80 
Beginning Station  466+60 Ending Station:  467+00 

 

 
 

7. Exit Draw Pattern and save the changes to the MicroStation file. 
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8. In the Pattern section of the Route 50 Working Alignment Definition note that the Design 
file is pattern_shape_j5p0100.dgn and the symbology for the pattern lines. 

 

 
 

9. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\xs_j5p0100.dgn. 
 

Save the file as xs_50_j5p0100.dgn so xs_j5p0100.dgn remains a blank file. 
 

10. Choose Existing Ground Cross Sections from the Road Project dialog. 
 

 
 

Copy the MoDOT run to Route50 and enter that run. 
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11. Cut the existing ground cross sections with the following parameters in the top portion of the 
dialog: 

 
Job Number: 100 
Chain: Route50 

 
In the XS Cells tab, set the following: 

 
Pattern: By DGN File 
Design File: pattern_shape_50_j5p0100.dgn 

 

 
 

In the Surfaces tab, set the TIN File to j5p0100.tin. 
 

 
 

Click on Draw to cut the cross sections. 
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12. Exist Draw Cross Sections and save the changes to the run and the MicroStation drawing 
xs_50_j5p0100.dgn. 

 

13. In the Cross Section View section of the Route50 Working Alignment Definition set 
the XS DGN File to xs_50_j5p0100.dgn. 
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Chapter 14 Superelevation 

14.1 Objectives 

• Learn how GEOPAK defines a roadway slope. 
• Learn to use GEOPAK Auto Shape Maker and Graphics Shape Maker to apply 

superelevation to a roadway. 

14.2 Definitions 

GEOPAK uses two tools to calculate superelevation transition locations for any chain stored in 
the coordinate geometry database.  One tool results in an ASCII file that lists the stations and 
slopes for each superelevation transition break.  Microstation shapes represent the roadway 
crown and depict the superelevation transition breaks.  GEOPAK Superelevation uses the 
following tools for shape creation. 

• Auto Shape Maker - is a tool used to create an input file for applying superelevation 
transition locations along a specified alignment.  Using this tool will result in an 
ASCII file that lists the stations and slopes for each superelevation transition break.  
This file is then processed to draw the shapes into the Microstation drawing. 

• Graphics Shape Maker permits interactive creation of superelevation shapes defined 
by graphic elements drawn in a Microstation file. 

14.2.1  Shapes 
Shapes are Microstation complex shapes that are placed into a design file to represent an area of 
pavement slope.  Non-transitional shapes have a constant slope for the entire length of the 
shape.  Transitional shapes have a different slope at each end of the shape, and will either 
linearly or parabolically interpolate between the slopes. 
 

Non-transitional Slopes

0%0%
Transitional Slopes

-1%2%

3%3%

2%
2%

2%
2%
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SHAPE CLUSTERS 
Four attributes are associated with each shape depending on the definition of the profile grade 
line.   
 
Baseline – roadway baseline 
 
Profile – roadway profile 
 
Tie – distance between the roadway baseline and roadway profile 
 

 

 
 
PGL-Chain – (optional) defines the location of the profile if the distance between the baseline 
and profile is not constant.  (If the distance is constant the tie distance can be used.) 
 
A group of shapes with the same shape attributes is called a “Shape Cluster”. 
 

Shape Cluster with Tie = 30 

Shape Cluster with Tie = -30 

tie = 30.0 
profile = Route50pr

baseline = Route50 

tie = -30.0 
profile = Route50pr 

baseline = Route50 
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SHAPE CLASS 
There are two classifications of shapes, Dependent and Independent, which determine how the 
pavement elevations are computed.  Dependent shape pavement elevations are determined 
directly from the profile.  Independent shape pavement elevations are determined from adjacent 
shapes. 
 
The figure below shows the dependent shape adjacent to the profile grade line (PGL).  Therefore, 
the elevation of the shape at point A will be the elevation of the profile at point A.  The elevation 
of the shape at point B will be calculated based on the width and slope of the dependent shape.  
This will be the starting elevation for the independent shape.  The elevation of point C will be 
calculated based on the width and slope of the independent shape. 

 
The figure below shows the independent and dependent shape reversed from the figure above.  In 
this case, the independent shape is located next to the PGL.  The starting elevation of the 
dependent shape, point B, is calculated based on the slope of the dependent shape and the 
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distance between the dependent shape and the profile.  The end of the dependent shape, point C, 
is calculated based on the width and slope of the dependent shape.  The end point of the 
independent shape, point B, is at the same elevation as the dependent shape at that point, and the 
beginning of the independent shape, point A, is calculated based on the width and the slope of 
the independent shape. 
 
It is good practice to use one dependent shape for each shape cluster. 

SHAPE ELEMENTS 
Shapes consist of a series of connected Microstation elements that form a closed surface.  The 
types of elements can be classified into two types, longitudinal edges, and filler lines. 
 
Longitudinal Edges - Typically, these consist of the roadway edges of pavement or lane lines. 
These lines do not represent slopes. 
 
Filler Lines - These lines represent the beginning and ending slopes of a pavement shape. Each 
of these lines always represents a slope value. 

14.3 Accessing 

The superelevation tools can be accessed from the cross section toolbox by choosing the 
Superelevation Shape Manager tool.  When selected, the superelevation toolbox will be 
displayed.  

 
The Automated Superelevation can also be accessed from Project Manager 
>> Calculate Superelevation, and the Shape Maker can also be accessed 
from Project Manager >> Superelevation Shapes.  

14.4 Dialog 

The superelevation toolbox is shown below. 

 

 
 

Shape 
Analyst 

Shape 
Properties

Shape 
Editor 

Automated 
Superelevation

Autoshape 
Builder 

Shape 
Maker 

Shape 
Selector 

Shape 
Profiler 

14.4.1  Automated Superelevation 
The Automated Superelevation dialog is the dialog most commonly used to create 
superelevation.  It allows the user to specify the parameters needed for superelevation, and then 
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creates an input file the user can modify according to the specific design for the project.  When 
the Automated Superelevation icon is chosen, the following dialog will appear. 
 

 
 
If project manager is used, the Job Number, Chain, and Beginning and Ending Stations will 
be filled in using the current Working Alignment.  The user can specify the design information 
as follows. 
 
Job – Job number of the .gpk file for the project. 
 
Chain – Baseline chain name for the project.  This may be the centerline of roadway for an 
undivided roadway, the centerline of median for a divided roadway, or the edge of pavement for 
a ramp. 
 
Beginning Station – station to begin the shapes. 
 
Ending Station – station to end shapes. 
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Design Speed - the design speed for the project that determines the rate of superelevation for 
curves. 
 
Preference File – the file to use in calculating the superelevation 
rates and transition stations.  The user should choose the 
preference file according to the standard plan being used for 
superelevation calculations.  
 

i_divided_1side – imperial, divided roadway, using 
standard 203.21G, when calculating only 1 side of 
the median 

i_undivided – imperial, undivided roadway, using standard 203.20E 
m_divided_1side – metric, divided roadway, using standard M203.21G, when 

calculating only 1 side of the median 
m_undivided – metric, undivided roadway, using standard M203.20E 

 
e Selection – the maximum superelevation value to be used for the 
alignment.  
 
Facilitiy – set according to if the roadway is Undivided or Divided 
 
L Selection – this should be set to All Cases for all situations.  
 
Profile – choose the profile for the left and right sides.  For undivided roadways, the left and 
right profiles should be the same.  For divided roadways, the left and right profiles may or may 
not be the same. 
 
Tie/PGL Chain – set to either Tie or PGL Chain.  The tie distance is the 
distance between the baseline and the profile.   If this distance is variable, a 
PGL chain can be used to define the location of the profile.   
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The % Slope, Offset, and Dependency field define the shape characteristics. 
 

 
 

% Slope – define as the normal slope for this section of roadway. 
 
Offset – define one Offset as the distance between the baseline and the inside edge of the shape, 
and the other as the distance between the baseline and the outside edge of the shape. 
 
Dependency – defines whether the shapes elevation is determined by the profile, or by the 
adjacent shapes.  Dependent shapes obtain the elevation from the profile and the slope of the 
shape as discussed in section 14.2.  Independent shapes obtain the elevation from adjacent 
shapes. 
 
Create Input File – specifies the name o the 
shape input file to be created that creates the 
shape information.  This file needs to be run to 
plot the shapes into the Microstation drawing.   
 
Shapes can be added by specifying the % Slope, offsets, and dependency, then pressing the add 
button.   Once listed, the shapes can be deleted , or modified  using the respective 
buttons. 

 
The Quick Entry button  will bring up the Quick 
Entry dialog.  This dialog can be used to create 
shapes without calculating the required offsets for 
multiple lanes.  The user chooses the type of Facility 
as divided or undivided.  If divided is chosen, the 
Median Width can be specified.  The Lane Widths, 
Total Number of Lanes, and the Nominal Percent 
Slope are specified.  When the dialog has been 
completed, the OK button is pressed, and the n
of lanes and their corresponding offsets are 

automatically entered into the shape cluster list boxes. 

umber 
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When the Automated Superelevation dialog has been completed, the user presses the Generate 
Superelevation Transitions button.  This will create the input file specified in the Create Input 
Field dialog.   

14.4.2  Superelevation Input File 
A Superelevation Input File with an .inp extension is created and placed in the project 
directory.  This input file shows where the location superelevation critical points by indicating 
the station and slope along the roadway.  This is an ASCII file that may be reviewed and/or 
edited.  A sample input file is provided below. 
 
/* Superelevation Settings and Parameters: 
Unit System is english. 
Created input file "shape.inp". 
Created activity log file "shape.log". 
Created on Mon, Oct 08, 2001 at 20:49. 
Using Preference File "i_divided" 
Using e Selection of "8% max". 
Using Length Selection of "8% max" 
Using Design Speed of 50.000000. 
*/ 
  
auto shape 
job number = 100 
  
   auto shape set 
      shape cluster baseline   = ROUTE50 
      shape cluster profile    = ROUTE50PR 
      shape cluster tie        = -30.0000 
      dependent shape 
      chain  /  offset 
         ROUTE50    -30.0000 
         ROUTE50    -42.0000 
      filler line station / slope 
           445+30.940000    2.0000 
           462+89.133015    2.0000 
           465+18.080384   -3.8000  /* Curve ROUTE50-1 */ 
           488+24.816494   -3.8000  /* Curve ROUTE50-1 */ 
           490+53.763863    2.0000 
           490+84.817000    2.0000 
  
   auto shape set 
      shape cluster baseline   = ROUTE50 
      shape cluster profile    = ROUTE50PR 
      shape cluster tie        = -30.0000 
      independent shape 
      chain  /  offset 
         ROUTE50    -42.0000 
         ROUTE50    -54.0000 
      filler line station / slope 
           445+30.940000   -2.0000 
           464+47.027752   -2.0000 
           465+18.080384   -3.8000  /* Curve ROUTE50-1 */ 
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           488+24.816494   -3.8000  /* Curve ROUTE50-1 */ 
           488+95.869125   -2.0000 
           490+84.817000   -2.0000 
  
   auto shape set 
      shape cluster baseline   = ROUTE50 
      shape cluster profile    = ROUTE50PR 
      shape cluster tie        = 30.0000 
      dependent shape 
      chain  /  offset 
         ROUTE50    30.0000 
         ROUTE50    42.0000 
      filler line station / slope 
           445+30.940000    2.0000 
           464+47.027752    2.0000 
           465+18.080384    3.8000  /* Curve ROUTE50-1 */ 
           488+24.816494    3.8000  /* Curve ROUTE50-1 */ 
           490+53.763863    2.0000 
           490+84.817000    2.0000 
  
   auto shape set 
      shape cluster baseline   = ROUTE50 
      shape cluster profile    = ROUTE50PR 
      shape cluster tie        = 30.0000 
      independent shape 
      chain  /  offset 
         ROUTE50    42.0000 
         ROUTE50    54.0000 
      filler line station / slope 
           445+30.940000   -2.0000 
           462+89.133015   -2.0000 
           465+18.080384    3.8000  /* Curve ROUTE50-1 */ 
           488+24.816494    3.8000  /* Curve ROUTE50-1 */ 
           490+53.763863   -2.0000 
           490+84.817000   -2.0000 
  
   Plot Parameters 
      Dependent Shape 
         lv = 63 
         co = 6 
         lc = 0 
         wt = 2 
      Dependent Text 
         lv = 63 
         co = 6 
      Independent Shape 
         lv = 63 
         co = 1 
         lc = 0 
         wt = 2 
      Independent Text 
         lv = 63 
         co = 1 
  
Write shapes into dgn = d:\de-proj\Cole\j5p0100\data\pattern_shape_j5p0100.dgn 
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The input file is also opened into the Geopak text editor.  The input file can be edited in the text 
editor.  Once any changes have been made, and the input file has been saved, the text e
be used to process the input file by clicking on the Create Superelevation Shapes but
 

ditor can 
ton.   

 
 

14.4.3   Superelevation Log File 
 created, the Superelevation Log File is also created.  

 

eginning calculation of superelevation for chain ROUTE50 in job 100. 

omputing superelevation rates . . . 
:  Superelevation rate computes to be 3.8000. 

omputing transition lengths . . . 
consists of 4 lanes, 

 for 4 lanes. 

When the Superelevation Input File is
The Superelevation Log File contains information pertaining to the creation of the input file.  A
sample log file is shown below. 
 
B
 
C
Curve ROUTE50-1, radius 2864.7890
 
C
Note: Because the roadway width 
      lengths are to be adjusted after initial calculation. 
Curve ROUTE50-1:  Super rate of 3.8000 yields 
      unadjusted runoff length of 150.0000. 
      Transition Length adjusted to 150.0000
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Checking for transition conflicts . . . 

uperelevation Calculation Complete. 

he log file indicates the superelevation rate computed for each curve, the transition length for 

he Superelevation Log File should be reviewed prior to the processing of the input file to 

14.4.4   Autoshape Builder 
 needs to be processed to plot the shapes into 

er.  The 
g 

No transition conflicts were found. 
 
S
      Output written to file "shape.inp" 
 
T
each curve, and any transition conflicts between curves. 
 
T
check for errors, and verify any transition conflict resolutions. 

After the input file has been created and edited, it
the Microstation design file.  The input file can be processed by using the Create 
Superelevation Shapes button in the text editor, or by using the Autoshape Build
Autoshape Builder can be accessed from the Superelevation toolbox. The followin
dialog will appear.   
 

 
 

he user selects the input file to process, then presses the Apply button to execute the input file.  

14.5 Shape Maker 

Not all superelevation transitions can be defined by station and offset.  GEOPAK provides the 
 

he user uses simple Microstation elements to depict the area to which superelevation is applied.  

 

ccess Shape Maker from the GEOPAK Project Manager by selecting Superelevation 
The following 

T
The Display Only toggle can be turned on to temporarily plot the shapes into the Microstation 
design file.  When the view is updated, the temporary graphics will be deleted. 
 

Graphical Shape Maker for situations that involve left turn lanes, merging roadways and in
some cases, widening. 
 
T
Once the area is drawn, the Graphical Shape Maker dialog box allows the designer to define 
the roadway information to apply superelevation.  The Microstation elements are then identified
and a complex shape representing the superelevation is created. 
 
A
Shapes or from the Shape Maker icon in the Superelevation toolbox.  
dialog is displayed. 
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Parameters 
 
Baseline - chain corresponding to the shape. 
 
Profile - profile controlling shape. 
 
Level - Microstation level on which shape will be placed. 
 
Class - dependent or independent, as previously discussed 
 
PGL Chain - chain to define the profile location if the tie distance varies. 
 
TransID - determines linear or parabolic transition.  Use 0 for linear transition. 
 
Tie - distance between the profile and the baseline. 
 
Set - used to change the parameters of an existing shape 
 
Show - used to display the parameters of an existing shape. 
 
Filler Lines 
 
Method: By DP - identify filler line by issuing a data point (DP) on each end of the line 

By Line - identify filler line by selecting a Microstation line 
By Station - identify filler line by keying in station limits 

 
S.E.:  Transition - shape is in a superelevation transition 

Non-Transition - shape is not in a superelevation transition (full super or normal 
crown) 

 
Slope - cross slope for the filler line at the beginning and end of the shape 
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Tolerance - user specified acceptable maximum gap between the Microstation elements that 
make up the shape 

 
Complete Shape: Manual - user identifies each element that makes up the shape. 

Semi-Automatic - user accepts or rejects elements that make up 
the shape. 
Automatic - GEOPAK uses all contiguous elements to create the 
shape. 

 

14.6 Additional Superelevation Tools 

14.6.1   Shape Analyst 
The Shape Analyst is used to determine the slope of a shape at a particular point.  The elevation, 
profile elevation and slope, cross slope, longitudinal slope, and flow slow are computed and 
displayed.  The elevation can be computed off the shape by using an Extrapolated Slope from 
the edge of the shape.  The Cross Section option will display the slope of each shape, and the 
elevation at the edge of each shape. 
 

 
 

14.6.2   Shape Profiler 
The Shape Profiler is used to graphically draw 
the elevations and/or slope arrows into the d
file for a specified element or shape.  COGO 
points can also be stored at the given location
 

esign 

s. 
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14.6.3   Shape Editor 
The user can edit the plotted shapes by using the Shape Editor.  The Shape Editor allows the 
user to adjust the slope of the filler lines, or change the location of the filler lines.  The filler lines 
of the adjacent shapes are also adjusted as needed. 
 

 
 

14.6.4   Shape Selector 
The Shape Selector allows the user to select or 
highlight shapes based on various attributes of the 
shape.  The attributes include baseline, profile, tie, 
transition type, class, slope, etc.  
 

14.6.5   Shape Properties 
The properties of a shape can be edited using the Shape 
Properties tool.  With Shape Properties, a user can change 
the baseline, profile, tie, etc. of a shape. 

14-14 Missouri Department of Transportation 2/11/02 



GEOPAK Road for Bridge Exercise 14-1 Superelevation 

4/14/03 Missouri Department of Transportation 14-1-1 

Exercise 14-1 

1. Open the MicroStation file  
t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj as user userc and 
enter Road. 

 

    
 

3. Select the Route50 working alignment. 

 

4. Choose Calculate Superelevation from the Road Project dialog to calculate the pavement 
cross slopes. 

 

  
 

Copy the MoDOT run to Route50 and enter the run. 
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5. Create the Route50 shapes as  
follows and as depicted in the  
dialog to the right: 
 
Job: 100 
Chain: Route50 
Begin Station: 464+00 
Ending Station: 468+00 
Design Speed: 60 
Reference File: i_dvided 
Facility: Divided 
e Selection: 8% max 
L Selection: all cases 
Profile: ROUTE50PR 
Tie: Offset 
 
Click on the Quick Entry icon  
circled in red in the dialog box to 
the right.  This will bring up the 
dialog shown below.  Fill it in as 
shown with the following: 
 
Facility: Divided 
Median Width: 60.00 
Lane Widths: 12.00 
Total Lanes: 4 
Normal % Slope: 2.00 
 

 
 
Click OK. 
 
Modify the % Slope to –2.0000 for offsets 42-54 on the Left (negative) and Right (positive) 
sides. 
 
Change the Input File to: shape_50.inp 
 
Click on Generate Superelevation Transitions. 
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6. Clicking on the Generate Superelevation Transitions button will generate the INP file, 
which is displayed in the following dialog box. 
 

 
 

7. Use UltraEdit or another text editor to view the log file: 
 t:\br-proj\a_geopak\d5\j5p0100\data\j5p0100\data\shape_50.log. 

 

8. Run the input file shape_50.inp by clicking on the Create Superelevation Shapes icon  
in the GEOPAK Text Editor: shape_50.inp.  It is the icon shown to the right and it the 
last icon in the tool bar at the top of the dialog.  Save the MicroStation drawing after creating 
the shapes and close the GEOPAK Automated Superelevation dialog.  Click on Yes to 
Save Superelevation Settings? in the Alert dialog. 

 

9. Select the BigHorn working alignment. 
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10. Click on the Define button to review the BigHorn working alignment definitions.  Under the 
Shapes section, change the following symbology settings: 
 
Levels: 62 
Colors: 2,7 
 
Using different symbology lets the user distinguish between the shapes for the two 
alignments. 
 
Close the working alignment definition box by clicking on OK. 

 
 

11. Select the Calculate Superelevation button from the Project Manager dialog.  Copy the 
MoDOT run to BigHorn, and enter the run.  Create the Big Horn shapes as follows:  
 

Job: 100  
Chain: BIGHORN 
Begin Station: 8+00 
Ending Station: 12+00 
Design Speed: 40 
Reference File: i_undvided 
Facility: Undivided 
e Selection: 8% max 
L Selection: all cases 
Profile: BIGHORNPR 
Tie: Offset 
 

Use the Quick Entry dialog to 
set the lane information to the  
following: 
 

Facility: Undivided 
Lane Widths: 16.00 
Total Lanes: 2 
Normal % Slope: -3.125 
 
 
 
 
 
 
 
 
 
 
 

Change the Input File to: shape_bh.inp 
 

Click on Generate Superelevation Transitions. 
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12. Edit the filler lines for both  
auto shape sets so there is a  
constant cross slope of  
–3.125% for the full station  
range and change the second  
set to an independent shape,  
as depicted to the right.  Note:  
Because the profile grade line  
is at the center of the roadway,  
both shapes can get their  
elevations from the profile  
(the dependent condition).   
Changing one of the shapes to  
independent, however, enables  
the user distinguish between  
the two shapes. 
 
Under Plot Parameters,  
change the level (lv) and the  
color (co) settings to the values  
shown below in bold text,  
which are the values set in the  
BigHorn Working Alignment: 
 
    Dependent Shape 
       lv = 62 
       co = 7 
       lc = 0 
       wt = 2 
    Dependent Text 
       lv = 62 
       co = 7 
    Independent Shape 
       lv = 62 
       co = 2 
       lc = 0 
       wt = 2 
    Independent Text 
       lv = 62 
       co = 2 
 
After editing the input file, save the changes by clicking on floppy disk icon and run it by 
clicking on the Create Superelevation Shapes icon.   
 
Exit the text editor. 
 
Exit the superelevation run and save the changes to it and the MicroStation file. 
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13. The fill slopes will also be shaped to determine the bridge length.  Since these shapes need to 
be associated with a profile, a location for the profile needs to be determined.  The toe of the 
slope is the most logical location.  From the cross section below, it can be determined that the 
toe of the slope is 0.15’ above the roadway profile with a constant offset of 24’ left and right. 

 
Go into Coordinate Geometry.  Select  
Element > Profile > Offset.  This  
will bring up the dialog box shown  
to the right. 
 
Enter the following information as  
shown in the top figure to the right: 
 
Source Profile: BIGHORNPR 
Target Profile: BH-ToeSlp 
Begin Station: 1+93.64 
End Station: 20+60.66 
Vertical Offset: 0.15 
 
Once this information is entered,  
click on the Add icon , which is 
the top icon on the right side of the  
dialog box.  This will add the station  
range and the offset to the list box as  
depicted in the bottom figure to the  
right.  To delete an item from the list  
box, highlight the line and click on  
the Delete icon , which is the  
middle icon on the right side of the  
dialog.  If changes need to be made  
to an item in the list box, highlight  
that line, edit information in the  
fields at the bottom of the dialog  
and click on the Edit icon . 
 
When the list box is complete, click on the Create Profile button.  This will store the target 
profile, as indicated by the following message in the MicroStation Status Bar in the lower left 
hand corner of the MicroStation window: “Profile BH_ToeSlp saved.  Store Profile 
commands saved in BH_ToeSlp100.icu.”  This file is stored in the working directory and may 
be viewed using UltraEdit or any other text editor. 
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14. Click on the Select button in Project Manager.  Copy the BigHorn working alignment to 
BH-Slope and enter the new working alignment. 
 
Click on the Define button and adjust the following definitions: 
In the Shapes section, change the Colors to 3. 
Under Profile View, change the Proposed Profile to BH-TOESLP. 
Click OK. 
 
To facilitate the creation of the shapes using Shape Maker, set Level 1 as the active level, 
use Level Manager to turn off levels 61 ans 63, and turn off the display for any referenced 
files.  All that should be visible after doing this are the shapes for Big Horn Dr. 
 
Choose Plan View Design from Project Manager.  This will bring up  
the toolbox shown to the right.  Select Draw Transition, which is the  
third tool in the toolbox. 
 
Use Draw Transition to draw the following lines  
to serve as longitudinal lines for shapes: 
 
 Beginning Beginning Ending Ending 
 Station Offset Station Offset 
 7+90 24 12+10 24 
 7+90 -24 12+10 -24 
 7+90 -70 12+10 -70 
 7+90 70 12+10 70 
 
Close the Draw Transition and the Plan View Design dialog boxes after the four lines are 
drawn. 

 

15. Click on Superelevation  
Shapes in Project Manager.   
 
Fill in the dialog so it is like  
the one to the right (wt = 2).   
Once this is completed, click  
on the Create button.  This  
will draw a filler line at  
station 8+00. 
 
Change the Station to 12+00  
and click the Create button a  
second time to draw the other  
filler line at Station 12+00.   
  
Click on the Draw button and data point inside the closed in area on the right side of Big 
Horn Drive.  Note: On the screen it is actually to the left of the existing shapes. 
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16. Repeat the process on the left  
side of Big Horn Drive, which  
is to the right of the existing  
shapes on the screen.  
 
Change the Tie to –24.00, set  
the Station to 8+00 and click  
on the Create button to draw  
the first filler line. 
 
Change the Station to 12+00  
as shown to the right and click  
on the Create button to draw  
the second filler line. 
 
Click on the Draw button and data point inside the closed in area on the left side of Big Horn 
Drive.  Note: On the screen it is actually to the right of the existing shapes. 
 
Refresh the view.  Turn on Level 63 and save the changes to the MicroStation drawing.  Exit 
Shape Maker. 

 

17. A profile for Route 50 is needed to define the maximum height of the fill slopes.  This profile 
is based upon the minimum clearance of 1’ from the top of the end bent beam to the top of 
the fill slope (BM 3.77.2.2-2, Effective May 2002).  Since Big Horn Dr is 39’ wide, Type 30 
P/S Concrete Double Tee Girders will be used (based on BM 3.56.1.6-1, Effective Nov. 
2000, as shown on the following page).  From the figure below (BM 3.56.1.1-10, Effective 
Nov. 200), the web depth is 30”.  Allowing ¼” for the bearing pads, ¼” for camber, and 8 ½” 
for the deck, gives a total depth of 39” (30 + ¼ + ¼ + 8 ½) = 3.25’.  Adding the 1’ clearance 
results in the maximum height of the fill slope at 4.25’ below the top of the deck. 

  
Using Offset Profile, create profile 50-PR-SLP 4.25’ below Route50PR. 
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Big Horn Dr. 
Width = 39’
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18. The profile 50-PR-SLP will be used for shapes that represent the maximum height surface 
for the bridge fill slope.  These will be added to pattern_shape_j5p0100.dgn by editing and 
running an existing INP file. 

 
Open shape_50.inp in 
UltraEdit.  Highlight the shape 
cluster profile ROUTE50PR.  
Go to the UltraEdit pull down 
menu Search > Replace, to 
bring up the dialog to the left. 
 
Enter 50-PR-SLP in the 
Replace With: field as shown.  
Click on the Replace All button 
to change the name of the 
profile in the file.   

 
Go to the 2nd and 4th auto shape sets and change the offset range to the values shown below 
(the value to be changed is shown in bold): 

 
  Changes to 2nd auto shape set  Change to 4th auto shape set 
    chain  /  offset    chain  /  offset 
       ROUTE50    -42.0000       ROUTE50     42.0000 
       ROUTE50    -64.0000       ROUTE50     64.0000 

 
Scroll down to the Plot Parameters section of the input file and change level (lv) and color 
(co) symbology to the values shown below in bold. 

 
    Plot Parameters 
       Dependent Shape 
          lv = 60 
          co = 8 
          lc = 0 
          wt = 2 
       Dependent Text 
          lv = 60 
          co = 8 
       Independent Shape 
          lv = 60 
          co = 4 
          lc = 0 
          wt = 2 
       Independent Text 
          lv = 60 
          co = 4 
 
Save the file as shape_50_slp.inp.  This input file will be run later. 
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Exercise 14-2 

This is a group exercise to demonstrate the use of the GEOPAK superelevation tools to help 
determine end locations.  Specifically, the tools will be used to find elevations from two shapes 
to locate where they intersect. 
 
This exercise is based on the following design information:  End of wing to end of wing length is 
controlled by the intersection of the spill slopes with the outside edges of the bridge deck.  End 
bent locations are controlled by the requirement to maintain a minimum clearance of 1’ from the 
top of the end bent beam to the top of the spill slope.  This clearance needs to be checked at the 
outside face of the exterior girders unless the crest of a vertical curve for the lower roadway is 
located directly beneath the bridge.  The location of the checks for this exercise was obtained 
from the cross section of the slab from Bridge Manual page 3.56.2.5-1 shown on the following 
page. 
 

1. Open the MicroStation file  
t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj as user userc and 
enter Road. 

 

    
 

3. Select the Route50 working alignment.  
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4. Determine Critical Offsets:  Away from the bridge, the roadbed width is 40’ (6’ left 
shoulder, + two 12’ lanes + 10’ right shoulder).  Centering the structure on the roadbed 
places the centerline of structure two feet to the right of the centerline of the two driving 
lanes, which is 42’ to the right of the highway’s horizontal alignment.  Consequently the 
centerline of structure is 44’ (42’ + 2’) to the right of the alignment.  Offsets for the bridge 
gutterlines are 24’-7” (44’ - 19’-5”) and 63’-5” (44’ + 19’-5”).  Adding the 16” barrier, the 
offsets for the bridge deck edges are 23.25’ & 64.75’.  These are the offset values that will 
be use to locate the intersect point of the spill slope with the bridge deck. 
 
The figure from the Bridge Manual on the previous page show the horizontal width of the 
flanges on the interior double-tees as 6’-11 ¼”.  Because the bridge is curved, this value will 
be increased to 6’-11 3/8” to reduce the maximum exterior overhang on the outside edge of 
the curve. 
 
Also, because the deck is curved to the left, its edge will come in towards the girders at 
center span by about 1 ½” on the left side and move away from the girder on the right side by 
about the same amount.  To account for that, the deck will be shifted to the right by 1 ½”.  
The following figure from BM page 3.56.1.6-10 shows that for a 38’-10” roadway and Type 
30 girder, the normal overhang from the centerline of the exterior girder is 13”.  This will be 
increased to 14 ½” (13” + 1 ½”) on the left and reduced to 11 ½” (13” - 1 ½”) on the right 
side at the end of each span.  With the 3” full depth cast in place slab overhang on the outside 
of the girder flange and with the 6” wide web, the exterior faces of the girders at the end bent 
will also be about 14 ½” from the edge of the slab on the left and 11 ½” from the edge of the 
slab on the right side of the deck at the end bents.   
 

 
 

Because the four interior girders have been widened by 1/8”, the overhangs will be reduced 
by ¼” (2 girders per half section x 1/8”).  Consequently, the horizontal offsets from the 
alignment for the exterior girder faces are 23.25’ + 14 ¼” (1.1875’) = 24.4375’ on the left 
side and 64.75’ – 11 ¼” (0.9375’) = 63.8125’ on the right side.  These will be plotted to 
locate the top of the spill slopes at the ends of the bridge. 
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5. The location of the critical offsets are shown on the follow cross section of the bridge away 
from a bent.  Because the slope of the roadway under the bridge is less than that of the 
bridges super elevation, exterior face of the right most girder will control the location of the 
end bents. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The first set is to determine the change in elevation along the bridge deck from the profile 
grade line to the critical offset.  This change in elevation is based on the 5% superelevation 
on the bridge plus the offset distance from the profile grade line to the critical point.  Based 
on the above figure this change in elevation is: 
 
  0.05 * (63.8125’ - 30’) = 0.05 * (33.8125’) = 1.690625. 
 
The 4.25’ distance from the top of deck to the top of the fill slope must be subtracted from 
this value.  Thus the total vertical offset from the Route 50 proposed profile to profile for the 
top of the fill slope at the exterior face of the right most girder is: 
 

    1.690625 – 4.25 = -2.559375. 
 
Based on this information, create the needed profile.  To do this, go into Coordinate 
Geometry for Job 100 with Operator Code cu.  Use the Element > Profile > Offset tool with 
the following settings: 
 
Source Profile = Route50PR  
 
Target Profile = EB-RT-SLP 
 
Begin Station = Route50PR 
  beginning 
  station 
 
End Station =  Route50PR  
  ending station 
 
Vertical Offset = -2.559375 

 

Left Edge of 
Bridge Deck 
23.25’ 

Profile Grade 
Line 30.00’ 

Exterior Face of
Right Most Girder

63.8125’Exterior Face of 
Left Most Girder 
24.4375’ 

Right Edge of 
Bridge Deck 
64.75’ 

5.00 %

Centerline  
of Structure 
44.00’

Centerline
East Bound
Lane 42.00’
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6.  Several tools from the Superelevation Shape Manager will be used to  
  obtain elevation information from the shapes.  The icon for the manager  
(shown above) is the forth icon from the right in the Cross Sections toolbox,  
which is located in the lower left hand corner of the Road Tools as shown in the  
figure to the right.  The expanded Cross Sections toolbox is shown below. 
 

    
 
Bring up the Superelevation Shape Manager shown below. 
 

   
 
The tools in this pallet are: 

 Automated Superelevation,    Autoshape Builder,  

 Shape Maker,   Shape Analyst,  

 Shape Profiler,   Shape Editor, 

 Shape Selector, and   Shape Properties. 
 
Open the Autoshape Builder, shown to  
the right.  Click on the Files… button  
and select shape_50_slp.inp.  Press the  
Apply button to run the input file. 
 
To off level 63. 
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7. In order to find the needed elevations,  
plot the outside face of the right exterior  
girder.  Elevations from the shapes will  
be obtained at set intervals along this  
line. 
 
To do this, open Design and  
Computation Manager. 
 
Expand the Design Standards folder. 
 
Open Safety and Structures subfolder  
as well. 
 
Select Bridge from the list of items  
in that folder, as shown in the figure to  
the right. 
 
Since a Design Standard is being plotted,  
make sure Place Influence is checked  
in the Operations box as shown in the  
following figure. 
 

 
 

8. Use the Draw Transition tool (the third icon in the Plan View Design tool box) to draw the  
following line relative to the Route 50 chain: 
 
  Beginning   Ending  
 Station  Offset Station  Offset 
 464+00  63.8125 468+00  63.8125 
 
The values for drawing the line are shown in the  
figure to the right.  
 
After drawing the drawing the line, close the  
D & C Manager and Draw Transition dialogs. 
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9. Open the Shape Profiler tool.  This will bring  
up the top dialog to the right.   
 
Go to User > Preferences in Shape Profiler  
to customize the profilers output as shown in  
the bottom figure on the right.  Use the setting  
shown in the figure.  Click OK. 
 
Go to the MicroStation pull down menu  
Element > Text and set the justification to  
match that shown in the figure below. 
 

 
 
In Shape Profiler, click on Identify Shape and data  
point on the shape for the driving lane of eastbound  
Route 50 where it crosses Bighorn Dr.  This will fill  
in the Chain and Station fields for the shape.  Change  
the From Station to 465+50.00 and the To Station  
to 467+05.00.  Click on the Identify Element button,  
data point on the line defining the outside edge of  
the right exterior girder, and data point to accept.   
The end result is depicted in the figure below, which  
gives the elevations along the girder edge one foot  
below the top of the end bent beam. 
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10. To determine the elevations on the fill slopes, use Level Manager to turn off  
levels 60 so only the shapes for Big Horn Dr. are visible.  
 
Switch the text justification to the lower right corner, as shown in the figure so  
the elevations for the fill slope are place opposite of the values just plotted.   
 

Select the Shape Analyst tool by clicking on the following icon in the Shape Manager .  
This will bring up the dialog on the  
right.  Select the BIGHORN chain. 
 
Go to User > Preferences and change  
the text settings to those shown below.   
Click OK to accept the changes. 
 

 
 
Set the tentative snap to key point.   
 
Click on the DP button in Shape  
Analyst.  Tentative snap on text  
giving the elevation at Station  
465+70 (773.9478) and accept the  
snap, this will plot the fill slope  
elevation at that location.  Repeat  
the process for the next three  
values plotted by the profiler.  The  
end result is shown to the right. 

 

11. Move to other end of the bridge and plot the slope elevations at that end of the bridge, as 
shown in the following figure. 

 

 
 

Turn on the display for level 60. 
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12. Window in on the SW corner between Station 465+70 and 465+80, as was  
done to create the figure on the right.  The plotted elevations indicate that  
the projection of the fill slope goes above its maximum allowable height  
under the bridge deck in this station range.  While linear interpolation could  
be used to establish a crossing point, greater accuracy can be accomplished  
by using the shapes.  To do this, elevation information will be obtained from  
the shapes at 1’ increments. 

 
Switch to Shape Profiler and adjust the User > 
Preferences text settings to Level 2, Color 2, and 
Size 0.75 as shown to the left.  The change in text 
size is being done to distinguish the  
foot from the 10’ increment values. 

 
Change the text justification to  
bottom left, as shown to the left. 
 
Based on the elevations given,  
the crossing point is between  
Route 50 Sta. 465+70 and  

465+80; therefore, use Shape Profiler to plot  
elevations relative to Route 50 at Sta. 465+71 -  
465+78 at 1’ increments.  Use the following  
settings as shown in the figure to the right: 
 
 Chain: ROUTE50 
 From Station: 465+70.50 
 To Station: 465+78.50 
 Increment: Even 1 
 
 
Do the same thing at the other end of the bridge  
between Route 50 Sta. 466+80 and 466+90.  Use  
the following settings: 
 
 Chain: ROUTE50 
 From Station: 466+80.50 
 To Station: 466+87.50 
 Increment: Even 1 
 
 
 
 
 

 



Exercise 14-2 Superelevation Tools GEOPAK Road for Bridge 

14-2-10 Missouri Department of Transportation 4/14/03 

13. To obtain the elevations on the fill slopes, use Level Manager to turn off levels  
60 so only the shapes for Big Horn Dr. are visible.  

 
Change the text justification to bottom right. 

Select Shape Analyst by clicking on its icon in the Shape Manager .  Select the 
BIGHORN chain. 

 
Go to User > Preferences and change the text  
settings to those shown to the right.  Click OK to  
accept the changes. 
 
Make sure your snap is set to key point.  Click on the DP button in Shape Analyst.  
Tentative snap on text plotted in the previous step.  This will plot the fill slope elevation at 
that location.  Screen captures from each corner of the bridge are shown below 

 
 SW Corner of Bridge SE Corner of the Bridge 

   
 

Compare your elevations to those given below. 
    Deck Elev. 
 Location Station Minus 4.25’ Slope Elevation 
 SW Corner 465+76 773.9913 774.3402 
 SW Corner 465+77 773.9984 773.8438 
 

 SE Corner 466+85 774.4242 774.0255 
 SE Corner 466+86 774.4250 774.5334 
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Exercise 14-3 

This group exercise will use the GEOPAK profile tools to plot proposed fill slopes under the 
bridge as they pass under the right exterior girder.  Data from Exercise 14-2 provides the 
information needed to accomplish this task.  Once the fill slopes have been plotted, they can be 
used to determine the minimum from front face to front face of the end bents.  These will be 
horizontal lengths as measured along the alignment for Route 50. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\profile_j5p0100.dgn.  
 
Do a MicroStation fit-view.  At the top of the drawing are three diagonal lines.  Adjust the 
MicroStation window so you are zoomed in on the right most diagonal line and the text 
above it and to the right.  This area will be used to plot the right edge of the bridge.   

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 

 

3. To keep track of the information for the left edge of the bridge, copy the Route50 working 
alignment to EB-BR-RT and enter that working alignment. 

 
Make the following changes in the Profile View section of the Working Alignment 
Definition: 
 
 Proposed Profile: EB-RT- SLP 
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 Adjust the values in the Location section of the Working Alignment Definition to those 
shown in the following figure: 

 
Horizontal Scale: 10 
Vertical Scale: 10 
DP Station: 465+00 
DP Elevation: 700 

 

 
 

Click on the By DP button and snap to the upper end of the diagonal line and accept.  This 
will set the DP X and DP Y values to those shown above. 
 
Place the profile cell by clicking on the Draw Cell at X,Y button.  The active MicroStation 
text setting controls size of the text in the cell. 
 
Save the changes to the working alignment definition by selecting the OK button. 

 

4.   Open Design and Computation Manager (D&C) from Road Tools using the icon  
 shown to the left.  It will be used to plot the profiles for the left edge of the bridge.  The 
first one to be plotted is EB-RT-SPL, which defines the maximum height of the fill slope. 

 
Navigate to: 
Drafting Standards\Profile\Existing Ground Profiles\1”=10’ Existing Ground Profile. 

 
Click on Draw Plan & Profile in the Operations box shown below. 
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  Change the label scale to 10 as depicted 
to the right and click on R OUTE50EX in  
the Select Profile list.  This will bring up  
the dialog shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change the following values: 
  Begin Station: 465+00 

Ending Station: 468+00 
 

Click on the Identify Cell button, data point on profile cell plotted in the previous step, and 
data point to accept. 
 
Select OK to plot the profile.  
 

  In D&C Manager, double-click on:  
  Proposed Ground Profiles\10 Scale Proposed Ground Profile 1”=10’’ H & 1”=10’ V. 
This will update GEOPAK Plan & Profile Draw to the defaults for proposed profiles. 
 
Select EB-RT-SLP from the Select Profile list. 
 
The settings should be the same as shown above in the figure on the left except for the name 
of the profile at the top of the dialog and the profile information.  Select the OK button to 
plot the EB-RT-SLP profile as the propose profile. 

 



Exercise 14-3 Profile Tools GEOPAK Road for Bridge 

14-3-4 Missouri Department of Transportation 4/14/03 

5. In the main D & C dialog, switch to: 
 Design Standards \ Cross Sections \ Proposed Surfaces \ Ground (Proposed). 
 
Make sure Place Influence is turned checked.  This will set the MicroStation symbology to 
those for fill slope under the bridge.  Keep D & C open. 
 
Go into Vertical Alignment from the Road Project Dialog, which will bring up the Settings 
dialog box shown below. 
 

  
 
Everything should be set from the Working Alignment Definition.  If your settings do not 
match those shown above, click on the Identify Cell button in the dialog, data point on the 
profile cell for the EB-LT profiles.  Click the OK button.  This will bring up the Profile 
Generator dialog box: 
 

 
 
Go to Tools >> Issue Data Point. 
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6. Use the Issue Data Point to plot the fill slopes.  To do this, active the MicroStation Place 
Line tool.  Enter the following values into the Issue Data Point dialog as shown below: 
  Station: 465+76 Elevation: 774.3402. 

 

 
 

Click the Issue DP button to begin a fill slope line. 
 

Issue data points for the following values to draw the rest of the line: 
 
 Station Elevation 
 465+77.00 773.8438 
 465+80.00 772.3540 
 465+90.00 767.3560 
 466+00.00 762.4142 
 466+07.44 758.7149 
 
Do a MicroStation reset to end the line.  Draw a second line for the other fill slope using the 
following values: 
 
 Station Elevation 
 466+55.20 758.9035 
 466+60.00 761.3367 
 466+70.00 766.4102 
 466+80.00 771.4865 
 466+85.00 774.0253 
 466+86.00 774.5334 

 
Close D & C Manager and Profile Generator. 

 

7. The lines plotted in the previous step are shown below.  The point of interest is where the 
solid fill slope line crosses the line parallel to the proposed alignment. 

 
 Beginning of Bridge End of Bridge 
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8. Use the Profile Labeler to find the station and elevation where the fill lines and EB-RT- SLP  
cross.  Profile Labeler is the fifth tool in the Plans Preparation toolbox shown below. 
 

   
 
Go to the Styles tab in Profile Labeler.  Open the Points folder and double click on the 
Sta/Elev .18 style in the Item Selector as shown in the following figure. 
 

 
Go to the Scale >> Change Scale pull down menu and make sure the Scale Style is set to 10. 
 
Switch to the Text tab and select the Data Point Location button indicated in the dialog box 
depicted below, snap to the intersection of the fill-slope line with the plotted profile and 
accept the snap. 
 

 
Click on the Place Label button and place the label. 
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9. Compare your intersection points to the values given below. 
 
 Location Station Elevation 
 Bent 1 465+76.69 774.00 
 Bent 4 466+85.79 774.42 
 
These station values can be used to determine the minimum distance from front face of end 
bent to front face of end bent along the right exterior girder.  Remember, however, that the 
stationing is measured along the chain, which is at the centerline of median.  This needs to be 
kept in mind when determining the actual bridge length. 
 
Save changes to the MicroStation drawing. 
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Exercise 14-4 

With the information from the previous two exercises, it is possible to layout the eastbound 
bridge.  This group exercise will use COGO to store and plot needed locations. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\plan_50_j5p0100.dgn.  
Attach as a reference t:\br-proj\a_geopak_\d5\j5p0100\data\plan_bh_j5p0100.dgn.  
Window in on the intersection of the two alignments so Route 50 stations 465+00 to 468+00 
are visible. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 
 
Switch the Working Alignment to Route50. 

 

3. Enter Coordinate Geometry. 
 
Go to Tools >> Locate >> On to bring up the dialog  
shown to the right.  It can be used to store a point on  
a curve, a spiral, or a chain.  Choose the On Chain  
option.  The Station option will be used to store points  
on chain ROUTE50. 
 
Store the points listed in the table below.  They are  
based on information obtained in Exercise 14-2 and  
locate where the fill slope intersects the profile  
EB-RT-SLP, which determines the minimum distance  
from the front face one end bent to the front face of the  
other end bent.  The stationing is for Route 50.  The  
dialog box for storing the first point is shown to the  
right. 

 
Location Pt. Name Station Offset 
Bent 1 Front Face EBRT1 465+76.69 63.8125 
Bent 4 Front Face EBRT4 466+85.79 63.8125 
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4. The location of the bents is based on layout lengths along the centerline of the eastbound 
lane.  Storing a chain at this location will ease the calculation of lengths along this line.  
Since this line is located 42’ to the right of chain ROUTE50, the store chain from offset 
chain command will be used.  The dialog for this command is located in the COGO menu 
Element > Chain > Store > From Offset Chain and is depicted below. 

 

 
 

Fill out the top of the dialog box as shown, select ROUTE50 as the Reference Chain, and 
press Apply.   

 

5. The skew of the bents is based on a radial line to Route 50 running through the intersection 
of the Route50 and BigHorn alignments so that the bents are roughly parallel to Big Horn Dr.  
Determine the angle between this radial line and Big Horn Dr. where it crosses Route 50 
chain by using the angle command: 
 
  ANGLE pa pb pi-pk, 
 
where the point numbers are used as defined in the figure  
and referenced to the job as follows: 
 
 pa  = PT BIGHORN-1  
 pb  = 10 (Point at alignment intersection) 
 pi  = CC ROUTE50-1 
 
Key in the COGO command: ANGLE PT BIGHORN-1 10 CC ROUTE50-1 
 

The returned value will be rounded to a right advance skew of 10° 49’. 
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6. Store two points (SK1 and SK2) to define the direction of the bents from left to right. 
 
Locate point SK2 at the intersection of the BIGHORN and EBL chains (Tools > 
Intersect). 
 
Locate point SK1 200’ from SK2 on a direction 10° 49’ to the left of a line from SK2 to 
the center of curve Route50-1 (Tools > Locate > Traverse).  The dialog box is shown 
below: 

  
 

7. Determine the minimum distance between centerlines of bearing at the end bents and point 
SK2 as measured along the centerline of the eastbound lane. 
 
To locate the points, use the intersect tool (Tools > Intersect) to project points EBRT1 and 
EBRT4 onto chain EBL using the direction from SK2 to SK1 with an offset of 15” (1.25’), 
which is one half of the with of the end bent beams.  Call the new points BT1 and BT4.  The 
COGO Key-in commands are: 
 
 LOCATE BT1 INTERSECT LINE EBRT1 SK2 TO SK1 OFF -1.2500 CHA EBL 
 
 LOCATE BT4 INTERSECT LINE EBRT4 SK2 TO SK1 OFF 1.2500 CHA EBL 
 
The dialogs for storing these points are shown on the following page. 

CC ROUTE50-1
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7. (Continued) 
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7. (Continued) 
To measure the distance along the EBL chain for the points BT1, SK2, and BT4, us the 
inverse command (Tools > Inverse), as shown in the following dialog.  Be sure to toggle on 
Distance Along Chain and enter chain EBL. 

 

 
 

The COGO output is: 
 

Point        X              Y         Station/Region  Offset  Distance 
-----  -------------- -------------- --------------- -------- -------- 
BT1    1,700,121.9709   999,252.1784    465+71.97  1   0.0000 
                                                               57.2216 
SK2    1,700,179.1964   999,247.5093    466+29.19  1   0.0000 
                                                               56.8846 
BT4    1,700,235.9706   999,243.9813    466+89.07  1   0.0000 
 
Consequently, the distance as measure along the centerline of the east bound lane between 
the centerline of Bent 1 and SK2 must be at least 57.23’, 56.89’ between SK2 and the 
centerline of the last bent, and 114.1’ for the whole bridge. 

 

8. Calculate the overall Design Layout Length for the bridge.   
 
Based on BM 3.55.3.1-3 (shown below), overall layout length for the bridge is: 

Σ (CL Bent to CL Bent) + 2 * (Be + 3 ½”). 
 

 
 

For this bridge Be = 5 ½” and Be + 3 ½” = 9” = 0.75’.  Thus, the minimum layout length: 
 

 for the whole bridge = 114.1’ + 2 (0.75’ = 114.1’ + 1.5’ = 115.6’ Use 116’ 
 from Bent 1 to SK2 = 57.23’ + (5 ½ + 3 ½)” = 57.23’ + (0.75’) = 57.98’ Use 58.0 
 from SK2 to Bent 4 = 56.89’ + (9)” = 56.89’ + 0.75’ = 57.64’ Use 58.0 
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9. Determine the layout length for each span. 
 
According BM 2.4.1-2, the minimum clearance between the front of the curb (offset of 18.5’) 
and Bents 2 and 3 needs to be 2.0’.  Assuming a maximum bent width of 3.5’, the offset for 
the centerlines of Bents 2 and 3 from the BigHorn chain needs to be at least 18.5’ + 2.0’ + 
3.5’/2 = 22.25’.  Use the intersect tool to store point BT2 at the intersection of chain EBL 
& chain BigHorn offset 22.25’ to the right and store point BT3 at the intersection of 
chain EBL & chain BigHorn offset 22.25’ to the left.  The dialog settings for storing the 
two points are shown below. 
 

      
 
Use the Inverse command to find the distance along chain EBL for points BT2, SK2, 
and BT3.  The results are: 
 
Point        X              Y         Station/Region  Offset  Distance 
-----  -------------- -------------- --------------- -------- -------- 
BT2    1,700,156.6040   999,249.2238    466+06.53  1   0.0000 
                                                               22.6575 
SK2    1,700,179.1964   999,247.5093    466+29.19  1   0.0000 
                                                               22.6243 
BT3    1,700,201.7685   999,245.9731    466+51.81  1   0.0000 
 
Rounding these values up to the nearest 0.5’, use the following layout lengths: Span 1-2 = 
35.0’ (58.0 – 23.0’), Span 2-3 = 46.0’ (23.0’ + 23.0’), and Span 3-4 = 35.0’ (58.0’ – 23.0’). 
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10. Determine the bridge’s tie station, which will be at  
Bent 2. 
 
Use Tools > Locate > Point on Curve to relocate  
point BT2 at the centerline of Bent 2 where it  
crosses chain EBL using one half of the length of  
span 2-3 from SK2.  The dialog is shown to the right. 
 
Use the Inverse tool to find the station and offset  
of point BT2 relative to chain Route50.  Since the  
inverse tool requires more than one point, some  
dummy points are included in the following dialog:  

 Base on the COGO 
output information 
shown below and 
rounding to the 
nearest tenth, the tie 
station is 466+04.6. 

 
Point        X              Y         Station/Region  Offset  Distance 
-----  -------------- -------------- --------------- -------- -------- 
BT2    1,700,156.2625   999,249.2511    466+04.65  1   42.0000 
 
Use Tools > Location > On to restore point BT2 at chain Route50 station 466+04.6 and 
a 42’ offset.  The dialog with the proper settings is:  
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11.   The intersection of the centerlines of the other bents  
with the centerline of the EBL can be located based  
on point BT2 and the span layout lengths.  Use  
Tools > Locate > Point on Curve to relocate points,  
BT1, BT3, and BT4 where the centerline for each  
bent crosses curve EBL1.  The distances along the  
curve are given in the following table.  The dialog for  
storing point BT1 is shown to the right. 

 
Point Dist. along EBL1 from tie Direction 
BT1 35’ - 0.75’ = 34.25’  + (clockwise) 
BT3 46.0’  - (counterclockwise) 
BT4 46’ + 35’ - 0.75’ = 80.25’  - (counterclockwise) 

 

12.  Check the location of Bents 1 and 4.  To do this, store two points where the front face of 
each end bent crosses the outside 
face of the right exterior girders 
(Route 50 offset 63.8125’, as 
determined in exercise 14-2) and 
compare the points to EBRT1 
and EBRT4.  Call the new points 
FACEBT1 and FACEBT4. 
 
Use Tools > Intersect to store 
the two points.  The dialog for 
storing EBRT5 is shown to the 
left.  (Note:  The 1.25’ offset 
accounts for ½ of the beam 
width.) 
 
Use Tools > Inverse to measure 
the distance along chain Route50 
for the following list of points:  
FACEBT1 EBRT1 EBRT4 
FACEBT4.  If the station values 
relative to Route 50 are all 
increasing, the location of the 
end bents is okay. 
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15.1 Objectives 

• Use Project Manager to create proposed cross-sections. 
• Understand what criteria files are and how Geopak uses them to define proposed 

cross-sections 
• Become familiar with MoDOT’s criteria library. 

15.2 Accessing 

Proposed cross-sections can be accessed from Project Manager >> Proposed Cross Sections.   

15.3 Dialog 

When the Proposed Cross Sections button in the Road Project Manager is pressed, the Select 
Run dialog is displayed.  An existing run may be selected or new run may be started.  When 
complete, press the OK button, which will close the Select Run dialog and open the proposed 
cross sections dialog as depicted below.  
 

 
 
The left side of the dialog contains the list of parameters required to process proposed cross 
sections.  When each parameter is selected, the dialog changes to reflect the requirement of each 
parameter.  For example, when Plot Parameters is selected, the dialog changes to reflect the 
various plot parameters and text as depicted on the next page.  
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15.3.1   XS DGN File 
XS DGN File controls the Microstation file in which the original ground cross-sections are 
located.  The proposed cross section elements will be placed into this file. 
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15.3.2 Pattern 
When Pattern is selected, the dialog changes to the illustration below.  This section contains 
information on how to find the pattern lines used to create the original ground cross-sections. 
 

 
 
Three dialogs (Pattern, Existing Ground, and Shapes) support a toggle to Use Working 
Alignment Definition.  For example, in the Pattern dialog above, the toggle is not active; 
therefore the user must supply all pattern information.  However, if the toggle is active when one 
of these three dialogs is invoked, the data information part of the dialog is ghosted and the 
required information is utilized from the current working alignment.  If the toggle is activated, 
and the required information is not stored within the current working alignment, an Alert 
message is displayed.  It is recommended to use the working alignment definition when this 
toggle is available. 
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15.3.3 Existing Ground 
Existing Ground section contains information to identify the symbology of the existing ground 
cross-sections.  The user toggles on the Search Criteria options needed to identify the existing 
ground, then selects the values for those options.  The Use Working Alignment Definition 
toggle is also available. 

 
 

15.3.4 Shapes 
When the Shapes parameter is selected, the dialog is displayed as depicted below. 
 

 
 
Three options are supported as depicted in the exploded view: 

• All in DGN - All shapes within the specified file are utilized. 
• By Search Criteria - Only those shapes that match the specified search parameters 

are utilized. 
• Shapeless - No shapes are utilized. In this option, there is no field for a shapes file 

name or files button. 
 
The Use Working Alignment toggle is also available. 
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15.3.5 Shape Clusters 
When the Shape Clusters parameter is selected, the dialog dynamically changes as depicted 
below. 
 

 
 
The user may Add, Delete, or Modify any specified shape clusters.  When the Scan button is 
pressed, Geopak scans the design file and uses the search criteria specified in the Shapes dialog 
to lists all matching shape clusters.  In the case of shapeless criteria, the user must define the 
cluster by typing in the Chain, Tie/PGL and Prof, then pressing the Add button. 
 

SIDE SLOPE CONDITIONS 
The Side Slope Conditions define what happens for each side of the shape cluster, and/or within 
a specified station range on the specified side of the shape cluster.  To define a side slope 
condition, choose the Define button.  The dialog box on the next page will open.  
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The user can choose Side Slope LT, Side Slope RT, or Offset Minus/Plus Side Slope LT/RT. 
 
Certain conditions such as Station > 5+000, or Median Width <= 7.2 can be set up to apply the 
side slope information if those conditions are met.  For example, the side slope condition Side 
Slope LT where Station >= 15+00 and Station <= 23+00 would apply the specified criteria files 
(criteria files are discussed later) to the left side of the shape cluster only between and including 
stations 15+00 and 23+00. 
 
It is important to remember that the side slope conditions pertain to the left or right side of the 
shape cluster, not the left or right side of the baseline. 
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CRITERIA FILE 
For each Side Slope Condition criteria files are added based upon the type of features to be 
drawn in the cross-sections.  Criteria files will be covered in Section 15.4. 
 

15.3.6 Define DGN Variables 
The Define DGN Variables option allows the user to define how to locate Microstation 
elements used by the criteria files.  Define DGN Variables can be determined from the element 
symbology, or from the symbology and attributes assigned in the D&C Manager database.  
MoDOT users do not need to define the DGN Variables.  These are defined within the criteria 
files. 
 

15.3.7 Define Variables 
Define Variables are variables that allow the user to enter job specific values for certain 
variables.  (I.e. pavement thickness, ditch width, backslope, etc.)  The user can select the variable 
from the list, then enter the value and select the Modify button.  The variables displayed will 
depend on the criteria files specified in the Shape Clusters section. 
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15.3.8 Plot Parameters 
Plot Parameters allow the user to determine how the data from the superelevation shapes are 
going to appear.  XS Lines determine the symbology of the pavement surface.  Text plots 
various pieces of text relating to the cross-section.  Plot allows the user to control different 
aspects relating to the cross-sections and criteria files.   
 

 
 
Pavement Thickness will plot a depth of pavement below the pavement surface.  MoDOT users 
should leave this value at 0.0.  The pvmt_layers.x criteria file should be used to draw the depth 
of pavement. 
 
Fill Gaps Between Clusters will draw a line between two shape clusters if the criteria does not 
fill between them. 
 
Transition Definition defines the use of superelevation parabolic transitions.  MoDOT users 
should use the ALL option. 
 
Intersect Between Clusters will extend or trim elements in a median to create a finished, clean 
appearance. 
 
Process Clusters as Indicated will force the criteria to process the clusters as they are listed in 
the Shape Clusters dialog.  If this option is turned off, the clusters will be processed left to right. 
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Remove Skew Effect will force Geopak to correct itself back to the pattern line if a skewed 
element is encountered in the processing of the criteria files. 
 
Process Only Sections With Existing Ground will process the proposed cross sections for only 
those cross section cells that have existing ground drawn. 

15.3.9 Drainage 
The Drainage section allows the user to draw the drainage components into the cross sections.  
The drainage .dgn file, and the drainage project database must be specified. 
 

15.3.10 File Menu 
Under Files, the options are Run, Save Settings, Export... and Exit.  To process 
the cross-sections, press the Run button, which invokes the Process Cross 
Section dialog.  Save Settings simply saves the current settings to the run, and 
can be recalled at a later time.  When the File > Export option is selected, the 
user may save the dialog information in an ASCII input file for subsequent 
processing.  The File > Exit option enables the user to exit the Proposed Cross 
Sections dialog box.  The software also prompts the user with an Alert box if the 

settings should be saved before exiting.  Pressing the Yes button will save the current dialog 
settings, No will not save the settings, but both buttons will exit to the Project Manager. 

15.3.11 Process Cross Sections 
When File >> Run is chosen, the dialog to the 
right appears.  
 
The output can be displayed on the screen only, or 
written to a log file and displayed to the screen.  
The Pause On Each Section option allows the 
user to view each section as it is drawn.  Criteria 
View displays each step in the criteria file.  This is 
primarily for debugging purposes. 
 

15.4 Criteria Files 

One of the most powerful and flexible features of GEOPAK is the use of criteria in generating 
proposed cross-sections.  Within criteria, design conditions can be evaluated and complicated 
design decisions executed in response to these design conditions.  The flexibility of criteria 
allows the designer to make the design as basic or as complex as the project requires.  Numerous 
baselines can interrelate as ditches and medians are drawn between roadways and ramps. 
Sophisticated drainage details can also be drawn with criteria.  The list is endless. 
  
Cross-section criteria are used to draw cross-section features outside of the mosaic of 
superelevation shapes typically representing pavement.  Operationally, the software constructs 
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the cross-section features derived from the mosaic of shapes first.  Then, the software constructs 
the remaining portions of the cross-section through the application of criteria emanating out from 
the outer edges of the mosaic of shapes.   
 
MoDOT users will not need to know how to write criteria.  A criteria library has been 
established, and continues to be expanded.  As users encounter situations that require a new 
criteria file, they should contact the CADD Support Center to have that criteria file written.  This 
will allow standardization within the criteria files, and allow the criteria library to grow so others 
can use these same files. 
 
Note: Criteria files written or modified outside of the CADD Support Center, and criteria writing 
WILL NOT BE SUPPORTED. 

15.4.1   MoDOT’s Criteria Library 
MoDOT’s criteria library is located in the directory t:\gpk_std\criteria.  Within the Shape 
Clusters section of the Proposed Cross Section dialog, the user can choose the Add button in 
the Criteria File portion of the dialog box.  The following dialog will appear. 
 

 
 
The user simply selects the criteria file to be included, and then clicks the To Criteria button.  
The criteria files must be listed in the order they are to be processed.  Once they are selected, 
they can be re-arranged within the Proposed Cross Sections dialog box.  (Other methods are 
being looked at for accessing criteria files.) 
 
With each run, the Setup.x criteria file must be chosen as the first criteria file in each side slope 
condition.  This file allows the user to choose the plotting scale and the files that are being used 
for the plan, shape, and cross-section information.  This data is required for other criteria files. 
 
The criteria files will have a short description to help identify what they will do.  The criteria file 
name will also give a basic idea of what the criteria file is.  For example, cg_b_c.x will draw a 
type B curb and gutter and cap the edge of pavement as concrete (vertical line).  The file 
cg_b_a.x will draw a type B curb and gutter and cap the edge of pavement as asphalt (on a 1:1 
slope).  Help documents will be available on the intranet for further information on the files in 
the criteria library.   
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Side Slope Left and Right Where Station <25+30.18 
setup.x 
pvmt_layers.x 
cg_b_a.x 
berm.x 
sideslope.x 
 
Side Slope Left and Right Where Station >= 25+30.18 
setup.x 
pvmt_layers.x 
shldr_c_a.x 
sideslope.x 
 
"UNITS (M=1 OR E=2)" 2                                                                
"NAME OF PLAN FILE" road1_plan_j2p0200.dgn  
"NAME OF CROSS-SECTION FILE" road1_xs_j2p0200.dgn  
"NAME OF SHAPE/PATTERN FILE" road1_pattern_shape_j2p0200.dgn    
"NAME OF BASELINE" road1 
"PLOTTING SCALE" 10  
"PLOT PGL ELEVATION YES = 1 NO = 0" 1  
"PAVEMENT LAYER 1 THICKNESS (MM OR IN)" 1.75  
"PAVEMENT LAYER 2 THICKNESS (MM OR IN)" 5  
"PAVEMENT LAYER 3 THICKNESS (MM OR IN)" 0.0  
"PAVEMENT LAYER 4 THICKNESS (MM OR IN)" 0.0  
"PAVEMENT LAYER 5 THICKNESS (MM OR IN)" 0.0  
"PAVEMENT LAYER 6 THICKNESS (MM OR IN)" 0.0  
"AGGREGATE LAYER 1 THICKNESS (MM OR IN)" 6  
"AGGREGATE LAYER 2 THICKNESS (MM OR IN)" 0.0  
"AGGREGATE LAYER 3 THICKNESS (MM OR IN)" 0.0  
"AGGREGATE LAYER 4 THICKNESS (MM OR IN)" 0.0  
"ROCK FILL BASE THICKNESS (M OR FT)" 0.0  
"UNDERGRADING THICKNESS (M OR FT)" 0.0  
"OVERBREAK THICKNESS (M OR FT)" 0.0  
"SHOULDER SLOPE (%)" 4.0  
"SHOULDER THICKNESS (MM OR IN)" 6  
"BERM WIDTH (M OR FT)" 4 
"BERM SLOPE (%)" 2.0  
"LEFT BERM WIDTH PROFILE" bermwdth  
"RIGHT BERM WIDTH PROFILE" bermwdth  
"FILL SLOPE 1 (1:X OR X:1)" 4  
"FILL SLOPE 2 (1:X OR X:1)" 2  
"FILL SLOPE 1 WIDTH (M OR FT)" 8  
"DITCH FORESLOPE (1:X OR X:1)" 4  
"DITCH BACK SLOPE (1:X OR X:1)" 3  
"DITCH DEPTH (M OR FT)" 2  
"DITCH WIDTH (M OR FT)" 8  
"DITCH PROFILE FORESLOPE 2 (1:X OR X:1)" 4  
"LEFT DITCH PROFILE" ditchlt  
"RIGHT DITCH PROFILE" ditchrt  
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Exercise 15-1 

This begins a series of exercises that will demonstrate another method for determining bridge 
length, which will by using cross-sections.  The proposed cross sections for Route50 are draw in 
this group exercie.  Later exercises will use these and other cross sections to create a proposed 
TIN and determine the bridge length from this surface model. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\xs_50_j5p0100.dgn.  

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 

 

3. Select the Route50 working alignment. 

 

4. Choose Proposed Cross Sections from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to Route50, and open the Route50 run. 
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5. Be sure the following items are set in the given sections of the dialog: 
 
XS DGN File: xs_50_j2p0200.dgn 
Pattern: Use Working Alignment Definition 
Existing Ground: Use Working Alignment Definition 
Shapes: Use Working Alignment Definition 

 

6. In the Shape Clusters section of the dialog, choose the Scan button.  Add the two shape 
clusters in the following order: 
 
 Chain Tie Profile 
 ROUTE50 -30 ROUTE50PR 
 ROUTE50 30 ROUTE50PR 
 
The clusters are added by highlighting a cluster in the top dialog shown below and clicking 
on Add in the Proposed Cross Sections dialog, which is depicted in the bottom figure.  When 
you are finished adding the Shape Clusters, close the List of Cluster dialog by clicking on 
Close at the bottom of the dialog.  Leave the Proposed Cross Sections – Route50 dialog 
open.  Information will be added to it in the next step. 
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7. For each shape cluster, add the given side Slope Conditions and Criteria Files.  (See the 
attached typical section for details.) 
 
 Chain Tie Profile Chain Tie Profile 
 ROUTE50 -30 ROUTE50PR ROUTE50 30 ROUTE50PR   

Side Slope: LT Side Slope: LT 
 Criteria Files: setup.x Criteria Files: setup.x 

 pvmt_layers.x  pvmt_layers.x 
 shldr_a_c.x  shldr_a1_c.x 
 sideslope.x  median_ditch.x   

Side Slope: RT Side Slope: RT 
 Criteria Files: setup.x Criteria Files: setup.x 

 pvmt_layers.x  pvmt_layers.x 
 shldr_a1_c.x  shldr_a_c.x 
 median_ditch.x  sideslope.x 

 
To add the Side Slope Conditions, highlight a shape cluster, and click on the Define button 
under that section of the Proposed Cross Section dialog. 

 

 
 

This will bring up the following dialog, which lets you define each condition.  Once the 
condition is set, click OK in the dialog to add it to the list of Side Slope Conditions. 
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 Once the Side Slope Conditions are defined, save the Proposed Cross Sections settings by 
going to Files > Save Settings, as shown in the following figure. 

 

 
 

Add the Criteria Files to each condition by highlighting one of the conditions and clicking on 
the Add button at the bottom of the Criteria File list. 

 

 
 

This brings up the Criteria dialog shown below.  Criteria files are added to the highlighted 
side slope condition by selecting a criteria file of the list and clicking on To Criteria. 

 

 
 

Select the Setup.x criteria file, as shown above, and add it to the selected condition by 
clicking on To Criteria.  Since this file is used in all conditions, highlight the other condition 
for the shape cluster and clicking on To Criteria.  Do the same thing for the other shape 
cluster.  Add pvmt_layers.x (which is the top file shown in the above figure) to all 
conditions and clusters.  Add the criteria files shldr_a_c.x, shldr_a1_c.x, sideslope.x, and 
median_ditch.x to the appropriate side slope conditions.    
 
Once all of the files have been added, click on Done to close the Criteria dialog and save the 
Proposed Cross Section run by going to Files > Save Settings. 
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8. Switch to the Define Variables section of Proposed Cross Sections, as shown below: 
 

 
 

Set the following variable values. 
 
NAME OF PLAN FILE.........................................................plan_J5P0100.dgn 
NAME OF CROSS-SECTION FILE ....................................xs_50_J5P0100.dgn 
NAME OF SHAPE/PATTERN FILE ...................................pattern_shape_J5P0100.dgn 
NAME OF BASELINE ........................................................Route50 
PAVEMENT LAYER 1 THICKNESS (MM OR IN)...........10 
AGGREGATE LAYER 1 THICKNESS (MM OR IN) ........4 
 
Leave the remaining variables set to the defaults. 

 

9. Save the settings for the run. 

 
 

10. Run the proposed cross-sections (Files > Run).  The following dialog will appear: 
 

 
 

Set the Log File to Screen Only. 
 
Turn on Pause on Each Section. 
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Chapter 16 Port Viewer 

16.1 Objectives 

• Learn how to use Geopak’s Port Viewer utility. 
 

16.2 Definitions 
The Port Viewer is a tool that enables the user to view and manipulate all three major aspects of 
a road design simultaneously, even though they are located in different files.  These include: 
 

• Plan  
• Profile 
• Cross-sections 
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16.3 Accessing 
Prior to starting the Port Viewer the working alignment must be set up to include the plan view 
drawing file, centerline chain, profile view file, profile name and location, and cross-section 
view file. 
 
To access the Port Viewer, choose the Port Viewer button from the Project Manager dialog. 

16.4 Dialog 

 

The Port Viewer dialog box allows the user to manipulate the views 
several different ways.  
 
The user is able to key-in the Station they want to view.  The cross hairs 
in the plan and profile views will move to the keyed-in station, and the 
section view will display the cross-section nearest that station. 
 
The navigation buttons allow the user to navigate station by station (< or 
>), or to the beginning (<<) or ending (>>) station. 
 
The Offset option will control the location of the circle in the plan view 
and the vertical cross hair in the cross-section view. 
 

The Elevation option will control the location of the horizontal cross hairs in the profile and 
cross-section views. 
 
If the Portview TIN is defined in the Working Alignment definition, the DTM 
view can be substituted for the cross-section view.  The DTM view will cut a 
section at the location of the cross hairs in the plan view.  

The Active View chooses the view to change the current file.  Any 
Microstation drawing commands will be executed in the Active View.  If 
the user wants to draw something in the cross sections, they should switch 
the Active View to XS View. 

 
Selecting the Set button allows the user to move the cursor to a view and move the cross hairs.  
As the user moves the cursor along the view, the other two views will be updated according to 
the placement of the cursor in the current view. 
 
The DP button allows the user to issue a data point for a Microstation command.  For example, if 
the user wanted to draw a line at the given station and offset listed in the Port Viewer dialog, 
they would select the line tool, and press the DP button.  This would begin drawing a line at the 
given station and offset. 
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The View menu at the top of the dialog box allows the user to fit one or all of the views, or to 
select the Active View.   
 

   
 
The Options menu controls which cross hairs to display, as well as the symbology of the DTM 
section view. 
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17.1 Objectives 

• Learn the procedures for calculating earthwork quantities with GEOPAK 
• Learn how to use Project Manager to set up and process an earthwork run. 

17.2 Definitions 

GEOPAK forms earthwork shapes in a design cross section .dgn file to represent the end areas 
used to calculate volumes.  These shapes are created when the designer processes an earthwork 
run in which the existing ground, finished grade, base, etc. are identified by level, color, weight 
and type.  For complete information, see the GEOPAK Manual or online help. 

17.3 Accessing 

To access the necessary dialogs needed to create and process an earthwork run, select Project 
Manager >> Earthwork.   

17.4 Dialog 

Once the Earthwork run is chosen, the following dialog box appears.  
 

 
 
The left side of the dialog contains the list of parameters required to compute earthwork.  When 
each parameter is selected, the dialog changes the keyin fields to reflect the selection.  For 
example, when EW Shapes is selected, the dialog changes as illustrated below. 
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17.4.1   XS DGN File 
In XS DGN File the user can specify the file name in which to find the cross-sections.   
 

 
 
Tolerance specifies the maximum distances between two elements to be considered as 
adjoining.   
 
Vertical Search Distance specifies the distance above and below the cross-section to look for 
elements pertaining to that cross-section.  (DO NOT CHANGE!)   
 
Baseline specifies the Geopak COGO chain the cross-sections are based from.   
 
Begin/End Station specifies the beginning and ending stations to perform the earthwork 
calculations. 
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17.4.2   Soil Types 
The Soil Types dialog requires the user to define the symbology and shrinkage/swell factors to 
be used in defining each soil type.   
 

 
 
The user must first select the Class of the soil type.  The 
classifications are as follows.  
 
Existing Ground – identifies the surface of the existing ground.  
This classification is required to calculate earthwork. 
 
Existing Suitable – identifies material that is to be removed, but can be used for fill material.  
(I.e. rock) 
 
Existing Unsuitable – identifies material that is to be removed, but cannot be used for fill 
material.  (I.e. shale, muck, pavement, etc.) 
 
Proposed Finish Grade – identifies the surface of the proposed roadway.  This classification is 
required to calculate earthwork. 
 
Proposed Undercut – identifies proposed layers that are not part of the finish grade.  This soil 
type is not the material being removed, but what the area will be backfilled with.  (I.e. rock 
blanket) 
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Excavation Limit –identifies the location to stop removing the existing suitable or unsuitable 
material.  Excavation limits can also be used to separate the areas of earthwork calculations for 
staged construction, multiple roadway cross sections, etc. 
 
Once the Classification is chosen, a Soil Type, the element symbology of the material, and the 
shrinkage/swell factors need to be entered.  A Classification, except Existing Ground, can be 
listed multiple times.  The Soil Type determines how the cut and fill are calculated.  For 
example, a user creates an earthwork run with a classification of Existing Ground with a soil type 
of Existing, classification of Proposed Finish Grade with a soil type of Suitable_Grading, and a 
classification of Proposed Undercut with a soil type of Pavement.  The output from the run 
would look as follows. 
 

Material Name  End Areas  Unadjusted  Adjusted  Mult Mass 
Station       Volumes  Volumes  Factor Ordinate 

(square  (cubic  (cubic                    
feet)  yards)  yards)                  

-------------------------------------------------------------------------------------------------------------------------------------------------------- 
449+00.00  SUITABLE_GRADING 

Excavation       0.00      0      0  1.00 
Fill   132.61  439  439  1.00 2887 

PAVEMENT 
Excavation      0.00      0      0  1.00 
Fill  315.81  960      0  0.00 2887 

EXISTING 
Excavation 278.57  855  855  1.00 
Fill      0.00      0      0  1.00 3541 

 
In the same example, if both classifications of Existing Ground and Proposed Finish Grade had 
the soil type of Suitable_Grading, then the output would look as follows. 
 

Material Name  End Areas Unadjusted  Adjusted  Mult Mass 
Station       Volumes  Volumes  Factor Ordinate 

(square  (cubic  (cubic                    
meters)  meters)  meters)                  

---------------------------------------------------------------------------------------------------------------------------------------------------------- 
449+00.00  SUITABLE_GRADING 

Excavation 278.57  855  855  1.00 
Fill  132.61  439  439  1.00 3541 

PAVEMENT 
Excavation       0.00      0      0  1.00 
Fill  315.81  960      0  0.00 3541 

 
As can be seen from the above examples, when the soil types for the Existing Ground and 
Proposed Finish Grade classifications were named differently, both soil types appeared in the 
output.  When the soil types for the Existing Ground and Proposed Finish Grade classifications 
were named the same, the quantities for each classification were combined into one soil type.  By 
paying close attention to the soil types, the user can specify exactly where a specific soil type 
should be placed. 
 
Once the Classification and Soil Type are chosen, the user can select the Element Symbology 
to define that particular Soil Type and the Multiplication Factors for the Soil Type.  The 
Match button can be used to select the Element Symbology.  Once the Match button is 
selected, the user can select the elements in the Microstation view.  The symbology of that 
element will be added to the list of symbologies to be used to define the Soil Type. 
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After the user selects the soil type symbologies, the Add button needs to be selected to add this 
soil type to the Soil Type Items list.  The items in this list can be modified or deleted by 
selecting the soil type item, making the changes, then selecting the Modify or Delete buttons. 

17.4.3   EW Shapes 
EW Shapes allows the earthwork shapes to be drawn and specifies the symbology to draw them 
with.  The colors of the earthwork shapes can be stratified, so that each soil type is a different 
color. 
 

 
 

17.4.4   Output Format 
Output Format allows the user to specify which items to show in the earthwork report.  As the 
<> buttons are pressed, the Common Excavation, Subgrade Excavation, and Subsoil Excavation 
are combined into a single quantity. 
 

 
 
Common Excavation volumes are not backfilled with an earthwork material.  This includes the 
excavation required for cut sections as well as for pavement thickness, shoulder thickness, etc. 
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Subgrade excavation volumes are backfilled with an earthwork material. 
 
Subsoil excavation - excavation required to remove unsuitable material down to the bottom of 
the proposed template. 
 
Accum Adjust Volume Column will add a column to the earthwork quantities report to show 
the accumulated adjusted volume.  This provides a running total for the adjusted volumes. 
 
Accum Unadjust Volume Column will add a column to the earthwork quantities report to show 
the accumulated unadjusted volume.  This provides a running total for the unadjusted volumes. 
 
Calc Only Between Exc Limits will calculate the earthwork only between the excavation limit 
lines as specified in the Soil Types section.  This can be used to calculate earthwork quantities 
for staged construction, individual roadbeds in a multiple roadbed section, etc. 
 
End Area Dec Places sets the number of decimal places to display in the earthwork quantities 
report. 

17.4.5   Add/Sub Vol 
Add/Sub Volumes allows the user to enter positive or negative add volumes.  The user can 
specify whether to add excavation or fill, the soil type, the station, and the volume to be added. 
 

 
 

17.4.6   Centroid Adj 
Centroid Adjustment allows the user to use the measurement between the centroids of the 
endarea as the distance between sections instead of the centerline distance.  MoDOT does not use 
the Centroid Adjustment method of calculating endarea volumes except in areas where there 
are extremely deep cuts or high fills. 
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17.4.7   Skip Areas 
Skip Areas allows a user to specify an area (i.e. bridge exception) in which to not calculate 
earthwork volumes.  The user needs to specify the Begin Station and End Station of the Skip 
Area. 
 

 
 

17.4.8   Sheet Quant. 
Sheet Quantities allows a user to write an earthwork quantity file to be used when plotting the 
cross-section sheets. 
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The name of the ASCII file can be chosen or entered.  The user then selects the columns in 
which to place the quantity, the number of decimal places, the total column width, the soil type, 
the earthwork operation, and the type of quantity. 
 
For MoDOT, the cross section sheets are set up to plot the information in the proper location on 
the cross section sheets, the quantities should be set up as follows. 
 

Column Soil Type EW Operation  Quantity Type  +/- 
 1  ClassA  Common Exc  Endarea  + 
 1  ClassA  Subgrade Exc  Endarea  + 
 1  ClassA  Subsoil Exc  Endarea  + 
 2  ClassA  Fill   Endarea  + 
 3  ClassA  Common Exc  Unadjusted Volumes + 
 3  ClassA  Subgrade Exc  Unadjusted Volumes + 
 3  ClassA  Subsoil Exc  Unadjusted Volumes + 
 4  ClassA  Fill   Unadjusted Volumes + 
 
If Class C quantities are being shown on the cross section sheets, the following columns should 
be added. 
 

Column Soil Type EW Operation  Quantity Type  +/- 
 5  ClassC  Common Exc  Endarea  + 
 5  ClassC  Subgrade Exc  Endarea  + 
 5  ClassC  Subsoil Exc  Endarea  + 
 6  ClassC  Common Exc  Unadjusted Volumes + 
 6  ClassC  Subgrade Exc  Unadjusted Volumes + 
 6  ClassC  Subsoil Exc  Unadjusted Volumes + 
 
This information is written to the ASCII file, and can be used to plot the quantities on the cross-
section sheets.  The process of plotting this data on the cross section sheets is covered in more 
detail in Chapter 14. 

17.4.9   File Menu 
From the Files menu, the Run option will process all parameters that have been 
set in the Earthwork dialog box.  The Save Settings option will save all 
information in the Earthwork dialog box.  The Export option will allow the u
to save the parameters in the Earthwork dialog box as an ASCII input file.  The 
Exit option will exit the Earthwork dialog box. 

ser 

 

17.4.10    Process Cross Sections 
After all necessary information has been entered the user has two options.  The preferred method 
of running the earthwork is to select the Run option. The following dialog box will appear and 
the user may proceed by entering a log file name, choosing the Pause On Each Section option 
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and then selecting the Apply button.  The second method is to export the information as an 
ASCII input file, then use the Process Cross Sections tool.  
 

 
 
When processing the earthwork quantities, a .log file should be created.  This ASCII file will 
contain the earthwork quantities that the user will use to evaluate the earthwork. 
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Exercise 17-1 

This group exercise calculates the Class 1 and Class 2 excavation for Bents 3 & 4 of one of the 
Route 6 bridges.  The bents are spread footings on rock. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\xs_j2p0300.dgn. 
 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj. 
 

Enter the project as user userc and go into Road. 
 

3. Copy the Rte6 working alignment to Bents and enter that working alignment. 
 

 
 

4. Set the XS DGN File in the Working Alignment Definition (Under Cross Section View) to: 
xs_j2p0300.dgn, as shown in the following figure. 
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5. The figure from the Bridge Manual on the previous page shows the Class 1 & 2 excavation 
for footings in a streambed.  As noted there, Class 1 excavation covers all material above the 
excavation datum, and Class 2 is for all excavation below the datum.  Also, since the bents 
have footings on rock, the *** dimension in the figure is 6” (0.5’). 

 
The following figure shows a typical cross section for Bents 3 & 4.  The spacing and size of 
the square footings is the same for both bents, as is the excavation datum.  Only the elevation 
at the bottom of the footings varies from one bent to the next. 

 
 Based on these figures, excavation will extend out from the footings on all sides by 1.5’ (18”) 

and stop 0.5’ above the bottom of the footing in this extended area.  Directly under the 
footings, the excavation goes to the bottom of footing elevation.  Cross sections starting 1.5’ 
before each footing and ending 1.5’ after the end of each one have already been created in the 
MicroStation file.  The sections for Bent 3 go from Sta. 1294+33.375 thru Sta. 1294+45.375, 
while the sections for Bent 4 go from 1295+31.375 thru 1243+43.375. 

 
Cross sections of the footings have been added to each of the cross sections at the correct 
elevation.  Only the bottom of footing line has been added for the sections before and after 
the footing  The excavation limits have also been added using a line drawn on level 60 using 
color 22.  This limit line stops 6” above the bottom of footing at Stations 1294+33.375, 
1294+34.855, 1294+43.905, & 1294+45.375 for Bent 3 and Stations 1295+31.375, 
1295+32.855, 1295+41.905, & 1295+43.375 for Bent 4.  The limit traces the bottom of the 
footing at all of the other sections.   

 
The excavation datum has been draw in all cross sections at elevation 771.6 using a line on 
level 57 and color 0.  The earthwork run will be set up using these drawn elements plus the 
existing ground line on level 57 and color 90. 
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6. Choose Earthwork from the Road Project dialog. 
 

 
 

Copy the MoDOT run to Bent3, and enter the run. 
 

 
 

7. In the XS DGN File section of the Earthwork dialog, set the following items: 
 
 Begin Station First Cross Section Station  
 End Station 1295+00 R 1 
 
The XS DGN File and Baseline have already been set by the Working Alignment Definition.   
The rest of the values are defaults, which do not need to be modified. 
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8. In the Soil Types section, created the following Soil Type Items:  
 
 Class Soil Type Level Colors 
 Existing Ground Class2 57 90 
 Existing Suitable Class1 57 0 
 Proposed Finish Grade Class1 60 22 
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9. Switch to the Output Format section of Earthwork and set the format to Excavation and 
Fill only, as shown below: 
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10. In the Sheet Quant. Section, toggle on the Write Sheet Quantities File. 
 

ASCII file:   bent3.txt 
 Decimal Places:   0 

Total Quantity Length  15 
 

 Col. Soil Type EW Operation Quantity Type +/- 
 1 Class1 Common Exec End Area + 
 1 Class1 Subgrade Exec End Area + 
 1 Class1 Subsoil Exec End Area + 
 2 Class1 Fill End Area + 
 3 Class1 Common Exec Unadjusted Volumes + 
 3 Class1 Subgrade Exec Unadjusted Volumes + 
 3 Class1 Subsoil Exec Unadjusted Volumes + 
 4 Class1 Fill Unadjusted Volumes + 
 5 Class2 Common Exec End Area + 
 5 Class2 Subgrade Exec End Area + 
 5 Class2 Subsoil Exec End Area + 
 6 Class2 Common Exec Unadjusted Volumes + 
 6 Class2 Subgrade Exec Unadjusted Volumes + 
 6 Class2 Subsoil Exec Unadjusted Volumes + 

 

 
 

11. Save the settings for the run (Files > Save Settings).   
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12. Run the earthwork run (Files > Run).  The following dialog will appear: 
 

 
 

Set the Log File to bent3.log. 

 

13. Repeat the process for Bent 4, by going back into Earthwork.  This time however, copy the 
Bent3 run and name it Bent4.  Go into the new run.  By copying the Bent3 run, everything is 
already set except for the station range and the name of the Sheet Quantity file. 

 

14. Under XS DGN File, change the station range to the following: 
 
 Begin Station 1295+00 R 1  
 End Station Last Cross Section Station 
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15. In the Sheet Quant. section, name the file bent4.txt. 
 

 
 

16. Save the settings for the run (Files > Save Settings).   

 

17. Run the earthwork run (Files > Run).  The following dialog will appear: 
 

 
 

Set the Log File to bent4.log. 
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18. Open D&C Manager, and use the Earthwork Text File Labels 3PC Tool to set up the cross 
section sheet labels as shown below: 

 

 
 

19. Repeat the last step for Bent 4: 
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18.1 Objectives 

• Learn the procedures for laying out cross-section sheets. 

18.2 Accessing 

Prior to beginning the cross-section sheet layout process, the user will need to create a cross-
section sheet file.  There are six seed files the user can choose from when setting up the cross-
section sheet file: i_xs_shts_5.dgn, i_xs_shts_10.dgn, i_xs_shts_20.dgn, m_xs_shts_100.dgn, 
m_xs_shts_200.dgn, and m_xs_shts_50.dgn.  The user should choose the seed file that represents 
the scale the cross-sections will be plotted at. 
 
To access the necessary dialogs needed to process the cross-section sheet layout, select Project 
Manager >> Cross Section Sheets.  The run should be chosen according to the scale that the 
cross-sections will be plotted at.  
 

 
 
Once the run is chosen, the dialog box shown below appears.   
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18.3 Dialog 

 
 
The left side of the dialog contains the list of parameters required to draw the cross section 
sheets.  When each parameter is selected, the dialog changes the key-in fields to reflect the 
selection. 
 
Most of the parameters should be left alone.  They are setup by the CADD Support Center, and 
are correct for the given scales.  Listed below are the items the user will need to change. 

18.3.1   XS DGN 
XS DGN defines the file in which the cross-sections are located, the baseline chain, and the 
station limits. 
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18.3.2   Earthwork Quantities 
Earthwork Quantities allows the user define the ASCII file that contains the earthwork quantity 
information, as well as toggle on/off the plotting of the earthwork quantities.  If the Sheet 
Quantities portion of the earthwork run was not changed, the user should not change anything 
else in this dialog. 
 

 

2/11/02 Missouri Department of Transportation 18-3 



Chapter 18 Cross Section Sheets 

18.3.3   Sheet DGN File 
The Sheet DGN File specifies which file the cross-section sheets will be placed in.  (Currently, 
the path to the Sheet DGN File including the file name is limited to 40 characters.  By using the 
working directory, the user can specify only the file name in the Sheet DGN File field to increase 
the length of the file name.)   
 
The Horizontal and Vertical Scales should be left at 1.0 regardless of what scale is being 
plotted.  The Reference Data Point coordinate should be left at 0, 0. 
 

 
 

18.3.4   Add Elevations 
Using the toggles Add Top Elevation and Add Bottom Elevation located in the Add 
Elevations section, the user can plot the elevation above and/or below the cross section 
elements. 
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18.3.5   Files Menu 
 From the Files menu, the Run option will process all parameters that have been 
set in the Cross Section Sheets dialog box.  The Save Settings option will save 
all information in the Cross Sections Sheets dialog box.  The Export option w
allow the user to save the parameters in the Cross Section Sheets dialog box a
an ASCII input file.  The Exit option will exit the Cross Sections Sheets dialog 
box. 

ill 
s 

 

18.3.6   Process Cross Sections 
Once the dialog box is complete, the user can select File >> Run and the following dialog box 
will appear. 
 

 
 
The user can display the results to the screen only, or write them to a log file.  Once the Apply 
button is selected, the cross-sections will be plotted in sheet format. 
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Exercise 18-1 

1. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\xs_j2p0300.dgn. 
 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj. 
 

Enter the project as user userc and go into Road. 
 

3. Select the Bents working alignment. 
 

4. Choose Cross Section Sheets from the Project Manager dialog. 
 

 
 

Copy the I_XS_10 run to Bent3. 

 
 Open the Bent3 run. 
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5. Create a new MicroStation file.  Name the file xs_bent3_sheets.dgn, and put the file in the 
directory t:\ br-proj\a_geopak\d2\j2p0300\data \.  Use the seed file 
t:\standard\wsmod\design\seed-i\i_xs_shts_10.dgn. 

 

6. Be sure the following items are set in the XS DGN File section of the dialog: 
 
 XS DGN File xs_j2p0300.dgn 
 Chain RTE6 
 Begin Station First Cross Section Station 
 End Station 1295+00 R 1 
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7. In the Earthwork Quantities section, turn on the Earthwork Quant. Define option, and 
choose the ASCII file of bent .txt. 

 

 
 

8. Select the Sheet DGN File to be the file xs_bent3_sheets.dgn created in step 5: 
 

 
 

9. Save the settings for the run (Files > Save Settings).   
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10. Run the proposed cross-sections. 
 

Set the Log File to Screen Only. 
 

 
 

11. Repeat the process for Bent 4, by going back into Cross Section Sheets.  This time however, 
copy the Bent3 run and name it Bent4.  Go into the new run.  By copying the Bent3 run, 
everything is already set except for the station range and the name of the files.  Use names 
relevant to Bent 4.  The earthwork quantities file is bent4-labels.txt, for instance. 
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19.1 Objectives 

• Create various cross section reports: 
- for plan use (design elements and quantities) 
- as input for other programs and/or applications of GEOPAK 
- for construction layouts 

• Create and plot construction limits in the plan view. 

19.2 XS Reports Definitions 

The GEOPAK Cross Section Report Utility can extract up to sixteen different reports from 
original and design cross-sections.  For each report generated, the user must set the parameters of 
the existing and/or design cross sections.  GEOPAK also provides an option to make custom 
headers for each of the reports via the User pull down menu. 

19.3 XS Reports Accessing 

To access the XS Report select Project Manager >> Reports & XS 
Quantities.  

19.4 XS Reports Dialog 

From the XS Report dialog box select User >> 
Preferences; a Report Header dialog box will 
appear with all options ghosted out.  To activate 
the individual fields simply toggle on the box next 

to the desired field.  Once you have completed the dialog box, the 
information will be saved as an .hdr file.  This allows for the creation of a
separate header for each type of report.  The tolerance field determines 
the maximum gap allowed between cross section elements.   
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19.5 Reports 

Blue and Red Top 
Based on the dialog box settings, GEOPAK determines the offset and elevation of a slope and its 
breakpoints.  Blue refers to the top of pavement and Red is the top of subgrade.  The user must 
determine this by indicating the level, color, weight and style for each surface. 

Clearing 
The Clearing Report is useful for obtaining clearing and grubbing quantities.  For each station, 
GEOPAK will list the clearing distance on each side of the chain and the width of any exception.  
You can obtain the results in meters squared and/or hectares.  Toggle boxes for Cut Slope 
Rounding, Additional Clearing in Cut and Fill, and Minimum Clearing Width are provided for 
increased control over the output. 
 
GEOPAK can also generate quantity sub-totals based on the value specified in Sub Every. 
 
To use the Except Width option, you must have an existing ASCII file that includes the 
Beginning and Ending Station and Exception Width. 
 
Once everything is set, you can output the information to an ASCII file 

Closure 
The Closure Report provides information on the intersection point between the user defined 
proposed finish grade and existing ground.  In addition to the ASCII report, the designer may 
instruct GEOPAK to close any gap either by drawing a vertical line between the endpoint of the 
proposed finish element and the existing ground or extending the slope of the last proposed 
element to intersect existing ground.  The procedure will not extend existing ground.  The 
Closure Report can be accessed within any Microstation cross section file by selecting Closure 
from the main XS Reports dialog 

DTM Input 
This process generates XYZ coordinates from cross section elements and places this information 
into an ASCII file for use in Geopak’s DTM package.  To use this dialog box simply enter the 
.gpk job number, chain name and station range.  GEOPAK will read the cross section elements 
based on level, weight, color and style. 

 DTM Proposed 3D 
This report is similar to DTM Input except that you can set both original and proposed cross 
sections at the same time.  This report also differs in that it makes breaklines across the cross 
sections.  This report is mainly useful when making 3-D cross sections for modeling purposes. 

19-2 Missouri Department of Transportation 2/11/02 



Chapter 19 XS Reports & Limits of Construction 

HEC-2 
This process reads cross section elements and formats the information in an ASCII text file 
suitable for use in the HEC-2 hydraulic program. 

 HEC RAS 
This process reads cross section elements and formats the information in an ASCII text file 
suitable for use in the HEC RAS hydraulic program. 

Multi-Line 
This report is useful in creating cross-sections for staged construction.  Begin by entering the job 
number, chain name and station limits.  Primary cross section element parameters must be 
completed before secondary element parameters.  This is important due to the order in which 
GEOPAK reads the information.  Once all the parameters have been entered, the new cross 
sections may be drawn to the design file or you may choose the display only option.  An ASCII 
text file will be generated. 

Profile Grade 
The Profile Grade Report is one of the most versatile reports available.  It prints existing 
ground and design grade elevations and low point elevations for each cross section.  
Additionally, this report has the ability to create horizontal and vertical alignments along the low 
points and store them directly into the .gpk.  Horizontal alignments created from this report will 
start with station 0+000 and have no curves. 

Radial Staking 
The Radial Staking Report is a specialized report created for the U.S. Federal Highway 
Administration (FHWA). 

 RT 40 
The RT 40 Report produces RDS based RT40 data.  To use this dialog box simply fill in the job 
chain name, stationing range and the parameters of the cross section elements you wish to use. 

Seeding 
Other than the usual entries, the user must enter the parameters of the elements to be seeded. 
 
This dialog box includes slope and subtotal options as well as a way to limit the number of 
segments read (By-Pass Segments).  The user may also establish additional seeding 
specifications (Additional Distance). 
 
Once all of the settings are complete, the report is written to an ASCII output file for use in plan 
quantities.  
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Slope Stake 
The Slope Stake Report is a special format report developed for the FHWA.  This report 
generates offsets, elevations and superelevation information for each cross section.  To generate 
this report fill in the usual cross section parameters plus Subgrade and Hub Staking information. 
When complete, push Apply and the report is written into an ASCII file. 

 Staking Detail 
The Staking Detail Report determines the tie down point between the proposed finished grade 
and the existing ground.  GEOPAK will list the right and left offset, elevation, slope of the finish 
grade and superelevation rate for each cross section.  To create this report, fill in the project 
information and desired cross section elements’ parameters.  Once complete, you have the choice 
between two formats, a FHWA ASCII report or a Montana DOT report (includes ditch 
elevations). 

WSPRO 
This report takes the cross section elements and turns them into an ASCII file in the WSPRO 
format for use as input in the WSPRO hydraulic analysis program. 

 XS List 
This report creates a listing of elevations and offsets for each cross section element according to 
user defined parameters.  You have the option of creating either an original cross section list or a 
design cross section list.  These reports are very similar to RDS cross section lists. 
 
Note: For more information on the various reports and the dialogs, see the Geopak manual 
or the online help. 
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19.6 Accessing Limits of C

ss the Limits of Co

onstruction 

To acce nstruction 

run 

 
 

19.7 Processing Limits of Construction 

 
ll 

he Parameters button opens the dialog box 

s 

he Place Construction Limit toggle allows the 

rs 

 for 

dialog, go to Project Manager >> 
Limits of Construction.  After the 
is chosen, the following dialog opens.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

The user can specify the .gpk job number, the 
centerline, and the file containing the plan view
information.  The Working Alignment should fi
the Existing Ground and the Proposed Finish 
Grade sections.   
 
T
below.  The symbology for the cut, fill, and 
transition construction limits can be set in thi
dialog.  
 
T
user to place various text strings along the 
construction limits.  Selecting the Paramete
button, and making the desired changes in the 
dialog box shown below will set the symbology
these text strings. 
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The Radius of Display field is the size of the 
display circle when Geopak is scanning the cross-
sections. The last option in the main Limits of 
Construction dialog is the Tie Down Option.  
There are two Tie Down Options.  If the All Tie 
Down option is set, all tie downs within a section 
are plotted.  (I.e. wide medians, outer roadways, 
ramps, etc. may have tie downs in between the 
limits of the main roadway, and the outer roadway 
or ramp.)  If the Outer Tie Down option is 
selected, then only the outmost tie downs are 
plotted.   
 
Once the Apply button is chosen, the limits of 
construction and the optional text are drawn into 
the plan view file. 
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Exercise 19-1 

1. Open the MicroStation file:  
 t:\br-proj\a_geopak\d2\j2p0300\data\pattern_shape_j2p0300.dgn. 
The yellow lines on level 22 will be used as pattern lines for cross sections for hydraulic 
analysis.  A GEOPAK XS Report will be created, which can be imported into HEC RAS. 

 

2. Open the project t:\br-proj\a_geopak\d2\j2p0300\project\j2p0300.prj. 
 

Enter the project as user userc and go into Road. 
 

3. Copy the J2P0300 working alignment to Water and enter that working alignment. 
 

4. Enter the Working Alignment Definition for Water and change the following: 
 

Section Item Value 
Plan View Chain: WATER 
Pattern Design File: pattern_shape_j2p0300.dgn 
 Levels 22 
 Weights 2 
 Colors 20 

 

5. Open the MicroStation file t:\br-proj\a_geopak\d2\j2p0300\data\xs_water_j2p0300.dgn. 
 

6. Choose Existing Ground Cross Sections from the Project Manager dialog. 
 

Copy the MoDOT run to Water and enter that run.  Set the XS Cells tab as shown below 
and have the J2P0300.TIN as the only one listed under the Surfaces tab. 

 

   

Select Draw to draw the cross section and Save the MicroStation file. 
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7. Set xs_water_j2p0300.dgn as the XS DGN in the Cross Section View section of the Water 
Working Alignment Definition as shown below. 

 

 
 

8. Choose Reports and XS Quantities from the Project Manager dialog. 
 

  
 

This will bring up the XS Report dialog shown to the right.  Select the  
HEC RAS report. 

 
The dialog shown below will appear.  Enter the information as shown: 

 

  
 

Select Apply to generate the report. 
 
The report will be written to the working directory.  Open the report  
in Ultra Edit.  It is: 
 
t:\br-proj\a_geopak\d2\j2p0300\data\HEC.geo. 

 
To import the data into HEC RAS, start the HEC RAS project and go to  
Edit > Geometric Data… in HEC RAS.  In the Geometric Data dialog,  
go to File > Import Geometry Data > GIS Format… and load the HEC.geo report. 
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Exercise 19-2 

This is the second in a series of exercise that will demonstrate using cross-sections to determine 
bridge length.  The group exercise makes use of the proposed cross-sections for Route50 that 
were drawn in Exercise 15-1.  In this exercise, a XS Report is used to create a new TIN, which 
will serve as the surface model for other cross-sections. 
 

1. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\xs_50_j5p0100.dgn.  

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 

 

3. Select the Route50 working alignment. 

 

4. Choose Reports and XS Quantities from the Project Manager dialog. 
 

  
 

Select the DTM Input report. 
 

The dialog shown below will appear.  Enter the information as shown: 
 

 
 

Once the information is entered, click on Apply.  Close the Reports and XS Quantities dialog 
when the Create DTM Input File process is completed. 
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5. Choose Existing Ground from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to xs50, and open the xs50 run. 
 

 
 

From the DTM menu, shown below, select Build > Triangles. 
 

 
 

When the following dialog appears, populate it as shown below: 
 
 Data File: xs50.dat 
 TIN File: xs50.tin 
 Dissolve Option: Side 
 Side Length: 25 

 
When the “Build Triangles Complete” appears  
in the MicroStation Status Bar, close the Build  
Triangles dialog.  Say YES, when asked if you  
want to save the settings. 
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6. Select Reports > Triangle Statistics from the DTM menu. 
 
When the following dialog appears, load the file xs50.tin and Process the report.  Compare 
your results to those shown below.  

 

 
 

7. Select Build > Merge TINs from the DTM menu. 
 

When the following dialog appears, populate it as shown below: 
 
 Old Tin: J5P0100.TIN 
 Mrg Tin: xs50.tin 
 New Tin: Route50.tin 

 

 
 

Once the dialog is set, click on Process.  When the “Build Merge Complete” appears in the 
MicroStation Status Bar, close the Merge Tin Files dialog. 
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8. Select Reports > Triangle Statistics from the DTM menu. 
 
When the following dialog appears, load the file Route50.tin and Process the report.  
Compare your results to those shown below.  

 

 
 

If you wish you may open either topo_J5P0100.dgn (2D file) or dtm_J5P0100.dgn (2D file) 
and view either of the tins created in this exercise.  The Route50.tin will serve as the existing 
ground tin for Exercise 19-3. 
 
Exit the DTM tools. 
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Exercise 19-3 
This continues a series of exercise that demonstrate a method for determining bridge length using 
cross-sections.  The previous exercised in the series are 15-1 and 19-2. 
 

1. Open the MicroStation file: 
 t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 
 
Select the Route50 Working Alignment. 

 

3. Open level manager and turn on level 61 and turn off levels 1-2, 5, 24, 60, and 62-63 as 
shown in the dialog in the following figure on the left. 

 

  
 

Do a MicroStation Fit View.  All that should be visible are the pattern lines for Route 50. 
 
Go to the pad lock in the MicroStation status bar and make sure that the Graphic Group lock 
is deactivated, as shown above in the figure on the right. 
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4. Use the MicroStation Change Element Attribute tool to change the color of the first and 
the last pattern line to Color 5. 

 

 
 

This will enable the next set of cross sections to ignore those two pattern lines.  The 
remaining color 0 pattern lines will be used as part of a working alignment called 50Clear, 
which while using the same chain as Route50, will use a profile 4.25’ below Route50PR.  
Just as a new tin was create from the Route50 cross sections to represent the surface of the 
highway, 50Clear cross sections will be used to create a tin representing the maximum height 
of the fill slopes under the bridge.  The shorter range of pattern lines is being used to show a 
clear drop between the two surfaces. 
 
Save the changes to the MicroStation file. 

 

5. Since the pattern lines for the Route50 working alignment have been modified, enter the 
Route50 Working Alignment Definition, highlight Pattern, and add color 5 to the list of 
Colors, as shown below. 

 

 
 

Click OK to save the changes to the alignment definition.  
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6. Use the GEOPAK Autoshape Builder tool to plot the shapes for 50Clear. 
 
To open the Autoshape Builder, expand the Cross Sections toolbox, which is  
the icon in the lower left hand corner of the Road Tools, shown to the right and  
select the fourth icon from the right, which is the raised icon shown below. 

 

 
 

This will display the Superelevation Shape Manger Tools dialog depicted below.  Select the 
Autoshape Builder, which is the second tool, as highlighted in the figure/ 

 

 
 

Click on the Files… button in the Autoshape Builder and select shape_50clear.inp. 
 
Press Apply to plot the shapes. 

 

 
 

Save the changes to the MicroStation file.  Close the Autoshape Builder and related 
toolboxes. 

 

7. Select the 50Clear working alignment. 
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8. Enter the working alignment definition for 50Clear.  
 

Go to the Shapes section and change Colors to 5,9 as depicted below. 
 

 
 

Switch to the DTM section and change the Existing Ground TIN and the Portview TIN to 
t:\br-proj\a_geopak\d5\j5p0100\data\Route50.tin as shown in the following dialog.  This 
TIN reflects the new driving surface for Route 50 and will be used for 50Clear existing and 
proposed cross sections. 

 

 
 

Click OK to save the changes to the alignment definition. 

 
9. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\xs_j5p0100.dgn.  Save it 

as t:\br-proj\a_geopak\d5\j5p0100\data\xs_50clear_j5p0100.dgn. 
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10.  Choose Existing Ground Cross Sections from the Project Manager dialog. 
 

Copy the MoDOT run to 50Clear and enter the 50Clear run. 

 

11. Set the XS Cells tab as shown below and have the Route50.tin as the only one listed under 
the Surfaces tab. 

 

 
 

Select Draw to draw the existing ground cross section and Save the MicroStation file.  Exit 
the run, saving the settings. 

 

12. Reenter the working alignment definition for 50Clear and change the XS DGN File to  
t:\br-proj\a_geopak\d5\j5p0100\data\xs_50clear_J5P0100.dgn in the Cross Section View 
section as shown below.  Note that the station range is shorter than that for the Route50 
working alignment, which goes from Sta. 465+00 to Sta. 467+00.  Click OK to save the 
changes to the alignment definition. 
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13. Choose Proposed Cross Sections from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to 50Clear and enter the 50Clear run. 

 

14. Be sure the following items are set in the given sections of the dialog: 
 
XS DGN File: xs_50clear_J5P0100.dgn 
Pattern: Use Working Alignment Definition 
Existing Ground: Use Working Alignment Definition 
Shapes: Use Working Alignment Definition 

 

15. In the Shape Clusters section of the dialog add the following shape clusters in the order 
shown by choosing the Scan button, highlighting the desired cluster in the List of Clusters 
dialog, and clicking on Add in the Proposed Cross Sections dialog.  Once the clusters have 
been added, close the List of Clusters. 
 
 Chain Tie Profile 
 ROUTE50 -30 50CLEAR 
 ROUTE50 30 50CLEAR 
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16. For each shape cluster, add the given side Slope Conditions and Criteria Files.  (See the 
attached typical section for details.) 
 
 Chain Tie Profile Chain Tie Profile 
 ROUTE50 -30 50CLEAR ROUTE50 30 50CLEAR   

Side Slope: LT Side Slope: LT 
 Criteria Files: setup.x Criteria Files: setup.x 

 pvmt_layers.x  pvmt_layers.x 
 shldr_a_c.x  shldr_a1_c.x 
 berm_to_prof_or_exgrnd.x  median_ditch.x   

Side Slope: RT Side Slope: RT 
 Criteria Files: setup.x Criteria Files: setup.x 

 pvmt_layers.x  pvmt_layers.x 
 shldr_a1_c.x  shldr_a_c.x 
 median_ditch.x  berm_to_prof_or_exgrnd.x 

 
Save the Proposed Cross Section run by going to Files > Save Settings. 

 

17. Switch to the Define Variables section of Proposed Cross Sections, as make sure the 
following are defined: 

 
NAME OF PLAN FILE.........................................................plan_50_J5P0100.dgn 
NAME OF CROSS-SECTION FILE ....................................xs_50clear_J5P0100.dgn 
NAME OF SHAPE/PATTERN FILE ...................................pattern_shape_J5P0100.dgn 
NAME OF BASELINE ........................................................Route50 
SHOULDER SLOPE (%) ......................................................5 
LEFT BERM SLOPE (%) .....................................................-5 
RIGHT BERM SLOPE (%)...................................................5 
MEDIAN SLOPE (1:X OR X:1) ...........................................50 
MEDIAN DITCH DEPTH (M OR FT) .................................0 
DITCH BACK SLOPE (1:X OR X:1)...................................50 
 
Leave the remaining variables set to the defaults. 

 

18. Save the settings for the run. 

 
 

19. Run the proposed cross-sections (Files > Run).   
 

Set the Log File to Screen Only. 
 
Turn on Pause on Each Section. 
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Exercise 19-4 

This exercise must be completed after Exercise 19-3 and continues the process of using cross 
sections to determine bridge length.  In this exercise a new TIN is created, which represents the 
maximum height of the fill slopes. 
 

1. Open the MicroStation file: 
 t:\br-proj\a_geopak\d5\j5p0100\data\xs_50Clear_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 

 

3. Select the 50Clear working alignment. 

 

4. Choose Reports and XS Quantities from the Project Manager dialog. 
 

  
 

Select the DTM Input report. 
 

The dialog shown below will appear.  Enter the information as shown: 
 

 
 

Once the information is entered, click on Apply.  Close the Reports and XS Quantities dialog 
when the Create DTM Input File process is completed. 
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5. Choose Existing Ground from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to 50clear, and open that run. 
 

 
 

From the DTM menu, shown below, select Build > Triangles. 
 

 
 

When the following dialog appears, populate it as shown below: 
 
 Data File: xs50clear.dat 
 TIN File: xs50clear.tin 
 Dissolve Option: Side 
 Side Length: 25 

 
When the “Build Triangles Complete” appears  
in the MicroStation Status Bar, close the Build  
Triangles dialog.  Say YES, when asked if you  
want to save the settings. 
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6. Select Reports > Triangle Statistics from the DTM menu. 
 
When the following dialog appears, load the file xs50clear.tin and Process the report.  
Compare your results to those shown below.  

 

 
 

7. Select Build > Merge TINs from the DTM menu. 
 

When the following dialog appears, populate it as shown below: 
 
 Old Tin: Route50.tin 
 Mrg Tin: xs50clear.tin 
 New Tin: 50clear.tin 

 

 
 

Once the dialog is set, click on Process.  When the “Build Merge Complete” appears in the 
MicroStation Status Bar, close the Merge Tin Files dialog. 
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8. Check the statistics for 50clear.tin.  Compare your results to those shown below.  
 

 
 

If you wish you may open either topo_J5P0100.dgn (2D file) or dtm_J5P0100.dgn (2D file) 
and view either of the tins created in this exercise. 
 
Exit the DTM tools. 

 

9. 50clear.tin will be used for cutting cross sections for Big Horn drive.  To prepare for that, 
select the BigHorn Working Alignment and click on Define in the Road Project dialog. 
 
Go to the DTM section of the working alignment definition and select 50clear.tin for the 
Existing Ground TIN and the Portview TIN as shown below.  

 

 
 

Click OK to save the changes to the working alignment definition. 
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Exercise 19-5 

This continues a series of exercise that demonstrate a method for determining bridge length using 
cross-sections.  The previous exercises in the series are 15-1 and 19-2 through 19-4. 
 

1. Open the MicroStation file: 
 t:\br-proj\a_geopak\d5\j5p0100\data\pattern_shape_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 
 
Select the BigHorn Working Alignment. 

 

3. Open level manager and turn on level 62 and turn off levels 1-2, 5, 24, 59-60, and 63 as 
shown below. 

 

 
 

Do a MicroStation Fit View.  All that should be visible are the pattern lines for Route 50 and 
the BigHorn shapes. 
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4. Pattern lines need to be drawn for Big Horn Drive.  They need to be different from those for 
Route50.  The easiest way to do this is by using a different color.  Enter the BigHorn 
Working Alignment Definition, highlight Pattern, and change Colors to 1. 

 

 
 

Click OK to save the changes to the alignment definition.  
 

5. Select Draw Pattern from the Road Project dialog. 
 

Copy the MoDOT run to BigHorn and enter that run.  Use the following settings: 
 

 Job: 100 Chain:  BIGHORN 
 Beginning    Ending 
  Offset Lt: 100   Offset Rt: 100 
  Station: 8+85  Station: 11+00 
  Offset Lt: 100   Offset Rt: 100 
 Even:  1 

 

 
 

Save the changes to the MicroStation file. 
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6. Open the MicroStation file t:\br-proj\a_geopak\d5\j5p0100\data\xs_j5p0100.dgn.  Save it 
as t:\br-proj\a_geopak\d5\j5p0100\data\xs_bh_j5p0100.dgn. 

 

7. Choose Existing Ground Cross Sections from the Project Manager dialog. 
 

Copy the MoDOT run to BigHorn and enter the BigHorn run. 

 

8. Set the XS Cells tab as shown below and have the 50clear.tin as the only one listed in the 
Surfaces tab. 

   
 

Select Draw to draw the existing ground cross section and Save the MicroStation file.  Exit 
the run, saving the settings. 

 

9. Reenter the working alignment definition for BigHorn and change the XS DGN File to  
t:\br-proj\a_geopak\d5\j5p0100\data\xs_bh_J5P0100.dgn in the Cross Section View 
section as shown below.  Click OK to save the changes to the alignment definition. 
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10. Choose Proposed Cross Sections from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to BigHorn and enter the BigHorn run. 

 

11. Be sure the following items are set in the given sections of the dialog: 
 
XS DGN File: xs_bh_J5P0100.dgn 
Pattern: Use Working Alignment Definition 
Existing Ground: Use Working Alignment Definition 
Shapes: Use Working Alignment Definition 

 

12. In the Shape Clusters section of the dialog add the following shape cluster by choosing the 
Scan button, highlighting the desired cluster in the List of Clusters dialog, and clicking on 
Add in the Proposed Cross Sections dialog.  Close the List of Clusters. 
 
 Chain Tie Profile 
 BIGHORN 0 BIGHORNPR 
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Since the typical section for Big Horn Drive is the same on both sides of the shape cluster, there 
is only one Side Slope Condition:  LTRT.  Add the listed Criteria Files.  (See the attached 
typical section for details.) 
 
 Side Slope: LTRT 
 Criteria Files: setup.x  
  pvmt_layers.x  
  cg_b_a.x  
  berm.x 
   sideslope.x 

 
Save the Proposed Cross Section run by going to Files > Save Settings. 

 

13. Switch to the Define Variables section of Proposed Cross Sections, as make sure the 
following are defined: 

 
NAME OF PLAN FILE.........................................................plan_bh_J5P0100.dgn 
NAME OF CROSS-SECTION FILE ....................................xs_bh_J5P0100.dgn 
NAME OF SHAPE/PATTERN FILE ...................................pattern_shape_J5P0100.dgn 
NAME OF BASELINE .........................................................BigHorn 
PAVEMENT LAYER 1 THICKNESS (MM OR IN)...........1.75 
PAVEMENT LAYER 2 THICKNESS (MM OR IN)...........5.5 
AGGREGATE LAYER 1 THICKNESS (MM OR IN) ........4 
BERM WIDTH (M OR FT) ..................................................5 
RIGHT BERM SLOPE (%)...................................................3 
FILL SLOPE 1 (1:X OR X:1)................................................2 
DITCH FORESLOPE 1 (1:X OR X:1)..................................2 
DITCH DEPTH (M OR FT) ..................................................0 
DITCH WIDTH (M OR FT)..................................................0 
  
Leave the remaining variables set to the defaults. 

 

14. Save the settings for the run. 

 
 

15. Run the proposed cross-sections (Files > Run).   
 

Set the Log File to Screen Only. 
 
Turn on Pause on Each Section. 
 
Once you see the proposed cross sections is cutting the sections correctly, toggle off Pause 
on Each Section and click Continue to cut the rest of the sections without stopping 
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Exercise 19-6 

This completes a series of exercise that demonstrate a method for determining bridge length 
using cross sections.  The previous exercises in the series are 15-1 and 19-2 through 19-5. 
 

1. Open the MicroStation file: 
 t:\br-proj\a_geopak\d5\j5p0100\data\xs_bh_j5p0100.dgn. 

 

2. Open the project t:\br-proj\a_geopak\d5\j5p0100\project\j5p0100.prj. 
 
Enter the as user userc. 
 
Go into Road. 

 

3. Select the BigHorn working alignment. 

 

4. Choose Reports and XS Quantities from the Project Manager dialog. 
 

 
 

Select the DTM Input report. 
 

The dialog shown below will appear.  Enter the information as shown: 
 

 
 

Once the information is entered, click on Apply. 
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5. Select the Profile Grade report from the XS Reports dialog. 
 

 
 

The dialog shown below will appear.  It can be used to generate a reports from cross sections 
based on Criteria Elements, Search Text, or an Offset.  Use the Search Text option.  For the 
Search Text option, the stationing can be related to the alignment chain (Design Alignment) 
or the location of the text (Text Alignment).  Select the Sta Text Alignment.  Enter the rest 
of the information as shown: 

 

 
 

Once the information is entered, click on Apply. 
 
When notified the process is complete, close all the XS Report dialogs.  If you wish, you can 
go into COGO to verify the creation of the chains and the profiles SLPSTKL and SLPSTKR. 
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6. Choose Existing Ground from the Project Manager dialog. 
 

 
 

Copy the MoDOT run to BigHorn, and open that run. 
 

 
 

From the DTM menu, shown below, select Build > Triangles. 
 

 
  

When the following dialog appears, populate it as shown below: 
 
 Data File: xsbh.dat 
 TIN File: xsbh.tin 
 Dissolve Option: Sliver 

 
When the “Build Triangles Complete” appears  
in the MicroStation Status Bar, close the Build  
Triangles dialog.  Say YES, when asked if you  
want to save the settings. 
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7. Select Reports > Triangle Statistics from the DTM menu. 
 
When the following dialog appears, load the file xsbh.tin and Process the report.  Compare 
your results to those shown below.  

 

 
 

8. Select Build > Merge TINs from the DTM menu. 
 

When the following dialog appears, populate it as shown below: 
 
 Old Tin: 50clear.tin 
 Mrg Tin: xsbh.tin 
 New Tin: slope.tin 

 

 
 

Once the dialog is set, click on Process.  When the “Build Merge Complete” appears in the 
MicroStation Status Bar, close the Merge Tin Files dialog. 
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9. Check the statistics for slope.tin.  Compare your results to those shown below.  
 

 
 

10. Open the MicroStation file: 
 t:\br-proj\a_geopak\d5\j5p0100\data\topo_j5p0100.dgn. 

 

11. Use the Draw Transition tool (the third icon in the Plan View Design tool box) to draw the 
following lines relative to the Route 50 chain.  They represent the outside face of the exterior 
girder webs.  Use symbology of your choosing. 

 
  Beginning   Ending  
Station  Offset Station  Offset 
464+00  24.4375 468+00  24.4375 
464+00  63.8125 468+00  63.8125 
 
The values for drawing the first line are shown  
in the figure to the right.  
 
After drawing the drawing the line, close the  
Draw Transition dialog and do a MicroStation fit view and save the changes to the file. 
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12. Go into Coordinate Geometry with the following settings. 
 

 
 

Set the visualization to Permanent. 
 
Use the COGO Navigator to plot the chains: SLPSTKL and SPLSTKR, as shown in the 
following figure. 

 

 
 

The following screen capture shows the girder lines with the two chains crossing them. 
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13. Use the Plan View Labeler or any other tool to find the station and elevation where the two 
changes cross the line with 63.8125’ offset.  The dialog for using Plan View Labeler is 
shown below. 

 

 
 

A screen capture showing the label in place is shown in the following figure. 
 

 
 

Note that the stations and elevations match the results from in Exercises 14-1 through 14-3.  
The process for laying out the bents from this point would be the same as was done in 
Exercise 14-4. 

 

14. To graphically see the results, use Load DTM Features to display xsbh.tin, as shown below. 
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20.1 Objectives 

• Create 3D cross sections from 2D cross sections  
• Interpolate between 3D cross sections to create B-spline surfaces 
• Use Drive Through to view the model 
• Place pavement markings on the 3D model 

20.2 Definitions 

Geopak 3D Modeling is a process of deriving three-dimensional cross sections from two-
dimensional cross sections and interpolating between the three-dimensional cross sections to 
create b-spline surfaces that represent the design. 

20.3 Prerequisites 

Before a 3D model can be extracted from 2D cross sections, there are a few prerequisites that 
must be met.  They are: 
 

• 2D design cross sections 
• Plan view graphics 
• 3D design file 

 
2D Design Cross Sections 
 
The user should have an existing design file where 2D cross sections are stored.  The user will 
need to know which levels contain the existing ground line and the proposed finished grade. 
 
Plan View Graphics 
 
The user must also have another 2D-design file containing plan view graphics.  The plan view 
graphics should include the elements specified in the Run.  For example, edge of pavement, 
chains and pavement markings. 
 
3D Design File 
 
A blank 3D-design file must exist to store the 3D cross sections as they are generated.  Enter the 
3D-design file and attach the 2D-plan file as a reference file.  Save the settings of this file with 
only the Top View displayed. 
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20.4 3D Modeling Tools 

From a 3D-design file, access the 3D modeling tools by selecting 
Project Manager >> 3D Models or by selecting the 3D Models 
icon.  The dialog box will appear requiring a job number and chain 
name.  This chapter will primarily focus on the 3D Cross Sections, 
Interp Between XS and Pavement Markings tools.  Descriptions of 
the available 3D modeling tools follow:  
 
3D Alignment - will draw elements into a 3D file, at correct 
coordinates, using the specified alignment and profile. 
 
Superelevation Surfaces - is used to draw Geopak generated 2D 
shapes into B-spline surfaces, within a 3D model, following user 
defined plotting parameters. 

 
3D Cross Sections - will reference your 2D cross section file and create a 3D complex chain to 
represent the 3D cross sections. 

 
Interp Between XS - interpolates between the 3D cross sections to create B-spline surfaces. 
 
Pavement Markings - will add pavement markings to a 3D model.  The pavement-marking tool 
will scan pavement markings in a 2D file and draw the markings in the 3D file based on user 
defined parameters. 
 

20.5 3D Modeling Process 

1. Plot the 3D alignment, and attach the plan view as a reference file.   
 
2. Geopak will open the 2D cross section file, scan the cross sections and create a complex line-

string based on the cross sections. 
 
2. Geopak then returns to the 3D-design file to draw the 3D cross sections. 
 
3. B-spline surfaces must be created using Interp Between XS. 
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20.5.1   3D Alignment 
A 3D alignment must be plotted.  This 3D alignment is a representation of the combined chain 
and profile.  An offset from the chain can be specified as well as the horizontal and vertical 
scales, and the symbology of the 2D alignment. 
 

 

20.5.2   3D Cross Sections 
Generate 3D Cross Sections: 
 

• Enter the 2D cross-section file containing design cross-sections; Geopak reads the file to 
determine the beginning and ending station of the cross-sections.  These stations are 
automatically displayed in the dialog box; however, the user may key in a different range. 

 
• Define the attribute information for Existing Ground Line and Proposed Finished Grade. 

 
• Select Apply 

 
Geopak opens the 2D cross-section file 
and begins creating 3D complex line-
strings from each cross-section.  Each 2D 
cross-section will highlight as the line 
string is formed.  This gives the user a 
brief opportunity to check for errors.  
When the process is complete, Geopak 
returns to the 3D file to draw the cross-
sections. 
 
A visual inspection of the 3D cross-
sections should be performed to verify 
their integrity.  The colors of the 3D-line 
string should reflect the same colors as 
shown in the 2D-design cross section.  If 
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an error has occurred, the user should return to the 2D-design cross section file and fix the 
appropriate cross section(s) using Geopak and/or Microstation.  Repeat the 3D cross-section 
process for any revised cross-sections and review.  

20.5.3   Interpolation Between XS 
Two Methods exist for interpolating cross-sections:  
 
Longitudinal - is used when a 2D-plan view is referenced to the 3D cross-section file.  This is 
the most common method. 
 
Surfaces - should be selected when your plan view reference file is a 3D file. 
 
Beginning Station and Ending Station - values will automatically be displayed when each of 
their offsets are defined.  Offset information must be entered in order and is controlled by 
successive activation of the DP buttons.  The user must define the Beginning Station offsets by 
first issuing a DP for the left and right offset locations.  The same process is repeated for the End 
Station box. 
 
Highlight Applied Breaklines - will highlight the breaklines used in interpolation when toggled 
on. 
 
Select the Draw Surfaces bar at the bottom of the dialog box to begin the interpolation process.  
The user is encouraged to process a small range of cross sections until the entire project has been 
done.  When Geopak interpolates 3D cross sections, it projects like color to like color between 
cross-sections.  All Microstation elements should maintain a consistent color scheme throughout 
the project.  For example, within a 2D file, all ditch slopes should be drawn the same color and 
roadway lines should also be drawn using one color.  If colors do not correspond, you will get a 
“Color Mismatch” error and the process will terminate.  There are two ways to correct this error: 
 

• Check the cross sections for an inconsistent color scheme, correct any errors, then 
regenerate the necessary cross sections, or 

 
• Activate the Force Color toggle; this will allow Geopak to ignore the color of the cross 

section elements and interpolate using only the specified color. 
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20.6 Geopak Drive Through 

Geopak Drive Through provides the user realistic visualization of 3D surfaces.  Select 
Applications >> Geopak Road >> 3D Tools >> Drive Through or choose the Drive Through 
icon.  
 

 
 
The user must enter the Job Number and a Chain name.  The drive through will follow this 
chain or may be offset from the chain by entering a value in the Plan View Offset box. 
 
Two options are available to define the distance the driver is from the roadway vertically: 
 

• Constant Elevation will place the driver at a fixed elevation, as defined by the user, 
throughout the drive through process. 

 
• Vertical Offset places the driver at a specified distance above the model, meaning the 

elevation of the view changes with the elevation of the model. 
 
The Station value will automatically display the beginning station of the selected chain, but may 
be changed by user key-in. 
 
Step Increment defines the distance traveled between each camera view. 
 
Target Offset defines how far down the road the viewer is looking (the focal point). 
 
Pressing the Locate Starting Point button will find the first station on the alignment where a 3D 
graphic element is present.  This is a convenient way to locate the start of a model. 
 
View indicates the Microstation view to be processed. 
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Press the Apply bar to activate the first camera view.  Once the first view is displayed, the user 
may pan the view by moving the slide bar to the desired angle and pressing the Apply button 
again. 
 
After viewing the model: 

• Restore the view by rotating to the top view. 
 
• Access the Settings >> View Attributes dialog box from the Microstation command 

window and toggle Camera off (automatically toggled on during drive through process). 

20.7 Pavement Markings 

This tool places pavement markings in a 3D file by extracting graphic information from the plan 
view of a 2D file. (Pavement markings created by copying parallel a complex element must be 
dropped before they can be included in a 3D model.) 
 

 
 
Enter the name of the 2D graphics file containing pavement markings. 
 
Provide Search Criteria by entering the graphic attributes of the pavement markings. 
 
Stripe Width reflects the actual width of the plan view stripe you want to create. 
 
Surface Elevation Offset is the distance from the B-spline surface the stripe shape is drawn.  
Special attention needs to be applied to this value.  If the distance is too low, the stripe may fade 
into the roadway; if the distance is too high, the stripe may cast a shadow on the road surface 
when the model is moved to a visualization software package.  It is desirable to place the stripe 
just above the surface.  Begin by using a value of 0.10; if adjustments are necessary, use small 
increments. 
 
Pavement Markings may be applied to an entire view or a fenced area by selecting the 
appropriate option.  If view is chosen, be sure to fit the view before processing. 
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